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1. Introduction 

 
 ISOPLAN is a software developed to automate the instrument calibration process 
in conjunction with Presys calibrators. It manages all information supplied by the 
calibrator being used, analyzes data and generates error graphs and calibration reports. 
It is ideal for a company that already has or will have a quality program with ISO 9000 
standard.  
 
  ISOPLAN-5 allows work orders to be specified containing calibration strategies for 
several instruments (tags). Through its instructions, Presys calibrator defines the correct 
sequence for calibration of all points and, when necessary, it organizes the data input to 
be provided by the operator. In the field, Presys calibrators have sufficient autonomy to 
inform the operator of the measurements (calibrations) that have been made and the 
deviations found during the calibration process. 
 
2. Minimum System and Hardware Requirements 

• Windows 7, 8, 8.1 or 10 ( 32 bits or 64 bits) 
• Computer with 1GHz processor or higher. 
• 2GB of RAM memory. 
• Monitor with the resolution set at 1024 x 768 or higher. 
• 100 MB of free hard disk space for installation of Isoplan. 
• Mouse 
• Serial port or USB for communication with calibrators. 
• Ethernet or Wifi network for communication with Presys advanced calibrators.  

 
3. Installation 

  ISOPLAN uses the Microsoft .NET platform for application development, which 
must be installed before ISOPLAN. Installation of the .NET platform is incorporated in the 
setup program and the steps explained below should be followed only if required. The 
installation program is in English and details about the use of each screen are explained 
in this manual.  
 
  Run the setup.exe program in the program installation CD. This installation must 
be executed by an administrator level. Normally, before installing Isoplan, additional 
components required by the Isoplan development tool are installed.  
 
  After the initial programs are installed, installation of ISOPLAN will begin. Click on 
the Next button when the following screen appears.  
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Figure 1 - Screen of ISOPLAN Installation Wizard  

 
  On the next screen, the directory for the installation of  
 ISOPLAN is defined. The default directory is "C:\isocs5", but it may be changed. There 
is also an option with the text "Install ISOPLAN for yourself, or for anyone who uses this 
computer" to indicate that you wish to install ISOPLAN only in your account (Just Me 
option) or for any user of the machine (Everyone option).  After these options have been 
configured, simply click on the "Next" button twice to confirm the installation of the 
program and wait for the installation to complete.  
 
 
  After ISOPLAN is installed, the following screen will appear. Click on the "Close" 
button to complete the installation  
 

 

Figure 2 - Screen indicating that installation was successfully completed  
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  After the end of the installation, a new icon will appear to start ISOPLAN. This 
icon can normally be found by clicking on the main Windows screen on "Start > 
Programs > Presys Instruments > ISOPLAN".  

 
  Isoplan installs only the Access database. In case it is necessary to install the 
SQL Server or Oracle database, check topic 11 ISOPLAN Maintenance. 
 

3.1. Migration from previous versions Isoplan or other  database  

  Migration from previous versions of ISOPLAN or migration of Access database to 
another database (eg. SQL Server) should be realized by sending the ISOPLAN 
database to Presys. The version of  ISOPLAN with Access database does not allow use 
with different database, as SQL Server.  

 
3.2. Removing ISOPLAN  

  In case it is necessary to remove ISOPLAN from the machine in which it was 
installed, simply follow the standard procedure for removing programs in Windows. Go to 
the control panel, in which there must be an option to add or remove programs and an 
icon to remove ISOPLAN. You can also remove the Microsoft .NET platform by 
searching for the option "Microsoft .NET Framework". This Microsoft platform may be 
used by other applications and is not exclusive of ISOPLAN. Its uninstallation may 
prevent other programs that use this resource from functioning.  
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3.3. Starting ISOPLAN 

  In the first time that ISOPLAN is used, the serial number provided with the 
program installation CD is required.  
 

 

Figure 3 – Serial number of ISOPLAN 

 
 
  Next the login screen is shown. 
 
 

 

Figure 4 – Login screen ISOPLAN 

 
  The standard password for accessing the program is:  
 

User: admin 
Password: admin 

 
 
  Isoplan allows the registration of multiple companies, but at first an example is 
used with the name "Model".  
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3.3.1.  Calibration Overdue Alarm 

 

 

Figure 5 – Calibration Overdue Alarm 

  The Isoplan presents, upon entering the program, a calibration alarm for tags, 
loops and standard that will be due in a period, for example, in the next 15 days. The 
number of days can be changed in the settings screen. Leaving the setting at 0 days the 
alarm screen is disabled. Click the Print Preview button to issue a report of tags or 
standard due or will be due. It is possible to use the standard options on the screen. 
Click the Close button to access the main program screen.   
 

 

Figure 6 – ISOPLAN 
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4. Optional Modules for Isoplan 

 
  The Isoplan presents modules or optional features that can be requested at the 
time of purchase of the software or purchased after.  
 
  Optional modules are described below:  
 
4.1.   SQL Server Database (5S)  

  The default version of Isoplan uses Access database that meets satisfactorily 
applications with a small number of concurrent users (1 to 3). 
 
  SQL Server is a database more robust supporting a larger number of users and 
less prone to failure being provided by Microsoft, but it requires more knowledge for its 
installation and maintenance. This type of database is suitable for companies that 
already use the database in SQL Server systems other than Isoplan. See topic  11.2 
Using an SQL Server Database . 
 
4.2.  Oracle Database (5O)  

  Oracle is a database similar to SQL Server, previously mentioned, supplied by 
another manufacturer, Oracle. See topic 11.3 Using an Oracle Database . 
 
4.3. DataSheet (DSh) 

  This module allows registering a datasheet of the characteristics of each 
instrument registered in Isoplan. This data sheet can be printed by the user Isoplan. This 
module also allows register operating conditions of each tag and generate a single 
document with details of the instrument and the tag where the instrument is installed. 
See topics 5.13.2 Instrument Datasheet and 5.14.6 Operational Conditions. 
 
4.4. Data Collector (CDE) 

  This module enables to export work orders from Isoplan to Excel spreadsheet. 
This spreadsheet can be completed and sent to other computers or mobile devices 
(Pockets, Palm's, etc.). These devices can edit the spreadsheet with Excel, for example, 
and need not have the Isoplan installed. The data in this spreadsheet can be filled by 
imported to Isoplan. See topic 6.2.6 Download to Excel Worksheets. 
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4.5. Pressure Safety Valves (PSV) 

 
  The Isoplan allows the generation of a calibration certificate for specific safety 
valves and Presys also optionally provides a calibrator, DMY 2017 PSV, which presents 
some features specific to the data collection point of opening and closing of safety 
valves.  
 
  See topics 5.14.4.3 Calibration of safety valves (PSV Module) e 6.2.2 Download 
to Presys Calibrator DMY-2017 PSV . 
 
4.6. Loops (ML) 

  The loop is a combination of two or more instruments connected so that the signal 
passes from one to the other in order to perform a measurement. This module allows to 
manage, so independent calibrations of loops in the same way as is done with individual 
instruments such as certificates create and issue a plan calibrations for the loops. For 
example, create certificates and issue a calibration plan.  
 
  Refer to topic 5.15 Loops.  
 
4.7. Signature Electronic (ASE) 

  Enables the use of electronic signature for the certificates of the Isoplan. This 
signature follows the recommendations of the American Norm 21 CFR - Part 11 for the 
pharmaceutical industries.  This norm recognizes as valid certificates stored in electronic 
form through the approval of the certificate through a password entered by the user. 
 
  Refer to topic 7.7.4 Signature Electronic 
 
4.8. Procedures (PCD) 

   This module allows to perform change control procedures for calibration 
documents (Word, Excel, etc.) with the Isoplan. This module allows only the Isoplan 
users to make changes to these documents.  
 
  Refer to topic 5.11 Procedures 
 
4.9. Audit-Trail (AT) 

  This module enables in the Isoplan the Audit-Trail. This module consists of a 
report with all the changes a user makes within the Isoplan as register a new instrument, 
delete calibrations, etc.  
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4.10. Service Provider (PS) 

 
  This module is designed for service provider companies wishing to issue 
certificates using Isoplan. There is a customer base for organizing tags and instruments 
for a specific customer, the certificate shows the name and address of the customer and 
you can disable some fields of the certificate as the date of next calibration, for example.  
 
  See topics 5.17 Register of Clients and 7.7.3 Correction of the Certificate in 
Isoplan with Service Provider module .  
 
4.11. FDA Module 

   For attend the American Norma 21 CFR - Part 11 for the pharmaceutical 
industries, the modules AT, ASE, DSH and ML must be included in the Isoplan. 
 
4.12. Critical Analysis Module (CA) 

   This module allows you to generate an approval document in the Isoplan tag 
register called a critical analysis where one or more users must approve the information 
defined in the register as acceptance criteria, instrument input range, calibration 
periodicity, etc. The approval must be performed by up to 4 users through electronic 
signature where after all the approvals a unique number is generated for the analysis. In 
addition to the individual approval document for each tag registered in Isoplan, a 
spreadsheet with a list of all the critical tags registered in Isoplan containing the main 
information related to the critical analysis such as calibration points, acceptance criteria 
and calibration periodicity can be generated. 
 
  When entering Isoplan the input alarm displays information on the number of 
critical analyzes pending and the number of tags that the user who is signing in must 
sign.  
 
4.13. Accredited Services Module 

 
  This module facilitates the creation of calibration certificates that are suitable for 
accreditation with the Brazilian Calibration Network. Isoplan presents only a few 
certificate models for services relating to temperature and pressure quantities. 
Depending on the procedures that the laboratory uses, it may be necessary to 
adapt the Isoplan accreditation certificate models. This service must be performed 
upon request to Presys. 
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5. Register 

 
  All information related to the automatic calibration process of an instrument is 
stored in the ISOPLAN database. The Registration menu in the main screen contains the 
items necessary for the complete configuration of the device characteristics and the 
sequence of operations performed by the Presys calibrator. 
 
5.1. Toolbar 

  All registration screens have a toolbar on the upper part with the controls for the 
creation of new registers (tags, units, areas etc.), deletion of registers or copying and 
pasting of data. The toolbar commands are as follows: 

 Creates a new register (tag, instrument, area etc.). 

 Saves the current register, which may be an existing register or a new one. 

 Deletes an existing register.  

 Cancels the update of a register in case it has not been saved. 

 Copies data from a register to the transfer area.  

 
Pastes data from the transfer area to the current register. It may be a new blank 
register. 

 Lock or unlock edition of a register. Click on this button to activate register edition 

 Button to close the screen. 

 Opens the Help file. 
 
 The Toolbar can also be accessed by the right mouse button or through hot keys 
as shown below: 
 

 Ctrl + n. 

 Ctrl + s. 

 Ctrl + d. 

 Ctrl + z. 

 Ctrl + c. 
 Ctrl + v. 

 Ctrl + e. 

 Ctrl + f. 

 Ctrl + a. 
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5.2. Copying and pasting registers 

  The copy and paste operation is similar to that of other programs running in 
Windows, but it is restricted to one single ISOPLAN screen. The copy and paste option is 
normally used to create several registers that are almost identical: for example, in case it 
is necessary to register several repeated instruments, simply click on the copy button to 
transfer data from the model instrument to the transfer area, click on the new button and 
then click on the paste button to copy all data from the model instrument to the new 
blank instrument. 
 
5.3. Lock Change Records 

 
  The Isoplan screens of register have an icon with a picture of a closed or opened 
lock. When the lock is closed saving changes is locked. Clicking the lock icon saving the 
changes is released. 
 
5.4. Register of Scales  

 

 

Figure 7 - Dialog box Scales 

 
  The registers defined for Units and Signal Types are grouped in order to 
establish the scales used by the instruments and calibrators in the calibration process. 
Refer to the Toolbar topic to create and delete registers. 
 
Presys Calibrator - Input 
 
 
  Measurement scales of Presys calibrators (data can not be either altered or 
deleted).  
 



PRESYS  Instruments ISOPLAN-5 

Page 17 

Presys Calibrator - Output 
 
  Generation scales (source) of Presys calibrators (data can not be either altered or 
deleted). 
 
 
External Calibrator - Input 
 
  Measurement scales of other calibrators are also used to define the output signal 
of the instruments to be calibrated.   
 
Signal  
  Choose one of the registered Signal Types. Use the button next to the signal 
type to edit or created a new type of signal.  
 
External Calibrator - Output 
 
  Generation scales of other calibrators are also used to define the input signal of 
the instruments to be calibrated.   
 
Signal  
 
  Choose one of the registered Signal Types. Use the button next to the signal 
type to edit or created a new type of signal.  
 
Unit 
 
  Choose one of the registered Units. Use the button next to the unit to edit or 
created a new unit.  
 
Number of Decimal Places 
 
  Number of decimal places used in the reports. 
 
Maximum Value and Minimum Value 
 
  Maximum value and minimum value allowed for this scale. These values must be 
defined according to the instruments and standards available for calibration. 
 
5.4.1. Units  

  The Units dialog box allows the types of engineering units previously registered to 
be checked and new units to be included. It must be observed that the program classifies 
units as internal, corresponding to those used in Presys calibrators to indicate their input 
or output signals. The external units refer to the signals that were read or generated 
externally (without the participation of Presys calibrator). A list of tag operational 
conditions can be created for each registered tag. Refer to the Toolbar page to create 
and delete registers.  
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Figure 8 - Dialog box Units 

 
Registered Units 
 
  List of registered units.  
 
Unit 
 
  Text of the registered unit. Only external units can be created or changed. 
 
5.4.2. Signals  

  The Signal Type dialog box presents the registered signal types and allows new 
signals to be registered. Reference is also made here to signals of internal and external 
type, such as the signals allowed by a Presys calibrator and by the instrument to be 
calibrated, respectively, whether they are input or output. Refer to the Toolbar page to 
create and delete registers.  
 
Registered Signals  
   
  List of signals already registered in the program. 
 
Signal 
 
  Text of the registered signal. Only external signals can be created or changed. 
 
5.5. Failures  

 
  The Failure dialog box allows the creation of codes to identify failures that occur 
or are observed during the calibration process. Registered codes may be input in Presys 
calibrators by the operator during the execution of a work order, or added to the 
calibration report when the diagnosis is specified. A list of failures registered in ISOPLAN 
can be generated and checked through the "Print Preview" option in the Report menu. 
The Failures and Conditions Found report presents the failure number, description of 
the failure or condition, and comment for each register. Refer to the Toolbar page to 
create and delete registers. 
 
Registered Failures  
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  List of failures already registered in the program.   
 
Failure number 
 
  A number defined by the user to identify failure or condition found in calibrations. 
 
 

 

Figure 9 - Dialog box Failures 

 
Failure 
 
  Brief description of the failure. 
 
Comments 
 
  Comments with further details explaining the type of failure. 
 
5.6. Laboratories  

 
  It is used to register external laboratories that can receive the standards or 
instruments registered in ISOPLAN. Refer to the Toolbar to create and delete registers. 
 
Registered Laboratories  
 
  List of registered laboratories. 
 
5.6.1. Laboratory  

  It presents basic data about the laboratory. 
 



PRESYS  Instruments ISOPLAN -5 

Page 20 

ISOPLAN Name 
 
  Internal name used in ISOPLAN to make it easier to locate a certain laboratory.  
 

 

Figure 10 - Dialog box Laboratories 

 
Laboratory full name 
 
  Name of the laboratory as it should appear in the reports issued by Isoplan. 
 
Actuation Fields 
 
  Fields in which the laboratory works. Refer to the topic Actuation Field 
 
 

The list of registered laboratories can be printed accessing the menu Main> Print 
Preview List of Laboratories. 

 
 
5.6.2. Address   

  Data about the location of the Laboratory. These data are optional. 
 
Address 
  
 Address of laboratory including name of the street or avenue where it is located. 
 
City 
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  City where the laboratory is located. 
 
State 
   
  State where the laboratory is located. 
 

 

Figure 11  - Address tab in dialog box Laboratories  

 
Zip code 
 
  Postal code of the address of the laboratory. 
 
E-mail 
 
  Main e-mail of the laboratory. The button next to the e-mail field can be used to 
open the standard e-mail program configured in Windows.  
 
Contacts 
   
  List of contacts in the laboratory that can be edited by clicking on the button. "...". 
Refer to the Contacts topic. 
 
Tax ID 
   
  Federal Tax ID number of the laboratory.  
 
 State Tax ID 
 
  State tax registration number of the laboratory. 
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5.6.3. Laboratory Contacts  

Register with information about the contacts in a certain laboratory. Refer to the Toolbar 
page to create and delete registers.  
 
 

 

Figure 12 - Dialog box Laboratory Contacts  

 
Registered Contacts 
 
  List of registered contacts. 
 
Name 
 
  Name of the contact person in the laboratory. 
 
Department 
 
  Department where the person works.  
 
Position 
 
  Description of position. 
 
Phone, Fax, e-mail 
 
  Information on how to contact the person. In the e-mail field it is possible to open 
the standard electronic mail program of Windows. 
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5.6.4.  Actuation Fields  

  Register with the lab's areas of work See the Toolbar page for creating and 
deleting records. 
 

 

Figure 13 -Dialog box Fields of Laboratory   

 
Registered Fields  
 
  Lists of fields registered for this laboratory. 
 
Laboratory Field 
 
  Select one of the existing fields or click on the button  to edit or register this 
list. Refer to the Laboratory Field topic. 
 
Accreditation Number 
 
  Laboratory accreditation number. 
 
Laboratory services 
 
  Services that can be executed by the laboratory within the selected actuation field. 
Click on the button  to edit or register this list. Refer to the Laboratory Services 
topic.  
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5.6.4.1. Register of Actuation Field  
 
  It registers a list of fields that are available to the several laboratories registered in 
ISOPLAN. Refer to the Toolbar page to create and delete registers.  
 

Laboratory Actuation Field 

Name of the field of the laboratory.  

 

 

Figure 14 -Dialog box Laboratory Actuation Field   

 
5.6.4.2. Laboratory Services  
 
  The laboratory may provide several types of service in each field. The service is 
defined through the combination of a certain area and type of service. Refer to the 
Toolbar page to create and delete registers.  
 

 

Figure 15 - Dialog box Laboratory Services  

mk:@MSITStore:C:/isoplans/Isoplan50QuimicaAmparo/bin/pt-BR/isocs.chm::/toobar.htm
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Registered services 
 
  List of services registered in the software.  
 
Laboratory Field 
 
  Filed in which the service must be registered. The fields available are only those 
registered for the laboratory. In case a new field is required, return to the Actuation 
Filed screen.  
 
Service Type 
 
  Select one of the registered types of service or create a new type of service by 
using the button . 
 
Ranges 
 
  Table with the ranges in which the laboratory can work. Click on the Add button to 
create a new range and fill in the fields of the table. Range is a text in which the 
laboratory measurement or generation range (e.g.: 0 to 10V) can be input. In the Best 
Capability field, input the best capability of the laboratory for that range (e.g.: 10ppm + 
0.3mV). To remove a range, click on the Remove button. 
 
 
5.6.4.3. Types of Service  
 
  List of types of service that are available to the several laboratories registered in 
Isoplan. Refer to the Toolbar page to create and delete registers.  
 
Name of Service 
 
  Text with the name of the service executed by the laboratory. 
 

 

Figure 16 - Dialog box Services. 
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5.7. Verifications  

  ISOPLAN has a simplified control of instruments that do not require calibration. 
This control is called verification. In this mode the instrument report presents only a few 
items that were checked and no measurement register is made in ISOPLAN. The items 
to be verified are registered on this screen and later they can be associated to the tag of 
the instrument to be verified.  
 
Registered verifications 
  List of registered verifications. 
 
Verification 
  Description of the registered verification. 
 
 
5.8. Types of Instrument  

  Register of the types of instrument employed by the user. Refer to the Toolbar to 
create and delete registers.  
 
 

 

Figure 17 – Instrument Type dialog box. 
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Registered instrument types 
 
  List of types of instrument registered in the software.  
 
Instrument type 
 
  Description of the type of instrument. 
 
Instrument Specification Data1 
 
  These data are optional and allow the user to create a datasheet template with 
several properties of the instrument. To add a new property to the type of instrument, 
click on the Add button. To remove a property, click on the Remove button. In case it is 
necessary to create a new property, click on the button . The order in which the 
properties appear on the datasheet can be modified by using the buttons with the arrows 
to move the property upwards or downwards. 
 
5.8.1. Properties  

  The several properties that can be part of the datasheet of an instrument are 
registered on this screen. Refer to the Toolbar page to create and delete registers.  
 
Instrument properties 
 
  List of registered properties.  
 
Property 
   
  Description of the property being registered. 
 

 

Figure 18 - Dialog box Properties. 

  

                                              
1 Available only on Isoplan with Datasheet module (DSh) 
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5.9. Operational Conditions2  

  A list of tag operational conditions can be created for each registered tag. Refer to 
the Toolbar page to create and delete registers.  
 
Registered Tag Types 
 
  List of the types of registered tags. 
 
Operational condition model 
 
  Name of a model of tag operation condition.  
 
Tag Specification Data 
 
  These data are optional and allow the user to create a model with a list of the 
several operational conditions of a tag. To add a new condition, click on the Add button. 
To remove a condition, click on the button  Remove. In case it is necessary to create a 
new condition, click on button . The order in which the conditions appear on the 
datasheet can be modified by using the buttons with the arrows to move the condition 
upwards or downwards. 
 

 

Figure 19 – Operational Condition Model dialog box. 

  

                                              
2 Available only on Isoplan with Datasheet module (DSh) 
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5.9.1. Conditions3  

  The several operation conditions that can appear in a tag are registered on this 
screen.  

 

Figure 20 – Tag Conditions Model dialog box. 

 

Registered Conditions 

List of registered operation conditions.  

Condition 

Description of the operation condition being registered. 

 
5.10. Areas  

It shows the areas or sectors in which the Tags registered in Isoplan can be 
allocated. Refer to the Toolbar to create and delete registers.  

 

 
 

Figure 21 - Dialog box Areas. 

                                              
3 Available only on Isoplan with Datasheet module (DSh) 

mk:@MSITStore:C:/isoplans/Isoplan50QuimicaAmparo/bin/pt-BR/isocs.chm::/tags.htm
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Registered areas 
 
  Tree with registered areas. ISOPLAN has the option of creating areas and sub-
areas. To create an area, click on the Areas folder and then on the New button. To 
create a sub-area, select one of the existing areas by clicking on the area folder and then 
on the New button.  
 
Area 
   
  Name of the area.  
 
  Below the area name there are some data with the number of tags registered in 
Isoplan, total number of tags in the area and sub-area and total number of tags in the 
area only.  
 
 In the lower right corner of the screen, It is possible to view the list of tags and 
loops that belong to the selected area. 
 
5.11. Procedures  

  Register with calibration procedures adopted by ISOPLAN users. 
 

 

Figure 22 - Dialog box Procedures. 

 
Registered Procedures 
 
  List of registered procedures. 
 
Procedure Code 
   
  Alphanumeric code of the calibration procedure. 
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Procedure Name 
 
  Name to make it easier to identify the procedure. 
 
Description 
 
  Optional short text to describe the procedure. 
 
Selected Procedure 
 
 The ISOPLAN allows you to print preview several procedures at once, to select 
the procedures click Reports>Select Procedures, if you want to see the procedures in 
separate files, also check the option Separate reports. In the field Registered 
Procedures select the procedure that you want to print preview, and then click the 
button   to add the procedure to the Selected Procedures list. To print preview the 
procedures that are in the list, click Main> Print Preview. 
 
 
5.11.1. Control Documents4 

 

   

Figure 23 – Associated Document tab 

 
  The registration of tags allows the operation conditions of the tag to be registered. 
There are two options for storing documents:  
 
 
                                              
4 Available in Isoplan with procedure module 
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  Save Revisions in Isoplan 
 
  With this option, documents are stored in a folder controlled by Isoplan. This 
folder is defined in the Settings Isoplan. The files are encrypted before they are stored in 
this folder and can only be accessed through Isoplan.  
 
Do not Save Revisions in Isoplan 
 
  With this option, the Isoplan only stores the file path associated with the 
procedure (Ex: \\server\lab\p001.doc). The Isoplan has no control over the files which 
can be changed without the use of Isoplan.  
 
 
  The change control documents are realized by the following commands:  
 
 
Check-in 
 
  Check-in is used to store a new document or a new revision in Isoplan. By clicking 
the check-in is requested the document associated with the procedure, for example, a 
Word document, a justification and a number or code revision of the document. Clicking 
the OK button the document is stored in Isoplan or just created a link has been chosen 
the "Do not Save Revisions in Isoplan".  
 
Check Out 
 
  The checkout is used to change a document controlled by Isoplan. By clicking the 
check-out must be chosen a location where you saved the file for changes to be made. 
Upon completion of the changes should be made to check in, as explained earlier, to 
store a new revision in Isoplan. It is not possible for two users Isoplan perform a 
checkout simultaneously. Click on Cancel to cancel check out of a document. 
 
Preview Revisions 
 
  The Isoplan allows it to be viewed a specific revision. Click the row of the revision 
you want to view and click the Display Review.  
 
Opens Archive 
 
  Open the document from the last place where the document was saved. 
 
 
 
 
 
 
 
5.12. Standards  

  Register with the standards used to calibrate the Instruments. 

 

file://///lservidor/laboratorio/p001.doc
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Registered Standards 
 
  List of standards registered in the software.  
 

 

Figure 24 - Dialog box Standards. 

 
5.12.1. Standard  

  It presents basic data to register a standard.  
 
Registration Number 
 
  A number or code that identifies the standard. This number does not have to be 
the same as the manufacturer's serial number.  
 
 
Type of Instrument 
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  One of the Types of instrument previously registered in the program that is 
suitable for the calibrator being registered. 
 
 
Manufacturer 
 
  Manufacturer of the standard. 
 
 
Model 
 
  Model of the standard. 
 
Tag 
 
  Optional field in case a tag needs to be defined for the standard. 
 
Serial Number 
 
  Optional field for the manufacturer's serial number. 
 
Scales 
 
  Each standard must have one or more measurement signal or generation signal 
scales. To add or remove scales, click on the button  to access the standard scales 
register. This register must be made after the basic data of the standard register is 
saved. 
 
Certificates 
 
  Register of the standard certificates. To add or remove a certificate, click on the 
button  or on the Edit Certificates button to access the standard certificates 
register. This register must be made after the basic data of the standard register is 
saved. 
 
Send W.O. 
 
  Creates a calibration work order (W.O.) for the standard that will be sent to an 
external laboratory. Refer to the work orders of the standard topic. 
 
Receive W.O. 
 
  Inputs data of the standard calibration certificate provided by the laboratory. Refer 
to the receive W.O. of the standard topic. 
 
 
 
 
Period 
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  Defines the frequency of standard calibration in months or days. This field is 
informational only, the period is set at the time of signing the standard certificate. 
 
Simplified certificate 
 
 Allows the user to register the standard simplified certificate, no need to fill 
calibration values, in this case, the standard uncertainty is estimated for the accuracy of 
the registered range. 
 
Certificate without W.O. 
 
 Allows registering the standard certificate without generating a work order 
 
Last 
 
  Date of last standard calibration. 
 
Next 
 
  Date of next standard calibration. Calibration date can be changed by using the 
calendar or inputting the date. 

 

Inactive  
 
  If a standard has a defect so that it can not be repaired, you can click this option 
to keep the standard registered but inactive where it no longer appears in the list of 
registered standards and there is no further need to perform calibrations of this standard. 
 
 
Date In Use 
 
  Date that the pattern was put in use Only the user with supervisor level can make 
changes in this field. 
 
 
Area 
 
  Area or sector that defines the location of the tag in the plant. Select one of the 
areas available or use the button  to register a new area. 
 
 
Comments 
 
  Free text field to enter comments. 
 
 
5.12.2. Presys Calibrator Options  
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  For ISOPLAN to work in conjunction with Presys calibrators, it is necessary to 
register the information shown on this screen. 
 
Pressure Options 
 
  These fields are specific to the pressure measurement calibrators. There are two 
types of pressure calibrators: those that use external sensors (External Sensor option); 
and those that use internal sensors (Internal Sensor PC-507 option). In case the 
equipment does not measure pressure, use the No pressure module option. Presys 
equipment can use up to four sensors. 
 

 

Figure 25 – Presys Calibrator Options tab in the Standard dialog box 
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Field Calibrator Model 
   
  Choose one of the Presys Calibrator models corresponding to the standard you 
are registering. The communication address must be entered with the Presys calibrators. 
Calibrators can use some types of communication protocols that will be described in the 
next topic.  
 
Sensors 1 to 4  
 
  Presys devices have up to four pressure sensors in which it is possible to choose 
one of the ranges available. If necessary, a new range can be registered by clicking on 
the button . Refer to the Pressure Sensors register. 
 
Presys Serial Number 
 
  For the program to run correctly, it is necessary to register a serial number 
provided by Presys. 
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5.12.3. Pressure Sensors  

  Presys pressure sensors allow up to four sensors to be registered. ISOPLAN 
presents a list of sensors provided by Presys so that it is not necessary to create new 
ranges for most cases. If the range is not available, it must be registered so that the 
calibrator can be used in ISOPLAN.  
 

 

 Figure 26 –Dialog box Pressure Sensors 

 
Registered Sensors 
 
  List of registered sensors. 
 
Minimum and Maximum 
 
  Minimum and maximum values of the sensor. The minimum value may be 
negative in sensors that can measure pressures below atmospheric pressure. 
 
Unit 
 
  Use a suitable pressure unit, normally psi or mmH2O.  
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5.12.4. Communication protocols Calibrators Presys 

  The communication address configuration uses a format similar to the addresses 
of Web browsers where each protocol uses a different address format. To facilitate the 
address registration there is a wizard, click the Wizard button next to the address.  
 
  On the Wizard screen you can choose one of the protocols used by Presys 
calibrators.  
 

• http - protocol used by the advanced line of Presys calibrators being suitable for 
installations where the computer running the Isoplan and the calibrators are 
interconnected in the same wired (ethernet) or wireless (wi-fi) local area network.   
The address has the following format:  

 
   http://address 
  
 where:  
  address = ip address or host name of the calibrator in the Windows 
network.  
 
  Example: http://192.168.1.5 
 
 

• connector - protocol used by the advanced line of Presys calibrators being 
suitable for installations where the computer running the Isoplan and the 
calibrators are not on the same network, for example Isoplan is virtualized in a 
server on the Internet. Refer to topic 6.5 The address has the following format:  

 
   connector://address/calibrator_serial 
  
 where:  
  address = ip address or machine name where the Presys connector is 
installed.    
 
   calibrator_serial = calibrator serial number.     
 
  Example: connector: //192.168.50.1/290.08.17 
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• usb - protocol used by the advanced line of Presys calibrators being suitable for 

installations where the computer running the Isoplan and the Presys calibrator are 
connected via a USB cable.   The address has the following format:  

 
   usb://[drive letter] 
  
 where:  
  drive letter = letter of the drive that appears on the computer when Presys 
calibrator uses USB cable.  This field is optional where in case it is not filled the Isoplan 
automatically searches for the calibrator.  
 
  Example: usb:// 
 

• Modbus Rtu - protocol used by the Presys calibrators that use serial 
communication with modbus rtu protocol. The calibrators can be connected in RS-
485 network. The machine where the Isoplan and calibrator are connected must 
be connected via USB/Serial cable.   The address has the following format:  

 
   rtu://COMX:[ModbusAddress] 
  
 where:  
  COMX = COM port used 
  ModbusAddress = modbus address. Optional field with default value equal 
to 1.  
     
 
  Example: rtu://COM3:1 
 

• Modbus TCP - In this mode calibrators with serial communication can connect to 
Isoplan via local network (ethernet or wi-fi) through a Modbus rtu to Modbus TCP 
adapter. This adapter allows all Presys calibrators share a single network.  The 
address has the following format: 

 
   modbustcp://address:[Port]:[SlaveAddress] 
  
 where:  
  address = ip address or host name of the Modbus / TCP adapter for 
Modbus-Rtu.  
 
  Port: TCP port of the adapter, usually 502.  
   
  SlaveAddress: modbus address of the calibrator, usually address 1 
configured in the calibrator.  
    
  Example: modbustcp://192.168.50.2:502: 1 
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5.12.5. Register of Scales  

  This register presents the several scales that can be used by a calibration 
standard. It is also possible to register points that must appear in the standard calibration 
certificate and additional sources of error that can be taken into consideration in the 
calculation of calibrator uncertainty during calibration of an instrument.  
 
Registered Scales 
 
  List of registered calibration scales. 
 

 

Figure 27 - Dialog box Standard Scales 

 
5.12.5.1. Standard Scale  
 
  A calibration standard has one or more measurement signal or generation signal 
scales. In order to register a standard calibration certificate, it is necessary to register 
these scales in ISOPLAN.    
 
Input (Meter) or Output (Source) Mode 
 
  A scale can refer to a signal measured by the standard (input) or a signal 
generated by the standard (output), that is, the standard works as a source. 
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Signal 
 
  Type of signal of the standard scale. Refer to the signal type register.  
 
Unit 
 
  Unit of the standard scale. Refer to the units register. 
 
Num. Decimals Standard 
 
  Number of decimals corresponding to the resolution of the standard. The number 
of decimal places can be changed when data is input in the standard certificate. 
 
Num. Decimals Reference 
 
  The number of places corresponding to the resolution of the reference standard 
used by the laboratory. The number of reference decimals can be changed when data is 
input in the standard certificate. 
 
Maximum Value and Minimum Value 
 
  Range of values that the standard can generate or measure according to a 
defined scale. 
 
History Maximum Error  
 
  Click the "Show Graph" button to generate a graph with the maximum calibration 
error of a standard scale over time. There are two options to show the limit for the error: 
Only Error - limit based on error and Error Plus Uncertainty - limit based on sum of 
error module plus uncertainty.  
 
5.12.5.2. Calibration Points 

 
  In this tab the calibration points that must be shown in the calibration certificate 
are defined. A calibration point is added by clicking on the Add button and removed by 
clicking on the Remove button after the calibration point to be removed is selected. The 
following columns are defined in this table: 
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Figure 28 - Calibration Points tab in the dialog box Standard Scales 

 
Calibration Points 
 
  Calibration point that should appear in the certificate. When certificate data is 
input, the calibration points can be changed, if necessary, according to the points defined 
by the external laboratory. 
 
Accuracy (E.U.) 
 
  Accuracy in an engineering unit specified in the manual of the manufacturer of the 
standard. In case the manufacturer provides the accuracy as a percentage, the value 
must be converted engineering unit (E.U.) before this value is defined in Isoplan. 
 
Acceptance Criteria (E.U.) 
 
  ISOPLAN allows each calibration point to be validated through acceptance 
criteria. The laboratory must provide, for each calibration point, the error and the 
uncertainty. The sum of the error module with the uncertainty is compared to the 
acceptance criteria defined in this column.  
 
Calculation Assistant 
 
  Isoplan works with accuracy values and acceptance criteria in an engineering unit. 
The fields of the group Calculation Assistant are intended to convert instrument 
specifications as a percentage of full scale, span and read to engineering unit. Choose 
whether you want to fill in the Accuracy column or Acceptance Criteria, enter the 
percentage value, choose one of the options (Reading, Span or Full Scale) and click in 
Calculate for the Isoplan to perform the calculations. 
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5.12.5.3. Error Sources  
 

  Besides the uncertainty value provided by the laboratory, it is possible to add 
other uncertainty components related to the standard scale that is being registered. 
These uncertainty components were called sources of error in ISOPLAN. An example of 
an error source is the effect of variation in ambient temperature on the value measured 
by the standard. To add a new error source, fill in the name for the error source and click 
on the Add button. To remove an error source, click on the Remove button. The 
uncertainty of an error source is registered by filling in the table present in the group 
called Ranges. First click on the Add button and then fill in the table. The uncertainty 
can be defined to different values according to the value that was measured or 
generated by the standard. To remove a line from the table, click on the Remove button. 
 

 

Figure 29 – Tab Error Sources  in the dialog box Standard Scales  

 
Standard Value 
 
  Value measured or generated by the standard. The uncertainty will be defined for 
the value typed in this column. 
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Uncertainty 
 
  Value of the uncertainty due to the error source that is being registered. This 
value must be in the same unit as that of the registered scale. For example, if the register 
contains an uncertainty due to temperature variation for a current meter, the uncertainty 
value must be in mA or another registered current scale. The value of this uncertainty 
can be provided by the manufacturer or obtained through some other kind of research 
made by the user.  
 
 
Uncertainty Factor 
 
  The uncertainty due to a certain error source usually follows a probability 
distribution (rectangular, triangular, normal etc.). Depending on the type of distribution, it 
is necessary to input a factor that will be used to obtain the standardized uncertainty 
which in turn will be used to calculate the uncertainty of the standard. For rectangular 
distribution, the uncertainty factor is 1.732 (SQRT(3)), for triangular distribution, the 
uncertainty factor is 2.4495 (SQRT(6)) and for normal distribution, the uncertainty factor 
is 2.   
 
Uncertainty Factor Selected When Choosing Standard Scale 
 
  This option is used to leave extra uncertainty components selected (resolution, 
drift, etc.) when a standard calibration scale is selected in the calibration results part.  
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5.12.5.4. Scale Registering Help for Presys Calibrators 
 
  Isoplan allows you to register easily the scales of Presys calibrators. Click on 
Main>Scale Registering Help For Presys Calibrators.   
 
 

 

Figure 30 - Scale Registering Help for Presys Calibrators 

  Choose one of the Scales Group of the list that are classified by magnitudes, 
select the scales that have a certificate or that you want to certify, and optionally a 
multiplying factor to calculate the acceptance criteria based on accuracy of the 
manufacturer and click on Add button. Isoplan will register automatically the selected 
scales using accuracy data of the Presys calibrator specification and the calibration 
points usually used on certificate generate by Presys Inst. These automatically registered 
dates can be edited if necessary.  
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5.12.6. W.O. (Work Order) of the Standard  

  In order to input data of a standard certificate, it is necessary to create a standard 
W.O. After a W.O. is created, a report with the work order must be generated by clicking 
on the Send W.O. button The fields on this screen are as follows: 
 
 
Registered W.O. 
 
  List of registered work orders. The W.O. uses automatic numbering created by 
Isoplan. 
 
ISOPLAN Internal W.O. Number 
 
  ISOPLAN creates a sequential number automatically to number the work order. It 
is not necessary to fill in this field. 
 
User W.O. Number 
 
  This field is optional and allows a different numbering system to be used for the 
work order. This number is defined by the user and it can be used, for example, to fill in a 
W.O. number defined in a procedure of the company or provided by another system. 
 
Laboratory 
  Select one of the registered laboratories or use the button  to register a new 
laboratory. 
 

 

Figure 31 - Dialog box Standard W.O. 
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Sent Date 
 
  Date when the standard will be sent to the external laboratory. 
 
W.O. Condition 
 
  Condition of the W.O. The following options are available: New - The W.O. was 
created and is expecting the emission report to be generated. Sent - the emission report 
has been generated Associated to a Certificate - the standard has returned from the 
external laboratory and a certificate has been created. 
 
W.O. Scales 
   
  Scales of the standard that will be calibrated by the laboratory. It is not necessary 
to add all standard scales, but only the scales for which the laboratory will provide a 
certificate. 
 
Scales Available 
 
  All scales of the standard registered in ISOPLAN. Refer to Register of Scales. 
 
5.12.6.1. Adding and Removing Scales  

 
  A work order is composed of one or more scales to be calibrated by the external 
laboratory. In order to add a scale, click on the square that is shown on the left-hand 
corner of the scale name to select it. Choose the Before Adjustment option (laboratory 
must provide a certificate before making any adjustment in the standard) or the After 
Adjustment option (laboratory provides a certificate after adjusting the standard). Click 
on the "<" button to add a scale to the W.O.. In case it is necessary to remove a scale 
from the W.O., simply select it by clicking on the square on the left-hand corner of the 
scale name and click on the Remove button. Only the After Adjustment option is 
normally selected because in many cases the laboratory does not provide an instrument 
calibration certificate before the adjustment. 

 

5.12.6.2. Send W.O.  
 
  After the W.O. is created and saved, a report with the data of the scales to be 
calibrated by the external laboratory can be generated by clicking on the Send W.O. 
button.  
 
 
5.12.7. Receive Standard W.O.  

  This screen starts the receipt of a work order of the standard so that certificate 
data provided by the laboratory that calibrated the standard can begin to be input.  
 



PRESYS  Instruments ISOPLAN-5 

Page 49 

 

Figure 32 -  Dialog box Receive Standard W.O.  

 
Creating a new Certificate of a Standard 
 

1. Select one of the W.O. from the Pending W.O. list. 
2. Choose from the Pending Scales list those scales that were calibrated in the 

certificate provided by the laboratory. In case the laboratory has provided more 
than one certificate, only one certificate must be created at a time. Scales are 
selected by clicking on the square next to the name of the scale. Press the Ctrl 
key if you want to select more than one scale simultaneously. 

3. Click on the "<"button to transfer scales from the W.O. to the Certificate Scales 
list. If an item is added by mistake, select the scale from the list and click on the 
Remove button. 

4. Fill in the Laboratory Certificate Number and Certificate Date fields with the 
date when the calibration was made. 

5.  Click on the Create a New Certificate button to begin to input certificate data. A 
new blank certificate will be created with the selected scales. Type in the 
certificate data as described on the Standard Certificates screen.  

 

 

 

 

5.12.8. Standard Certificates  
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  Standard certificate data is input on this screen. It is not possible to create a new 
certificate through this screen. Instead, it is necessary to follow the send W.O. and 
receive W.O. procedures. Refer to the Toolbar page to check the functions of the 
buttons. The new, copy and paste buttons are disabled.   
 
Registered Certificates 
 
  List of registered certificates or those expecting data to be input.  
 
5.12.8.1. Certificate  

 

 
 

Figure 33 - Dialog box Standards Certificates 

  This tab presents basic data about the standard certificate made in an external 
laboratory.  
 
Certificate number 
 
  Number of the certificate provided by the laboratory.  
 
Date 
 
  Certificate date. 

 
 
Work Order 
 
  This is a read-only field showing the number of the W.O. associated to the 
certificate. 
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Responsible 
 
  This field is automatically filled in when the user clicks on the Sign button. See 
more details about the signature in the Standard Certificates topic. 
 
Laboratory 
  List of available laboratories. Click on the button  in case it is necessary to 
create a new laboratory. 
 
Temperature 
   
  Room temperature in the laboratory. 
 
Humidity 
 
  Relative humidity in the laboratory. 
 
Attached File 
 

In this group it can be added and viewed a file in PDF format, usually the standard 
calibration certificate, click the Add button to add a file, the Remove button is used to 
remove the file, and to view the file click the Visualize button. 
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5.12.8.2. Failures  
 

 

Figure 34 - Failures tab in the Standard Certificates dialog box. 

 
Failures and Conditions Found  
 
  On this screen it is possible to add failures or conditions that occurred during 
calibration of the standard. Click on the Add  button to define a new failure or condition 
found during calibration. In case it is necessary to remove one of the failures that have 
been added, select it and click on the Remove  button. 
 
Comments 
 
  Fill in this field with general comments about the calibration of the standard. 
 
 
5.12.8.3. Measured Points  

 
In this tab the calibration points of the standard are typed. They must be copied from the 
certificate provided by the laboratory. The procedure to input data is as follows:  
 

1. Select one of the scales from the list shown in the Scales field. 

2. In the Decimals field, adjust the number of decimal places of the standard 
(instrument that was sent to the laboratory) and of the reference (standard used 
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by the laboratory). 
   

3. Fill in the Measured Points table with the values provided by the certificate. The 
columns in the table are as follows: Value Indicated - value indicated by the 
standard (instrument) that was sent to the laboratory.  Val. Standard Ref. -value 
measured by the laboratory reference standard.  Error (E..U.)-error in engineering 
unit calculated by the program. Uncertainty-uncertainty value provided by the 
laboratory. K Factor - K factor value supplied by the laboratory. Accept. Crit. - 
acceptance criteria in the same engineering unit of the scale. The sum of the error 
module and uncertainty  is compared with this value to determine if the scale 
diagnosis is approved or reproved. The measured points correspond to the values 
defined in the standard scale. If necessary you can add or remove the calibration 
points using the Add and Remove buttons.  

4. Click on the Save button before changing from one scale to another to save the 
changes made. 

 

 

Figure 35 - Tab Measured Points of the dialog Certificates of Standards 
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5.12.8.4. Finishing Data Entry (Signature)  
 

  The standard can only be used for instrument calibrations after finalization of the 
standard certificate data entry. This completion is done as follows:  

1. View or print the data entered in Isoplan through the report from the Main>Print 
Preview menu. 

2. After verifying that all the data has been entered correctly, you must define the 
calibration period or click the Keep Period, option and then click the Sign An 
electronic signature is made by the person responsible for entering the certificate 
data. This signature is simply a confirmation of the user's password. After signing 
the certificate, the data can no longer be changed and the certificate is ready to 
be used for instrument calibrations that use the standard. 

 

 

Figure 36 - Tab Signature of the dialog Certificates of Standards 
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5.12.9. Report Menu  

The standard register displays the following reports: 

 

List of Standards 

Click the List button to preview a list of registered standards. Inactive standards do 

not appear in this list. 

History 

Click the  History  button to view a history of the calibrations of the standard. 

 

5.12.10. Instrument Search 

 

Figure 37 - Tab Form  of the Standard Search dialog box 

 

  Through the button  it is possible to search the standards registered in 
ISOPLAN based on few details about the standard. The search procedure is as follows: 
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1. Use the Form tab to fill some known information about the standard.   You can 
perform a search knowing only a few characters, for example by typing in the 
Num  of Register 02 will return all standards that contain the characters "02". The 
fields that are irrelevant to the search can be left blank. See below further details 
about how to fill in the fields.  

2. Click on the Search tab in the upper part of the screen. Click on the Start Search 
button to search the ISOPLAN register according to the criteria defined in the 
Form tab. The search result is shown in the table in the upper part of the screen. 
The search result can be printed by clicking on the Print Preview button, to check 
the result of the printing, and then on the printer icon, to send the report to the 
printer.  

3. To work with the only with standards found  use the button Use Searchto transfer 
the list of found tags to the list of standards present in the registration screen. The 
Use Selected button can be used to display only the selected standards. Use the 
Cancel button if you do not need to work with the list of standards found.  

 

 

Figure 38 - Tab Search  of the Search standard Dialog Box 

 

Comments: 
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• The Last and Next fields represent the date of the last and next calibration of the 
standard respectively. The two fields allow three options: a) fill the date only on 
the left: in this case will be searched the standards from  the specified date. b) fill 
in date only on the right: standards with calibrations will be searched  up 
tospecified date. c) completion of the two dates: standards will be searched with 
calibrations that are in the interval between the two dates specified.   

 

5.12.10.1. Search Criteria 
 
  The group called Search Criteria allows you to save search criteria used. To use 
this feature do the following:  
 
1. To perform a search on Isoplan usually using a filter, for example, tags that begin 
with the letter "T" ("T").  
2. Enter a name for this search criteria, for example, "Temperature Tags" and click 
Save.  
3. To use this search criteria in the choice list "Name Search Criteria" the name 
entered in the previous step and click on "Start Search".  
4. To remove a saved search criteria click the "Remove". 

 
 
5.12.10.2. Exporting Search Results 

 
   The CSV Export button lets you export the search result in text format separated 
by semicolons and can be read by other programs such as Excel format in a simple and 
plain easier to manipulate the data. Reports of Isoplan can be exported to PDF, Excel 
and Word, but the formatting of these files cannot be well suited to handle the data in 
other programs, for example, to create a filter in Excel.  

 
 

5.12.11. Importing Certificates from Presys Laboratory 

  The Presys calibration laboratory offers the user the option of downloading the 
calibration certificate data from a standard over the internet into a text file that can be 
imported into Isoplan. The standard, scales, and certificate can be created automatically 
by Isoplan by importing this file. To import a pattern and / or certificate do the following:  
 

1. * Save the downloaded file from the Presys Lab site to a folder on your computer.  
 

2. * On the Standard screen, click the Main>Import Presys Certificate.  
 

3. Select the file downloaded from the Presys website and click Open.  
 

4. Wait for the message that the standard has been imported.  
 

  Comments: 
 

• The accuracy and acceptance criteria are not part of the Presys certificate 
and should be reviewed by the Isoplan user.  
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• The acceptance criteria used by Isoplan is based on the accuracy of the 
standard or the sum of the error and uncertainty of the certificate, this 
value may not be adequate for the needs of the laboratory.   

• This import feature is for the sole purpose of saving typing time. The 
responsibility to verify that the data is correct according to the 
laboratory procedures remains with the user who electronically 
signs the standard calibration data document in Isoplan.  

 
5.13. Instruments  

  The instruments represent the equipment to be calibrated (indicators, controllers 
etc.). ISOPLAN allows the registration of an instrument datasheet and of the instrument 
scales that are used in case it is necessary to employ other error sources besides the 
standards during calibration. Refer to the Toolbar to create and delete registers.  

 

Registered instruments 
 
  List of registered instruments. Use the button  to perform an instrument 
search. 
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5.13.1. Register of Instruments  

 

Figure 39 - Register tab in the Instruments dialog box. 

 
  This screen presents the main instrument data to be registered in ISOPLAN. The 
fields on this screen are as follows: 
 
Registration Number 
 
  Alphanumeric field that identifies the instrument. This field may contain the 
manufacturer's serial number or an internal number of the company that identifies each 
instrument. 
 
Type of Instrument 
 
  One of the types of instrument previously registered in the program. 
 
Model 
  List of registered instrument model. Click on the button  to change the list of 
models of the instrument.  
 
Manufacturer 
 
  List of registered instrument manufacturers. Click on the button  to change the 
list of manufacturers of the instrument. 
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Scales 
  List of registered instrument scales. Click on the button  to change the list of 
scales of the instrument. 
 
Inactive 
 
  Select this field to indicate that the instrument is inactive due to a failure that 
cannot be repaired or due to some other reason. 
 
Maintenance 
 
  Check to indicate that the instrument is in maintenance. Optional data. 
 
Reserve 
 
  Check to indicate that it is an instrument of reservation. Optional data. 
 
Tags (Read Only) 
 
  List of tags associated with this instrument. This list is populated as the tags are 
registered, you cannot add tags through this screen.  
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5.13.2. Instrument Datasheet5  

   When a type of instrument is selected, ISOPLAN automatically presents a list of 
properties that can be registered. This list is only shown if the properties have been 
registered on the Types of Instruments screen. The Value column is to be filled in by 
the user. 

 

Figure 40 Register tab in the Instrument Data-sheet dialog box 

 

5.13.2.1. Adding and Removing Properties  
 

  The register of an instrument datasheet allows properties to be added or removed 
only from a specific instrument. To add a new property, select it from the list in the center 
of the screen and click on the Add button. To remove an instrument property, click on 
the square next to the desired property to select it and then click on the button  
Remove. To register, click on the button . It is not necessary to fill in all properties. 

  

                                              
5 Available only on Isoplan with Datasheet module (DSh) 
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5.13.2.2. Datasheet Report  
 

  To print a list with the instrument datasheet, click on Main > Print Preview. The 
Settings > Datasheet menu has two options: Show blank values - prints full datasheet 
including blank values; and Do not show blank values - prints datasheet without blank 
values. 
 

 

Figure 41 - Instrument Datasheet Report 
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5.13.3. Photo  

 
 

Figure 42 - Photo tab in the Instruments screen 

 
  Click on Change to add or modify a photo and on Remove to remove the photo 
associated to the instrument. This option need to be activated in the configuration menu.  
 
 
5.13.4. Instrument Search  

  The Instrument Search dialog allows you to search for instruments among those 
already registered according to the characteristics specified in the tab Form for register 
number, instrument type , model, manufacturer, active or inactive situation and existence 
of tag associated to this instrument. Instrument registers can also be sorted according to 
registration number or tag.  
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Figure 43 – Form tab in the Instrument Search dialog box 

 
  The fields whose information is irrelevant to the search can be left blank. A search 
can be made knowing only a few characters. For example, by typing 01 for the 
registration number, all instruments whose registration number contains 01 will be 
shown.  
 

 

Figure 44 –  Search tab in the Instrument Search dialog box 

 
  Click on the Start Search button for Isoplan to start the search. The search result 
will be written in a box in the upper part of the window and it can be printed as a report 
with a title (edited in the Report Title box) and date.  Below the search screen there is a 
list with the columns of the table, unselect any column that has no interest that appears 
on the screen or in the print preview. The Print Preview button allows a report with the 
search result to be previewed on the screen. The Use Search button transfers the 
instruments of the search to the Instruments box in the main dialog box. The Use 
Selected button can be used to display only the selected instruments. 
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Figure 45 – Report Instrument Datasheet  

 
5.13.4.1. Saving a Search Parameters 
 
  The search screen instrument provides an option to save the search criteria for 
use later. Having performed a search using one or more filters, for example, equal to 
Presys manufacturer, can save this criteria give a name for it and clicking Save. This 
name will be saved in the list below the Search Criteria Name field. Click the name of 
the Start button and search for the search to be redone without the need to fill the filters 
tab Form.  
 
5.13.4.2. Exporting Search Results 

 
   The CSV Export button lets you export the search result in text format separated 
by semicolons and can be read by other programs such as Excel format in a simple and 
plain easier to manipulate the data. Reports of Isoplan can be exported to PDF, Excel 
and Word, but the formatting of these files cannot be well suited to handle the data in 
other programs, for example, to create a filter in Excel.  

 
5.13.5. Register of Scales  

  An instrument can have several scales; for ISOPLAN a scale corresponds to a 
combination of input and output of the instrument. The scale is used in case it is 
necessary to register extra uncertainties of type B associated to the instrument (for 
example, instrument resolution, hysteresis etc.) and the manufacturer's accuracies for a 
certain instrument scale. It is possible to calibrate the instrument without using the scale 
register. See the Toolbar page for creating and deleting records.  

 

 

Registered Scales 
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  List of registered scales.  
 
 
5.13.5.1. Scale 

 
  A scale corresponds to a combination of input and output of the instrument. If the 
instrument has multiple channels, it is not necessary to register a scale for each channel 
provided that all channels present the same characteristics. For example, in the case of 
an instrument with 10 reading channels of PT-100 sensor, a single channel can be 
registered and it will be used later to register Tags for all channels of the instrument. 
 

 

Figure 46 –  Scale tab in the Instrument Scales dialog box 

 
 
Scale Name 
 
  A name for the scale (e.g. temperature), if the instrument has a scale to measure 
temperature. This field is a free text, but it is not possible to register two scales with the 
same name for the same instrument. 
 
 
 
 
 
Input Unit or Adjustment 
 
  Unit used in the instrument input in case it is a meter or transmitter. If the 
instrument is a source, the unit would be the one with which the source is adjusted.  
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Output Unit or Indication 
 
  Unit used in the instrument output, for example a transmitter or a source. In the 
case of an indicator instrument, the indication unit must be used. For example, for an 
indicator with 4 to 20mA input and 0 to 100% indication, the input unit would be mA and 
the output unit would be %.  
 
5.13.5.2. Accuracy  

 
 

 

Figure 47 –  Accuracy tab in the Instrument Scales dialog box 

 
 Table with the manufacturer's accuracy for the scale that is being registered. An 
instrument can have different accuracies depending on the input value applied to it. In 
this case, several accuracy values can be registered. The Instrument Value field 
represents a value applied to the instrument input and the Input Accuracy field 
represents the value in engineering unit of the instrument input of the accuracy provided 
by the manufacturer. Isoplan allows also to register the instrument's output accuracy, 
simply check the Output Accuracy option and fill in the corresponding field in the table. 
For example, in the case of a temperature transmitter with PT-100 input, unit in °C and 4 
to 20mA current output, the input accuracy must be fill in (ºC) and the output accuracy 
must be fill in mA. The Add and Remove buttons are used to add or remove, 
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respectively, values defined as accuracy for the instrument. Click on the square beside 
the instrument value before clicking on the button Remove. 
 
  The fields of the group Calculation Assistant are intended to convert the 
instrument specifications as a percentage of full scale, span and reading to engineering 
unit. Enter the minimum and maximum value of the instrument range, enter the value in 
percentage, choose one of the options (Reading, Span or Full Scale) and click Calculate 
for Isoplan to perform the calculations. 
 
 
5.13.5.3. Error Sources  

 
  Besides the uncertainty value due to the calibration standards, it is possible to add 
other uncertainty components related to the instrument scale that is being calibrated by 
ISOPLAN. These uncertainty components were called sources of error in ISOPLAN. An 
example of an error source is the effect of variation in ambient temperature on the value 
measured by the instrument. To add a new error source, fill in the name for the error 
source and click on the Add button. To remove an error source, click on the Remove 
button. 
 
  The uncertainty due to an error source is registered by filling in the table present 
in the group called Ranges. First click on the Add button and then fill in the table. The 
uncertainty can be defined with different values according to the value applied to the 
instrument input. To remove a line from the table, click on the Remove button. 
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Figure 48 – Error Sources tab in the Dialog Box Instrument Scales 

Instrument value 
 
  Value applied to the instrument input. If the Use Output Unit option is selected, 
this value must be in the instrument output unit. For example, for a transmitter with PT-
100 input, unit in °C and 4 to 20mA output, the unit to be used will be °C if the Use 
Output Unit option is not selected, and mA if it is. 
 
Uncertainty 
 
  The uncertainty value due to the error source that is being registered corresponds 
to the instrument value. This value must be in the same unit as that of the Scale tab. The 
value of this uncertainty can be provided by the manufacturer or obtained through some 
other kind of research made by the user.  
 
Uncertainty Factor 
 
  The uncertainty due to a certain error source usually follows a probability 
distribution (rectangular, triangular, normal etc.). Depending on the type of distribution, it 
is necessary to input a factor that will be used in order to obtain the standardized 
uncertainty to be employed to calculate the uncertainty of the standard. For rectangular 
distribution, the uncertainty factor is 1.732 (SQRT(3)), for triangular distribution, the 
uncertainty factor is 2.4495 (SQRT(6)) and for normal distribution, the uncertainty factor 
is 2.   
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Adds Automatically to Download 
 
  This option is for automatically adding an uncertainty component associated with 
the scale of the instrument, eg resolution. The purpose of this option is to prevent the 
user from having to choose the extra uncertainty components at each instrument 
calibration.  
 
 
 
5.13.6. Register of Models 

 

 

Figure 49 - Dialog box Models 

This screen displays the models of registered instruments in ISOPLAN. 
Refer to the Toolbar to create and delete registers.  

 
 
Registered Models 
 
 List of registered instrument model. 
 
 
 
Model 
 

Instrument model. This is a free text field, but it is not possible to register two 
models with the same name. 
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5.13.7. Register of Manufacturers 

 

          Figure 50 - Dialog box Manufacturers  

This screen displays the manufacturers of registered instruments in ISOPLAN. 
Refer to the Toolbar to create and delete registers.  
 
 

Registered Manufacturers 
 
List of registered instrument manufacturers. 
 

Manufacturer 
 

Instrument manufacturer. This is a free text field, but it is not possible to register 
two manufacturers with the same name. 

 
  



PRESYS  Instruments ISOPLAN -5 

Page 72 

5.14. Tags  

  For ISOPLAN, tags are the points of measurement or indication of the process in 
which the ISA terminology is generally used to identify each tag. In ISOPLAN each tag 
must be associated to an instrument - identified by the registration number - , which 
effectively carries out the measurement. If the process does not change, the tag normally 
remains the same and through time the associated instrument is changed due to failures, 
replacement by a newer model etc. The screen presents tag identification fields, which 
are described below, and several tabs, explained in separate topics, to define the tag 
calibration strategy. After all tabs have been filled in, the tag can be saved. Refer to the 
Toolbar topic to create and delete registers.  
 
Registered Tags 
 
  List of registered tags. Use the button  to make a tag search. 
 
Area 
 
  Area or sector that defines the location of the tag in the plant. Select one of the 
areas available or use the button  to register a new area. 
 
Client6 
 
  This field define which client the tag is associated. Select one of the clients 
available or use the button  to register a new client. 
 
Tag Name 
   
  Name that identifies the tag and normally follows ISA terminology, for example, 
TT-101 for a temperature transmitter.  
 
Instrument 
   
  Instrument associated to the tag and identified by the registration number. Choose 
one of the instruments available on the list or use the button  to register a new 
instrument. Use the button  to filter the instruments shown on this list through the 
Instrument Search. 
 
Cal./Verif. 
 
  It indicates if the tag will be used for calibration or only for verification. In the 
verification mode the measurements are not registered and ISOPLAN fills in the 
calibration and strategy data automatically. It is necessary to fill in the items to be verified 
in the Verifications tab. 
 
Inactive 
 
                                              
6 Optional Module Service Provider 
10 Critical Analysis Module 

file:///C:/Users/admin/AppData/Roaming/Microsoft/isocsHtmlHelp/portbr/tags_verifications.html
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  To indicate that the tag is inactive. Inactive tags do not appear in calibration plan.  
 
Calibrated Only in Loop 
 
 Option used to indicate that the tag is calibrated in loop, when a loop is calibrated, 
the date of the next calibration of its component will be updated according to the date of 
the next calibration of the loop, as long as the calibrated only in loop option is checked 
 The tags calibrated in loop appear in the calibration plan and in the critical 
analysis list 10 with an indication that they are calibrated in loop 
 
External Calibration 
 
 Option used to indicate that the tag is calibrated in an external laboratory 
 
 
 
 
 
5.14.1.1. Criticality Register 
  Criticality of the Tag. Select one of the criticalities available or use the button  
to register a new criticality. 
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5.14.2. Function/Interval   

 

 

Figure 51 – Function/Interval tab in the dialog box Tags 

 
  Some properties of the tag calibration period and function are defined in this tab. 
The fields are as follows:  
 
Period 
 
  It defines the interval between calibrations in days or months, according to the 
selected option. If the tag has already been calibrated, Isoplan can calculate the date of 
the next calibration through the Calculate button.  
 
Per. Min. and Per. Max.  
 
  If the automatic adjustment of frequency was selected in the Configurations 
screen, then these two fields, corresponding to the minimum and maximum periods 
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between calibrations, must be filled in. The automatic adjustment cannot change the 
calibration period outside this interval.  
 
Last 
 
  Date of last tag calibration. This field is only for consultation and shows when the 
last calibration using ISOPLAN was made. 
 
Next 
   
  Date of next tag calibration. This date will be used to develop the calibration 
plan.  
 
Function 
 
  Text describing the function of the tag. 
 
Procedure 
 
  Code of the procedure used for the calibration. Select one of the procedures 
available or use the button  to register a new procedure. 
 
Accredited Service Type 7 
 
  Choose one of the services such as Digital Pressure Manometer, Analog 
Manometer, Temperature Meter with Thermocouple Sensor and others to create a 
certification certificate for Isoplan. The calibration process is the same regardless of 
whether calibration is accredited or not. In the certificate there is some optional 
information that the user can add to the certificate as immersion depth. 
 
 

5.14.3. Instruments  

  This tab is only for consultation and shows instrument information so that it is 
possible to check if the instrument associated to the tag is correct. The information is the 
same as that of the Instruments register. 
  

                                              
7 Accredited Services Module 
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5.14.4. Calibration  

 

 Figure 52 – Calibration tab in the dialog box Tags  

 In this part of the screen the calibration data that will be sent to Presys calibrators 
or collected manually begin to be defined. Information about the signal that will be 
applied to the instrument input and that will be read in the instrument output is presented 
on this screen. The fields in this tab are as follows: 

 

Strategy 
 
  The calibration strategy consists of all settings that must be used to calibrate an 
instrument - for example, signal applied to instrument input, calibration points etc. 
ISOPLAN allows up to two different strategies, called strategy 1 and strategy 2, and 
more than one strategy can be used per tag. For example, in the case of a controller that 
calibrates instrument input and output independently, one strategy can be created for the 
input and another for the output. A new tag presents at first only one strategy (strategy 
1). If you need to create another strategy click the button Add and if you need to remove 
an existing strategy click the Remove button. To change strategy simply click on the list 
of the strategy field. Normally each strategy will present an independent calibration 
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certificate. Use the Certificate with multiple strategies option so that the same certificate 
can present more than one calibration strategy or range.  
 
Instrument scale 
 
  If the instrument scale register was used, then the instrument scale must be 
associated to the calibration strategy. Data about instrument error sources can be 
used to calculate the uncertainty in the calibration certificate. The units used in the 
instrument register and in the calibration strategy must coincide so that ISOPLAN can 
calculate automatically the effect of these error sources on the uncertainty of the 
instrument certificate.  
 
Calibration 
 
  In the Calibration section, the calibrator output signal (generation), which can 
also be interpreted as the signal that will be applied to the instrument input, is defined. 
The Generation field has two options:   
 

1. Calib. Presys : In this mode the Scale list displays only the Presys calibrator 
scales.  

 
2. External: in this mode the Scale list shows the external scales according to the 

Scales register. External scales are used when Presys calibrators will not be 
used to generate a signal.   
 

 
Scale 
 
  The Scale list shows the available scales according to the previous option. Below 
the list, it is possible to define the minimum and maximum values of the calibration range 
(signal applied to the instrument input). The Decimals field shows the number of decimal 
places that will appear in the certificate for the calibrator output signal. In the case of a 
Presys calibrator this number of decimals cannot be changed. If an external scale is 
being used, the number of decimals can be defined by clicking on the Man.  option. By 
default the number of decimals is the same as that defined in the Scales register. 
 
Reference 
 
  In the Reference group, the calibrator input signal (reading) is defined which can 
also be interpreted as the output signal of the instrument. This group has configuration 
analogous to the group of calibration where there is option to use scales of the Presys 
calibrators or external calibrators and again must be defined a minimum and maximum 
value that in this case corresponds to the output of the instrument. This reference signal 
is not always measured, in case of indicators this signal is read by the user and an 
external scale must be used. 
 
Presys Calibrator Options 
 
  Save Amb. Temp.: select this option if the calibrator has a port for RTD probe 
and you want to use this probe to measure the room temperature. 
 

mk:@MSITStore:C:/isoplans/Isoplan50QuimicaAmparo/bin/pt-BR/isocs.chm::/inst_scales.htm
mk:@MSITStore:C:/isoplans/Isoplan50QuimicaAmparo/bin/pt-BR/isocs.chm::/inst_scales_uncertanty.html
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  Ref. Table: in the case of thermocouple or thermoresistance reading or 
generation, choose the temperature scale and unit. Normally the ITS-90 scale is used.  
 
  Output Volt.: a level of calibrator output voltage must be defined if the calibrator 
is used to generate frequency.  
 
  Sensors P1 and P2: see the explanation below about Presys equipment for 
measuring pressure.  
 
  Presys Calibrator Message 
 
  Text shown in the display of Presys calibrators before calibration. 
 
 Stabilization Time  
 
  indicates the stabilization time used by Presys calibrators. It is mainly used with 
Presys thermal baths and this period indicates the time to elapse after the bath reaches 
the temperature of the calibration point, before measuring the value of the instrument 
(temperature of a sensor, output signal of a transmitter etc.).When using Presys 
calibrators that require values to be typed in (indicators, manometers etc.), this period 
should be zero. It must also be zero if a manual pressure pump is used together with 
Presys calibrators.  
 
 
  Comp. Cold Junction Input /Comp. Cold Junction Output 
 
  Selects the option of cold joint compensation to measure or simulate 
thermocouples. The option uses CJC Internal temperature compensation using the 
internal sensor calibrator and the option CJC Ext. Probe uses an external sensor 
connected to thermoresistance side entrance for measuring the temperature of the cold 
junction.  
 

 

5.14.4.1. Using Presys Calibrators to measure Pressure  
 
  If a Presys pressure measurement calibrator (PC-507 or other) is used to calibrate 
an instrument that has a pressure port (manometers, P/I converters etc.), it is necessary 
to define the scale shown in the Calibration group as Pressure P1 or Pressure P2 and 
the unit to be used. The Pressure P1-P2 option is used to measure differential pressure. 
In addition to setting the correct scale should be set in the Presys Calibrators Options, 
the capsule you want to use for pressure P1 or P2, for example a capsule from 0 to 30 
psi. When calibration information is sent to the Presys equipment (download), the 
program will search in the standard register which sensor has the desired range. In the 
case of calibration of instruments that generate pressure, such as an I/P converter, this 
configuration must be made in the Reference group. 
 
5.14.4.2. Using Presys Thermal Baths  
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  In the case of Presys thermal baths (T-25N, T-350P etc) it is necessary to define 
the scale present in the Calibration group as Temp. Probe , which means that the 
internal probe of the bath will be used to measure the temperature.   
 
5.14.4.3. Calibration of safety valves (PSV Module)8   
 
  Calibration of safety valves can be performed on Isoplan in conjunction with 
Presys DMY2017-PSV calibrator on Isoplan with PSV module. To perform this type of 
calibration, the tags screen must be configured as follows: 

 
1. In the Calibration tab, use the generation scale in the Presys Calib. mode 

and the PSV Pressure scale. 
 
2. Choose the operating range of the valve, eg 0 to 10 kgf/cm2 

 
3. In the strategy tab add two calibration points, the first point corresponds to 

the closing of the valve and the second the aperture, the same value can be 
used for the two points.  

  

                                              
8 Available only on Isoplan with safety valve module (PSV) 
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4. Fill in the value of acceptance criteria, in pressure unit, of the first point 

corresponding to the closing of the valve and the second point 
corresponding to the opening of the valve. Isoplan also allows the automatic 
calculation of the acceptance criteria according to the tolerances of the 
American Standard ASME I and ASME VIII. See in the Appendix  the 
tolerance table used by Isoplan.  

 
5. To use automatic calculation select one of the standards and click the 

calculate button. Isoplan shall automatically calculate the tolerances 
according to the selected standard.  

 
5.14.4.4. Calibration of Block Valves (PSV Module)9   
 
 
  The PSV module allows the calibration of blocking valves which in the Isoplan 
corresponds to a leak test where the valve must have the outlet closed and a pressure 
applied to the inlet. Isoplan evaluates the pressure drop to indicate a possible leak by 
issuing a specific report for this type of test.  
 
  Select type of valve, Block Valve.  
 
 
5.14.4.5. Switch Calibration  

 
   Isoplan has a specific certificate for switches such as pressure switches or 
thermostats. To perform the switch calibration, make the following settings in the tags 
screen: 
 

1. Choose a pressure or temperature signal as the calibration (generation) scale 
depending on the type of switch used.   

 
2. Choose the "Presys Calib." and the Switch SW-SW scale to indicate that the 

output of the instrument corresponds to a switch, for example a contact.  
 

3. In the calibration strategy, place only two calibration points, where the first point 
corresponds to the reset of the switch and the second corresponds to the alarm.  
 

  Presys calibrators presently do not allow switch calibration through download to 
field calibrator, and manual download and calibration with contact input must be 
performed as explained in the manual of calibrator.  
 
  The readings of switch certificate correspond to the alarm or reset points of the 
key.  
  

                                              
9 Available only on Isoplan with safety valve module (PSV) 
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5.14.4.6. Digital Output Reading with Presys Calibrators 

 
 

 
  Advanced Presys calibrators allow to read the digital output of HART and Profibus 
instruments. To use this feature enable the External Input option of the tab Calibration 
> Options Presys Calibrator. The reading range should remain as the External option, 
even if in this case the output is read by the Presys calibrators. Set the reading with 
scale according to the instrument's digital output, for example, for temperature indication 
choose an external scale Temperature ° C. .  . The available options are as follows:  
 
 
 
HART 
 
Used for reading instruments with digital output using the HART protocol. The address of 
the instrument must be set in the HART Address field.  
 
 
 
 
PROFIBUS 
 
Used for reading instruments with digital output using the PROFIBUS PA protocol. The 
address of the instrument must be set in the Profibus Address field and the index of the 
block containing the digital output can usually be left as zero.   
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5.14.5. Strategy  

  The fields in this tab are linked to strategy 1 or 2, as explained in the topic about 
the Calibration tab. The fields of the screen are described below. 
 

 

Figure 53 – Strategy tab in the dialog box Tags 

Sequence 
  There are four sequence options: 1) up  ; 2) down ; 3) up-down  ; 4) 
down-up . 
 
  As Found and As Left: Indicates the number of times the as-found or as-left 
calibration points will be repeated. 
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  Automatic Calculation of Calibration Points: The Calc. Interval button allows 
the calibration points to be calculated automatically. Choose one of the options (10, 20 or 
25%), click on the Calc. Interval button and the calibration points will be shown in the 
table on the right.  
 
  Input / Output Relation: The instruments that are normally used have a linear 
relation between the signal applied to the instrument input and the signal read in the 
output. There is an alternative to use the Square Root option ‒ normally for flow meters 
in which the output signal is proportional to the Square Root of the input. The option 
called Inverse (1/x) allows you to calibrate conductivity meter  where in the certificate 
must appear as input signal resistance and output signal conductivity, inverse of 
resistance. The Pt-100 (IEC) ITS-90 option allows the PT-100 formula of the ITS-90 
standard to be used as the input and output ratio.  
 
Calibration Points 
 
  This table shows the calibration points that will be used. As previously explained, 
ISOPLAN allows the calibration points to be calculated automatically. It is also possible 
to add and remove calibration points by clicking on the Add and Remove buttons. To 
remove a point, select it by clicking on the square on the left-hand side of the table next 
to the calibration point. 

 

Acceptance Criteria 
 
  In order to validate a calibration certificate, a criteria must be defined to approve 
or reprove a certificate. This criteria is a numeric value individually defined for each 
calibration point and is in engineering unit. This value is in the second column of the 
calibration points table. Isoplan provides two options: Only error ‒ in this case, 
ISOPLAN suggests the certificate should be approved if |E| <= acceptance criteria, 
where |E| is the error module Error plus uncertainly ‒ ISOPLAN suggests the certificate 
should be approved if |E| +U <= acceptance criteria, where |E| is the error module and U 
is the uncertainty of the calibration point.  
 
Automatic Calculation of the Acceptance Criteria Values 
 
  If the acceptance criteria is defined as a percentage of reading, span or full scale, 
ISOPLAN allows the acceptance criteria values of the Calibration Points table, which 
must be in engineering unit, to be calculated automatically based on the acceptance 
criteria as a percentage plus a constant in engineering unit. Input the percentage value in 
the field next to the (%) and the constant value in engineering unit in the field Constant, 
choose the type of calculation (percentage of reading, span or full scale) and click on the 
Calculate button.   
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Calibration Settings 
 
 Defines some settings for calibration:  
 

• Reverse Calibration: calibration performed in Isoplan is usually done by setting a 
desired value on the standard that is applied to the input of the instrument and 
reading a value indicated on the instrument where multiple reads the default value 
is fixed and the value of the instrument may change. In the case of inverted 
calibration, eg used in an analog pressure manometer, the value applied to the 
instrument input is adjusted until the instrument displays a desired value and then 
the value of the standard is read. In the case of multiple readings the value of the 
instrument instrument is fixed and the value shown in the standard may vary. In 
the case of multiple reads the value of the instrument is fixed and the value 
displayed on the standard may change. 

 
• Corrects Defaults : option used to correct values indicated by the calibration 

standards in the certificate, for example, if a standard displays 10.00, but in the 
certificate indicates that for this value the laboratory reference is 9.95 so if this 
option is enabled, the value of 9.95 will be displayed and no longer the value 
indicated in the standard display.  

 
• Certificate and readings with scaled values:  When this option is selected, all 

values read out at the instrument output are scaled to the input unit, for example, 
on a transmitter with input from 0 to 100°C and output 4 to 20 mA will display all 
readings, errors and uncertainties in °C unit. 

 
• Certificate with scaled values: in this option the values will only be scaled in the 

calibration certificate. 
 

• * Observation: selects the observation that will be used in the calibration 
strategy. Click the button  to check the existing observations or register new 
observations.  
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5.14.5.1. Observation Register  
 
  The button  next to the observation field allows you to enter the observations 
that appear in the calibration certificate below the table of calibration points.  
 
 

 

Figure 54 – Observation Register screen 

 
Observation 
 
  Observation name to facilitate the search of the desired observation.  
 
Text of Note 
 
  Text that will appear on the certificate, this text can be different for each strategy 
calibration if desired.  
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5.14.6. Operational Conditions10  

  The registration of tags allows the operation conditions of the tag to be registered. 
This data is optional and models can be built through the registers of tag operation 
conditions, so that a certain type of tag (transmitter, manometer etc.) will have the 
conditions ready to be filled in.  

 

 

Figure 55 – Operation Conditions tab in the dialog box Tags 

  

                                              
10 Available only on Isoplan with Datasheet module (DSh) 
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5.14.6.1. Preparing an operation condition sheet  
 

1. Choose one of the types of tag from the Tag Type list.  
2. Fill in the table in the Value column. This field is a free text, letters and numbers 

can be used.  
3. In the Notes field a brief comment can be added about the tag. 

 

Comments: 

• If it is necessary to register a specific property for this tag that is not listed in the 
model, choose one of the properties from the list in the center of the screen and 
click on the Add button. This property will be added only for this tag and will not 
affect other tags that use the same model. A new property can be created by 
using the button.   

•  Use the Remove button to exclude properties from the tag operation conditions. The 
property will be removed only for this tag and will not affect other tags that use the 
same template.  
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5.14.6.2. Technical Specification Report  
 

  ISOPLAN allows a technical specification report to be generated in the Reports > 
Technical Specification menu. This report combines information from the Instrument 
Datasheet and the tag operation conditions. 
 

 

Figure 56 - Technical Specification Report 
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5.14.7. Verifications  

 

 

Figure 57 – Verifications tab in the dialog box Tags 

  ISOPLAN has a simplified control of instruments that do not require calibration. 
This control is called verification. This tab specifies the items to be checked on the 
instrument periodically. See Verifications register. 
 

Choose one of the items from the list in the center of the screen and click on the 
Add button. This will be one of the items to be verified.  
 

Use the Remove button to exclude an item that does not require verification 
anymore.  
 

Click on the button  in case it is necessary to create a new type of verification 
that is not available. 
  

file:///C:/Users/admin/AppData/Roaming/Microsoft/isocsHtmlHelp/portbr/verifications.htm
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5.14.8. Create Calibration  

 

Figure 58 – Create Calibration tab in the dialog box Tags 

 The tag registration screen has a link to download and upload to Presys 
calibrator, you can also do a manual calibration without work order. 
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 Download to Calibrator 
 
 To download or upload to Presys calibrator, you must select the standard used, 
the communications port, and click the Download to Calibrator or Upload From Calibrator 
button. For more details refer to the manual section 6.2. 
 
 Manual calibration 
 

ISOPLAN allows users to create a calibration without the need to generate a work 
order, to create a calibration select the type of calibration and the calibration date, and 
click on the Create Calibration button. For more information about the type of manual 
calibration and external calibration laboratory, see Item 6 of the manual. 
 

The external laboratory calibration without calibration points can be used when is 
only needed date management with no fill points. 
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5.14.9. Photo Tag 

 

Figure 59 – Photo tab in the dialog box Tags 

 
  Used to add a photo of the location of the tag. Click the Change button to add or 
modify a photo and the Remove button to remove a photo associated with the tag. 
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5.14.10. Tag Search  

 

Figure 60 – Form tab in dialog box Search Tags 

 

  Through the button  it is possible to search the tags registered in ISOPLAN 
based on few details about the tag. The search procedure is as follows: 

4. Use the Form tab to fill in the data that is known about the tag. In the fields that 
allow texts to be typed in, a search can be made knowing only a few characters. 
For example, by typing TT for the Tag name, all tags whose tag name contains 
TT will be shown.  The fields that are irrelevant to the search can be left blank. 
See below further details about how to fill in the fields.  

5.  Select a sorting criterion in the Sort By field at the bottom of the screen. 

6. Click on the Search tab in the upper part of the screen. Click on the Start Search 
button to search the ISOPLAN register according to the criteria defined in the 
Form tab. The search result is shown in the table in the upper part of the screen. 
The search result can be printed by clicking on the Print Preview button, to check 
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the result of the printing, and then on the printer icon, to send the report to the 
printer.  

7. It is also possible to use the Use Search button to transfer the list of tags that 
were found to the list of tags on the registration screen. The Use Selected button 
can be used to display only the selected tags. Use the Cancell button if the list of 
tags that were found will not be necessary for further procedures.  

 

 

Figure 61 – Form tab in dialog box Search Tags 

 

Comments: 

• The Area field shows the Search all sub-areas option. When this option is 
selected, the search is made in the selected area and in all sub-areas of the initial 
area.   

• The Last and Next fields represent the date of the last and next tag calibration, 
respectively. Both fields allow three options: a) fill in the date on the left only ‒ in 
this case, calibrationsfrom  the specified date on will be searched for..  b) fill in 
the date on the right only ‒ calibrations performed until that date will be searched 



PRESYS  Instruments ISOPLAN-5 

Page 95 

for c) fill in both dates ‒ calibrations performed during the time interval between 
the specified dates will be searched for.   

• The Inactive field allows the search of tags associated to inactive instruments.  

 

5.14.10.1. Search Criteria 
 
  The group called Search Criteria allows you to save search criteria used. To use 
this feature do the following:  
 
1. To perform a search on Isoplan usually using a filter, for example, tags that begin 
with the letter "T" ("T").  
2. Enter a name for this search criteria, for example, "Temperature Tags" and click 
Save.  
3. To use this search criteria in the choice list "Name Search Criteria" the name 
entered in the previous step and click on "Start Search".  
4. To remove a saved search criteria click the "Remove". 

 
 
5.14.10.2. Exporting Search Results 

 
   The CSV Export button lets you export the search result in text format separated 
by semicolons and can be read by other programs such as Excel format in a simple and 
plain easier to manipulate the data. Reports of Isoplan can be exported to PDF, Excel 
and Word, but the formatting of these files cannot be well suited to handle the data in 
other programs, for example, to create a filter in Excel.  
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5.14.11. Critical Analysis of the Tag11 

  The tag register displays the "User Group" field where it is defined which group of 
users will be responsible for the approval of the tag.  

 
The critical analysis worksheet is created on the tags screen as follows:  
 

1. Click the menu Critical Analysis>Critical Analysis Worksheet  from the 
tags screen.  

 
2. Click the Save button to save registered data. The saved data consists of 

the list of tag register information and the instrument associated with the tag.  
 

3. Click the menu Main>Print Preview to verify that the data you have entered 
is correct. If any data is wrong go back to the tag register, correct the 
register and, after corrected, click again on the screen of the critical analysis 
worksheet, click the Update button to update the data in the worksheet and 
save the worksheet again.  

 
4. After checking the registration data, each member of the user group must 

enter the tag and approve the registration by clicking on the "Approve" 
button. This approval will generate an electronic signature being requested 
the user's password.  

 
5. All users in the group must approve the worksheet to the worksheet. If a 

user checks for an error, he can click on the "Reprove" button and justify 
the reason for the disapproval. In this case, the approval process must be 
started again and all users must re-sign.  

 
6. After approval of all users an approval number is generated and if 

necessary an approval document can be generated through the menu 
Main>Print Preview. 

  

                                              
11 Critical Analysis Module 
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5.14.11.1. Search for Critical Analysis 

 
The tag search screen allows you to find tags with pending critical analysis. The 
Pending Critical Analysis field has the following options:  

 
  (Pending): filters tags with pending review.  
 
 (No Critical Analysis): tags registered in Isoplan where no critical analysis was 
registered.  
 
 "Login": pending analysis for a specific user.  
 
 
 The User Group field allows you to find all the tags of a certain group of users.  
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5.15. Loops12  

 

Figure 62 – Diagram of a loop 

 
  The loop is a combination of two or more instruments connected so that the signal 
passes from one to the other in order to perform a measurement. For example, to 
measure a temperature it is possible to use a thermocouple sensor that is connected to a 
transmitter that converts the output signal of the thermocouple into an electric current 
signal of 4 to 20mA, and this current signal is applied in the input of a controller that 
indicates the temperature in degrees Celsius.  
 
  Isoplan has a loop register that is independent from the register of instruments or 
tags that would be the individual components of the loop. The loop and the tag (individual 
loop component) are treated equally in Isoplan and the main difference is that the loop 
screens do not contain instrument data because the loop is associated to several tags or 
instruments.  
 
  All screens to make the calibration (Work Order) and generate the certificates 
(Calibration Results) are duplicated with an option for tags and another for loops. This 
manual presents only the screens related to the tags because the operation of the loop 
screen is basically the same; the fill-in instructions can be used for both a tag screen and 
a loop screen. 
 
  The registration of a loop is similar to that of a tag. The Function/Interval, 
Calibration, Strategy, Operation Conditions and Verifications tabs are filled in the 
same way as in the registration of tags. The Components tab will be explained in the 
next topic. 
  

                                              
12 Available only on Isoplan with LOOP module 
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5.15.1. Loop Components  

 

 

Figure 63 – Components tab in the dialog box Loops 

 
 
  The Components tab shows all the tags (previously registered) that form the 
loop. The Measurement Comp. Measurement  (Measurement Component) is an 
information field to indicate whether a tag is used to perform a measurement. Usually the 
tags are used to perform a measurement, but there are cases of only auxiliary tags 
(instruments) such as a recorder that does not affect the accuracy or uncertainty of the 
loop. 
 
  Isoplan allows the generation of the  loop certificate from the certificate of each 
component of the loop. Isoplan will convert the errors and uncertainties of the certificate 
of each tag to the same unit of the loop and will combine these uncertainties as 
described in the appendix, for example, a certificate from a transmitter with output from 4 
to 20 mA requires errors and uncertainties to be converted from mA to °C. To perform 
this conversion it is necessary to fill some tag and loop range data in the Components 
tab table.  
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The following columns are defined in this table:  
 
Min. Tag, Max. Tag: output range of the instrument associated with the tag, for example, 
4 to 20 mA 
 
 To add a tag to the loop, select one of the existing tags and click on the Add 
button. 
 
 
  To remove a tag from the loop, click on the gray square to the left of the tag name 
to select it and then click on the Remove button.  

 
5.15.2. Loop Components 

 
  The Isoplan allows a calculation of the accuracy of the loop consisting of 
performing a calculation to combine  the accuracy of each component. The appendix of 
the manual explains how this calculation is performed. The value of the accuracy of each 
component corresponds to the value entered in the scale of the instrument. To generate 
a report with a loop accuracy calculation result click on the menu Reports > Loop 
Accuracy> Print Preview . in the loop register screen.  
  
 The calculation of the loop accuracy is independent of the existence of 
calibrations of the loop tags. In the Strategy tab there is a column in the calibration 
points table that allows you to set the required accuracy for the loop. The required 
accuracy can be compared to the calculated value and an diagnosis can be issued if the 
accuracy of the loop is in accordance with the desired value. The diagnosis must be 
defined by the Isoplan user through the fields of the Accuracy Diagnosis of the Loop 
group.  
 
  Isoplan allows you to generate a report with a list of loop components by clicking 
the Reports> Loop Register> Print Preview menu. in the loop register screen.  
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5.16. Companies  

  Isoplan allows a single data base to store the registration of multiple independent 
companies. In the login the user must choose the company he or she works for. 
Supervisor-level users can create new companies. 
 

 

Figure 64 - Dialog box Companies 

 
 Company  
  Text with the company name that is shown only in the login of Isoplan. Refer to 
the Configurations topic to define the company name that is shown in the certificate.  
 
Inactive 
  A company cannot be deleted after it has been created. Click on the Inactive 
option if you do not want the company to be shown anymore as an option in the login.  
 
  Although there is a single data base, it is not possible to share register data 
between companies. For example, if the user belongs to more than one company, he or 
she must be registered in all companies. The same occurs for the other Isoplan screens, 
such as Areas, Instruments, Standards, Tags etc.  
 
  When a new company is created, a new user is automatically created with 
login "admin" and password "admin".Close ISOPLAN and log in again by selecting 
the new registered company on the login screen. The Scales, Failures, Types of 
Instruments and Operation Conditions registers show some data to facilitate the initial 
registration, but this data can be changed if necessary. The Areas, Standards, Tags 
and Instruments registers are empty when a new company is created.   
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5.17. Register of Clients13  

 

 

Figure 65 – Clients dialog box 

 
  Registration clients screen for Isoplan with service provider module. 
 
  Client: Client Name of shorthand that appears on the screens of Isoplan. 
 
 Full Name Client: text with client's name. It should appear in the calibration 
certificate.  
 
 Client Address: text with client's address. It should appear in the calibration 
certificate.  
 
  There is no necessary to create several companies, one for each client, one 
company can be created, for example, with the laboratory name and for all clients 
equipment in this company which corresponds to the laboratory. In Isoplan there is an 
option to search tags or calibration of a specified client. 
 
  

                                              
13 Service Provider Module 
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5.18. Configurations  

 This screen shows the general configuration of ISOPLAN. 
 
5.18.1. Company  

The tab presents information about the company that is using ISOPLAN. 
 

 

Figure 66 – Form tab in dialog box Configuration 

 
Company Name  
 
  Text with the company name that is shown in the Isoplan reports. 
 
Logo of Reports  
 
  ISOPLAN allows the company logo displayed in the reports to be changed by the 
user. In order to change the logo, do as follows: 
 

1. Click on the Change button to open a dialog box and insert the picture of 
the logo. The picture must be in Windows bitmap or PNG format.  
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2. ISOPLAN shows a preview of how the picture will appear in the certificate. 
The Width (mm) and Height (mm) options allow the size of the picture to 
be changed in order to obtain a better printing result, for example by 
reducing a little the picture height or width to avoid conflict with the 
margins of the report.   

 

Verification 
  The texts shown in the verification report (Approved, Reproved or N.A.) can be 
changed in case a different terminology is required. 
 

Tags - Enable Tag Operation Condition 

  Enable option tags operating conditions. 

Tags - Tag Photo 

  Enables tag photo register  

Tags - Area 

 The Isoplan allows users edit the word area, the change is made in the calibration 
certificate, the tags screen and in the area registration screen. 

Instruments - Instrument Photo 

  Enable Instrument Photo 

Instruments - Register Number 

The Isoplan allows users edit the word Register Number, the change is made in the 
calibration certificate and in the instruments registration screen. 
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Enable Register Auxiliaries Menus 

  Unchecking this option allows users to remove some auxiliary menu screens from 
home screen of Isoplan as scale signals, operating conditions and others that can be 
accessed through other screens. 

 
Simplified certificate 
 
 Allows the user to register the standard simplified certificate, no need to fill 
calibration values, in this case, the standard uncertainty is estimated for the accuracy of 
the registered range. 
 
Certificate without W.O. 
 
 Allows registering the standard certificate without generating a work order 
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5.18.2. General  

 

Figure 67 – Form tab in dialog box Configuration 

 
  This screen shows the general configuration of ISOPLAN. 
 
Enable Operator Signature  
 
  When this option is selected, it indicates the report must bear the signature of the 
operator. 
 
Enable Reviewer Signature  
 
  When this option is selected, it indicates the report must bear the signature of the 
reviewer. 
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Enable more than one signature per user  
 
  When this option is selected, it indicates the same user can sign the same 
certificate more than once, for example the same user is the operator and the person in 
charge of the certificate. 
 
Enable scanned signature 
 
 When this option is selected, it indicates the report will be signed with a digital 
signature that was registered in User Registration. 
 
Enable manual certificate number 
  
 When this option is selected, it indicates that the calibration certificate number will 
be determined manually by the user. 
 
 Enable editing lock 
 
 When this option is checked it indicates that the isoplan registration screens will 
initially open with the controls locked, i.e. not allowing editing, editing will only be allowed 
after the user unlocks by clicking on the padlock. 
 
Maximum Inactivity Time  
 
  If the user leaves the software open without clicking on any Windows screen for 
the time specified in this field, ISOPLAN is automatically closed. If the user is working 
with other software, the time is not counted as inactive. Inactivity time begins to be 
counted only if no application is being used. It is necessary to restart ISOPLAN for the 
alteration to be effective.  
 
Enable Automatic Frequency Adjustment 
 
  This option allows ISOPLAN to adjust automatically the frequency of calibration 
after data has been input on the Calibration Results screen. The adjustment algorithm 
is explained in the manual appendix and is based on the Schumacher table and the 
factors explained below.  
 
Increase Factor  
 
  This factor is used by ISOPLAN to define the increase in the interval between 
calibrations. In the example in the figure, if the calibration interval is 30 days then the 
new interval will be 1.1 x 30, which corresponds to 33 days.  
 
 
Reduction Factor  
 
  This factor is used by ISOPLAN to reduce the interval between calibrations. In the 
example in the figure, if the calibration interval is 30 days then the new interval will be 0.8 
x 30, which corresponds to 24 days.  
 
Max. Reduction Factor 
 



PRESYS  Instruments ISOPLAN -5 

Page 108 

  This factor is used by ISOPLAN to reduce the interval between calibrations when 
the Schumacher table indicates a maximum reduction in the calibration interval. This 
value must be lower than that of the Reduction Factor.  
 
Calibration Alarm - Alarm Period 
 
  Number of days in the calibration alarm of Isoplan entry. For example a value of 
30 indicates that the Isoplan shows the number of calibrations expiring within 30 days. 
Set it to 0 to disable the alarm.  
 
Calibration Alarm - Enable calibration alarm with signature pendencies. 
 
 Select this option to display an alert showing  how many calibrations are 
pendency with some kind of signature when the dialog box of  "Calibration Result" 
is opened. 
 

 
 

Figure 68 - Calibration Alarm with signature pending dialog box 

 
Print Preview:  loads a report with a list of all calibrations with selected signature 
pendencies 
View Calibrations:  view calibrations to the type of signature with selected pendency 
Close: loads the calibration results dialog box normally 
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5.18.3. Service Provider14 

 

Figure 69 – Service Provider tab in the dialog box Configurations 

 

Data Service Provider in the Bottom of the Certificate 

  Text with name and address information of the service provider being displayed in 
the footer of the certificate. 

  

                                              
14 Optional Module 
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Accreditation Logo 

ISOPLAN allows the company logo displayed in the reports to be changed by the user. In 
order to change the logo, do as follows: 
 

3. Click on the Change button to open a dialog box and insert the picture of 
the logo. The picture must be in Windows bitmap or PNG format.  

4. ISOPLAN shows a preview of how the picture will appear in the certificate. 
The Width (mm) and Height (mm) options allow the size of the picture to 
be changed in order to obtain a better printing result, for example by 
reducing a little the picture height or width to avoid conflict with the 
margins of the report.   

 

Accreditation Text Header 

  Free text with up to 4 lines shown in the headings of accredited certificates, for 
example, accreditation number.   
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5.18.4. Certificate 

 

 

Figure 70 – Form tab Certificate in dialog box Configurations 

 
  Observations 
 
  List of observations that can be used in strategies or a tag calibration ranges. 
Click the button next to the list to add new types of observations.  
 
 Operational Conditions 
 
  Environmental conditions that are filled by default in the certificate. These fields 
can be changed for each calibration.  
 
  Positions in the Certificate 
 
  The position that appears below the full name (operator, reviewer and 
responsible) can be changed according to user needs.  
 
  Calibration Fields 
 
  The fields: next calibration and period, area, criticality, acceptance criticality, 
failures and situations and comments can be shown marked fields in the settings screen, 
or removed from the certificate if unchecked the settings screen.  
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 Automatic Diagnosis 
 
  When this option is enabled, Isoplan gives the diagnosis (approved or reproved) 
automatically on the calibration certificate comparing the error or the error more 
uncertainty with the acceptance criteria defined by the user.  
 
 Register Standard at Download 
 
  When this option is enabled, during download, the user has the option to choose 
the standards used for each tag that belongs to the work order.  
 
 Add Standard Automatically 
 
  This option allows the Isoplan during the download, try to automatically find the 
used scales and standards. This automatic choice only works if they have been 
registered the standard certificates with signature. This choice uses only the scale of the 
main standard selected in the download and Isoplan can not locate calibration scales 
that involve more than one standard.  
 
 Shows Next Calibration Day  
 
  This option sets Isoplan to display the date format of the next day calibration. To 
display the next calibration date in month and year format, disable this option.   
 

Certificate Title 
 

Title of external laboratory certificate 
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5.18.5. Excel DataSheets15 

 

 

Figure 71 – Form tab Excel worksheet in dialog box Configuration 

 
 

Sync Existing Directories 

 
  Directories where spreadsheets are saved that can be sent to devices mobile. 
Usually this folder should be the synchronization folder between the computer and the 
selected mobile.  
 
Add Synchronization Directory 
 
  Isoplan allows users to create multiple directories where the Excel datasheet are 
temporarily saved, for example, one for each Palm to be connected with the computer.  
 
 To create a new directory must be completed two fields:  
 
Isoplan Name: a name to identify within the Isoplan to which device the sheets will be 
sent. Isoplan automatically creates a new directory with the name you entered. 
 
Excel Spreadsheet directory: directory where the spreadsheets are saved. When using 
in conjunction with a Palm. It must be used the directory defined in synchronization 
software that came with the equipment. 
 
                                              
15 Optional Module 
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5.18.6. Exportation 

 

Figure 72 – Form tab Export in dialog box Configuration 

ISOPLAN allows users to set the path where the exported certificate will be saved 
 
Installation Directory Isoplan 
 

When this option is checked indicating that the export certificates will be saved in 
the ISOPLAN installation directory. 
 
Save in the respective area directory 
 

When this option is checked it indicates that the exported certificates will be saved 
in a folder with area name that the tag / loop belongs. ISOPLAN automatically creates 
the installation directory a folder called Export,  Export folder within the folders will be 
created with names of areas. 
 
 ISOPLAN also lets users save the exported certificates in any other directory, 
simply leave the options Installation Directory Isoplan and Save in the respective area 
directory blank  and fill the path manually in the text box. 
 
5.18.7. Password 
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Figure 73 – Form tab Password in dialog box Configuration 

The complexity of the Isoplan access password can be defined by the user 
according to the following parameters: 

 
Number of Characters 
 
 Minimum number of uppercase characters that must compose the password  
 
Quantity Lowercase Characters 
 
 Minimum number of lowercase characters that must compose the password  
 
Quantity of Numbers 
 
 Minimum number of numeric characters  to compose the password  
 
Quantity Special Characters 
 
 Minimum number of special characters that must compose the password  

 
Max. Invalid Attempts  
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  Number of invalid attempts to log in ISOPLAN using a wrong password. If the user 
exceeds this limit, access is blocked and the user must be unblocked as described in the 
Register of Users screen.  
 
Min. Password Size  
 
  Number of characters that must be used in the password. 
 
Change Password Time (days) 
 
 Time, in days, that the password should be changed. When trying to login into 
Isoplan with an expired password, it is requested to replace it, which must follow the 
parameters that were determined in the above configurations. The new password must 
be different from the last five passwords used by the user  
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5.19. Users  

 

 

Figure 74 - Dialog box Users 

 
  Access to ISOPLAN is allowed only to registered users. Below is a description of 
the fields in the register of users. The permissions of each user level are defined on the 
Permissions screen. When a user is created, the standard password is 1234 and it must 
be changed in the first login. In case the user forgets the password, click on the Reset to 
default password button to return to the password 1234. 
  
 
Registered users 
 
  List of registered users.  
 
Login 
 
  User name or nickname to be used when logging in the program. 
 
User Level 
 
  The program has four user levels: read-only; operator; reviewer; supervisor. The 
read-only level only gives access to reading in the program. The supervisor level always 
gives complete access to ISOPLAN. Users' access to certain ISOPLAN screens can be 
limited through the permission register, which can be accessed in the Register > 
Permissions menu.  
 
User name 
 
  Full name of the user, which will be shown in the certificate.  
 
Blocked User 
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  This field is selected when the user exceeds the maximum number of invalid 
attempts with an invalid password to log in the program. This number is adjusted in the 
Configurations screen. 
 
Inactive User 
 
  A user should not normally be deleted from ISOPLAN because in general he or 
she may have signed several certificates. If the user leaves the company or does not 
need to access ISOPLAN, he or she can be made inactive so that access to the program 
is blocked even if the password is correct. 
 
Signature 
 
 Using the buttonAdd it is possible to assign a figure that will be used as the user's 
signature,will be used only when the Use digitized signature  option in the configuration 
register is enabled. 
 
  Isoplan allows you to print a list of registered users through the Main>Print 
Preview menu.  
 
 Isoplan allows visualize if there are other users connected to the same database, 
simply select the user and observe the indication Online User. 
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5.20. Permissions  

    It allows access to ISOPLAN screens to be defined depending on user 
level. The list on this screen (Registered permissions) shows the name of ISOPLAN 
screens and cannot be changed. The types of permission are as follows: 
 

1.  No Access: user does not have access to the screen and a warning is shown 
indicating that access is blocked. 

2. Read: user can access the screen but may only read it. 

3. Operation: user has full access, allowing changes to be made. 

 

Figure 75 - Dialog box Permissions 

  
  ISOPLAN allows access to be controlled only by user level ‒ there is no option to 
limit access of a specific user to certain screens. ISOPLAN allows the user permissions 
to be configured as Read-only, Operator and Reviewer level. A user's level is defined 
when he or she is registered. In order to define the permission of a certain screen, do as 
follows:  
 

1.  Choose the screen whose permissions will be adjusted, e.g. Standards, on the 
Registered Permissions list. 

2. Choose the level of permission (No Access, Read or Operation) for each user 
level (Read-only, Operator and Reviewer).  

3. Click on the button  to save the data. 
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Isoplan allows printing the list of permissions registered through the menu Main > Print 
Preview. 

 

Comments: 

•  The screens for registering users and permissions are configured by default with 
blocked access. Enabling access to these screens is not recommended.  

• The Supervisor user level always has complete access to the program. It is not 
possible to define permissions for the supervisor user.  

 

 

5.21. User Group 16 

 
The use of the critical analysis module requires the creation of a group of users to 
approve the instrument register. Multiple user groups can be created that can approve 
one or more Isoplan tags. The user group can be created through the menu Register> 
User Group.  
 
  The fields on this screen are as follows:  
 
  Group Name: user defined text identifying the name of the groups.  
 
  User 1 ... User 4: List of users who are part of the group corresponding to one of 
the users registered in Isoplan. If the group has less than 4 users, leave the unused 
users blank.  
 
 
  

                                              
16 Critical Analysis Module 
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5.22. Audit Trail 17  

 

 

Figure 76 – Dialog box Audit Trail 

 
 
  All operations of creation, edition and deletion of registers in ISOPLAN are 
recorded in a log file (audit trail), which allows everything done in ISOPLAN to be 
checked. 
 
  The function of the Audit Trail screen is to search the log files for information of 
interest to the user, e.g. all modifications within a certain interval, modifications to a 
certain screen etc.  
 
  The use of this screen is similar to that of the search screens in ISOPLAN: fill in 
the fields of interest to track modifications (e.g. Tag, Registration Number etc.) and 
click on the Print Preview button.  
 
  The Screen field filters the search for the changes made to a certain ISOPLAN 
screen, for example tag screen, instrument screen etc.  
 
5.23. User Password  

  At any moment the user can change his or her password through the Register > 
User Password menu. In order to do that, the user must type in the current password 
and then the new password twice. The user must define a password that is different from 
the current one and respect the limitation of password size defined in the 
Configurations screen.  
 
 

                                              
17 Isoplan with Audit-Trail module "AT" 
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Figure 77 – Dialog box User Password 

 
5.24. Login/Logoff 

Isoplan allows user switching without restarting the software, just do Logoff and Login. 
 
To make the logoff, click on "Register">"Log Off". 
 
To make login, click on "Register">"Log in". Select the company that user is registered 
and fill in the fields "User" and "Password 

 
 

 
 

Figure 78 – Dialog box Isoplan Login 
 
 

5.25. Quick View Panel 

The quick display panel is used for view Tags, Loops,Overdue Standards and 
Calibrations with pending signatures. 
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Figure 79 – Quick View Panel dialog box 
 

To Enable Quick View Panel click on menu Register>Configurations, select 
General tab, click on Enable Quick View Panel Tags, Standards and Calibrations 
and click on Save. 

 
Using Quick View Panel 

 
Put the mouse pointer over the lower right corner of Isoplan screen, to display the 
options panel. 

 

 
 

Figure 80 – Quick View Panel 
 

 
Standards 
 
It shows standards that are overdue, select the standard option and click view. 

 
 

 
 

Figure 81 –Quick View Panel - Standards 
 
 

Tags  
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It shows tags and loops that are overdue, select the tags option and click view. 
 
Calibrations 
 
It shows calibrations with pending signatures, select the desired option and click view. 

 

 
 

Figure 82 –  Quick View Panel - Calibrations with pendencies signatures 
 
 

 
6. Work Orders W.O.   

  Calibration data is input in ISOPLAN by means of a work order (W.O.), which 
consists of a set of tags to be calibrated. This work order can be executed in the 
following ways: 

1. By using one of Presys calibrators, the W.O. is downloaded from the computer to 
the calibrator and the data stored in the calibrator is uploaded to the computer.  

2. By sending the W.O. data directly to the printer or to the computer screen, without 
necessarily using one of Presys calibrators (Manual Download). The data 
obtained in the calibration can also be input through the computer keyboard 
(Manual Upload). 

3. By sending the W.O. data directly to the printer or to the computer screen, as in 
the previous way, but also sending the W.O. to an external laboratory that will be 
responsible for the calibration, adjustment and issuing of the instrument 
certificate. Only some of the data from the certificate provided by the external 
laboratory will be input in ISOPLAN.  

4. Create Excel spreadsheets with calibration data so that this data can be entered 
on other computers or mobile devices capable of editing Excel spreadsheets. 

 
6.1. Creating a W.O.   

  In order to execute a work order, it is first necessary to create a W.O. and to 
choose the tags that will be part of it. After it has been created, the W.O. can be sent to 
one of Presys calibrators or it can be executed manually. This screen has edition buttons 
similar to those of the register screens. Refer to the Toolbar topic to create and delete 
registers, which in this case correspond to a W.O..  

mk:@MSITStore:C:/isoplans/Isoplan50QuimicaAmparo/bin/pt-BR/isocs.chm::/toobar.htm
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Figure 83 – Register/Download W.O. dialog box 

 
6.1.1. Choosing Tags for the W.O.  

  The creation of a W.O. requires first that tags that will be part of the W.O. be 
located in the register. There are two options: 
 

1. Search by Tag name: click on the Tags List button. This option will list all 
registered tags, the filter can be done through the text box next to the tag name 
typing some characters that compose it. 

2.  General Tag Search: a more advanced search can be made by using the same 
search screen of the tag register. Click on the General Search button and follow 
the same instructions of the Tag Search register screen. Click on the Use Search 
button and the located tags will be displayed in Tags Available.  

Note: 

• In the Tags Available section, when a certain tag is clicked on, information about 
the tag is shown (Next Calibration, Registration Number, Instrument Model and 
Area).  
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6.1.2. Creating or Editing a W.O.  

  After the Available Tags table indicates which tags must be calibrated, the W.O. 
creation can be initiated, according to the following procedure: 

1. Press the New button  to start a new W.O.  

2. Fill in the area W.O. name with a text for the W.O. name. Each W.O. registered in 
ISOPLAN must have a name.  

3. Select the main standard to be used and the serial port of the microcomputer, 
COM port  (The COM port that has "<->" in the name are the ports that are 
available).  
 

 

4. Click the square next to the table tag Available Tags to select it and click the "<" 
button to transfer the tag to table W.O. Tags. The tags in this table will be sent to 
the calibrator or will be manually calibrated. If necessary, one of the tags can be 
removed by selecting the tag on the W.O. Tags table and pressing the Remove 
button.  

5. Press the Save button to save the W.O created. 

 

  Next to the list tags, there is a column where the calibration status of each tag in 
the examined W.O. is indicated. Each tag added to a W.O. receives the classification 
NW, indicating it is a new tag. The DL status is presented by tags which have been 
transferred to a Presys calibrator through download operation and by tags used with 
manual download operation. UP corresponds to: tags whose calibration information has 
been uploaded from a Presys calibrator; tags created through manual upload; or tags 
where false download operation was used. MA is shown next to tags without 
calibration, whose W.Os have been closed manually. The tags corresponding to the 
calibrations deleted in the Calibration Results dialog box are indicated by DEL. 

  It is possible to issue a work order report or verify its layout by selecting "Print 
Preview" or "Print" from the Report menu. Each tag of the work order is followed by the 
description of the instrument function, the calibration identification (1 or 2), serial number, 
area, status and amount of time spent in the calibration (in hours). 

 Isoplan allows users to sort the list of work order by name or by date through the 
menu Settings>Order by name or Order by date. 

 

 
6.1.3.  Choice of Standards Used in Calibration 
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  The Isoplan presents two options that allows the choice of standards used during 
the download.  
 
 The option "Request Standards in Download" makes Isoplan ask the standards 
used for each tag of the WO during the download.  
 
  Click the option Add "Add Standards Automatically" to Isoplan to try find the 
scales used by standard. This option works when it is been used Presys calibrators, 
certified standards have been registered and signed in Isoplan and it was used a single 
scale of Presys calibrator to generate or read a signal. Obs.: It is not possible to make 
download of inactive tags  
 
 
6.2. W.O. Download   

  The act of sending calibration information to Presys equipment is called 
Download. In case a Presys calibrator is not used and the data is collected manually, 
the Manual Download must be used. There are several types of Downloads, as shown 
below:  

Obs.: It is not possible to make download of inactive tags. 

 
6.2.1. Download to Presys Calibrator  

  In order to transfer one of the work orders from the "W.O." list to the Presys 
calibrator. Select the W.O. so that its name in the "Registered W.O.s" list is indicated. In 
the "Download" menu, start the work order transfer by choosing the "Download Field 
Calibrator" command.  

  It is not necessary to carry out all the calibrations of all the tags of the same W.O. 
loaded to the Presys calibrator. However, after the calibration results have been 
transferred to the computer through Upload, it is not allowed to carry out a new 
download of the previously calibrated tags. In order to execute the remaining 
calibrations, it is possible to carry out a download of the same W.O. again. In this case, 
ISOPLAN will transfer the tags without calibration only (NW or DL status). 
 

  When there is a tag registered in more than one W.O., it is possible to download 
the tag only if there is no other W.O. with the same tag with a hanging calibration, that is, 
with DL status. Otherwise, Isoplan shows an error message, along with the name of the 
W.O. that contains the tag already loaded, and it is necessary to wait for its upload or, if 
necessary, the W.O. can be closed manually with the Close W.O..  command in Main 
menu (the NW or DL status of each tag becomes MA). 
 
6.2.2. Download to Presys Calibrator DMY-2017 PSV 18 

To send a work order to the DMY-2017-PSV calibrator, follow the steps:  

                                              
18 Available only on Isoplan with safety valve module (PSV). 
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1. Add the tag on the OS, it is only allowed a single tag.  
 
2. Select as calibrator model "Presys DMY-2017 Calibrator Online" 

 
3. Save and click on Download> Download Field Calibrator menu.  

 
4. It must be shown an operating screen to make the valve calibration with 2017 as 

explained in the next section.  
 
6.2.2.1. Calibrator operation DMY -2017 PSV by Isoplan 
 
  The calibration of the DMY-2017 is made in the online mode, the calibrator should 
be connected to the computer during the calibration, it is not possible to perform the 
calibration autonomously and transfer the data stored in calibrator to Isoplan as in other 
calibrators Presys like Isocal, PC-507, etc.  

 
  Before starting calibration is necessary to adjust the Calibrator group settings: 
 

• Channel: choose which channel will be used 1 or 2.  
 
• Enter the C1 field value, in psi, pressure capsule used at channel 1.  

 
 
 

• C1 Time: maximum time in seconds for channel 1, after detection of the valve 
opening peak pressure, for the calibrator to find the minimum pressure point 
corresponding to valve closure. This value may be a few seconds, for 
example, 10 (s).  

 
• RTU communication type: used when communication between the Isoplan 

and PSV station is made by serial communication. The modbus address is 
usually 1, but can be changed..  

 
• TCP communication type: used when communication between the Isoplan 

and PSV station is made by Modbus/TCP communication. The modbus 
address can be set, usually 1, the IP address and port of the TCP protocol, 
usually 502.  

 
The operation of the Isoplan 2017 is made as follows:  

 
 

 
1. Select whether it will perform preliminary calibration of the valve (As 

Found) or final calibration (As Left).  
 
2. Choose which repetition or test will run, it is usually recorded one test in 

the preliminary calibration and 3 tests in the final calibration. The same test 
can be repeated several times, but only the last had been saved in 
Isoplan.  
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3. Once the safety valve is connected to the compressor click the Start 
button. If the connection with calibrator is running it should be shown on 
the screen the pressure value indicated by Presys calibrator and a graph 
with pressure versus time.  

 
4. Increase pressure on the valve and wait until its opening  

 
 

5. After the peak pressure calibrator is detected waits for the set time and 
measures the minimum corresponding to valve closure. In the bottom of 
the screen are shown the opening points and closing of the valve detected 
by Presys calibrator.  

 
6. Click the Save button to save the test and perform the other tests 

repeating the previous steps again. If the next point for Question option 
is enabled the Isoplan open a message box asking if you want to start the 
next test.  

 
7. After you performed all tests and have clicked Save, the screen can be 

closed and return to Isoplan to transfer the calibration data for the Isoplan 
database. The data is saved in a temporary file while it is not transferred to 
the Isoplan, but if you made a new download for the same tag of this valve, 
all calibration values will be lost.  

 
6.2.2.2. Pressure graph 
 
  The graph has some simple "zoom" features. Click and drag to zoom a particular 
region of the graph. Click the button  that appears on the scroll bar below the graph to 
undo the zoom.  
 
  Click on a point of the graph to display a cursor, there are two fields below the 
graph showing the pressure value and the time point selected by the cursor. Span field 
corresponds to the time interval in minutes shown by the chart when the test is initiated.  
 
6.2.2.3. DMY -2017 Calibrator Operation with Block Valve 
 

The operation of the calibration screen is performed as follows:  
 

1. Adjust the communication configuration in the same way as explained in the 
previous topic.  
 

2. Set a time for recording the pressure value, the stabilization time of the tag screen 
is used.  
 

3. Choose either As Found or As Left.  
 

4. Type a text as a test description, for example, "Direction" A "Open".  
 

5. Click Start to start the test.  
 

6. Click End if you want to end the test before the specified time.  
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7. You can hit the position of the chart annotations by dragging with the mouse. 

 
8. After you performed all tests and have clicked Save, the screen can be closed 

and return to Isoplan to transfer the calibration data for the Isoplan database. The 
data is saved in a temporary file while it is not transferred to the Isoplan, but if you 
made a new download for the same tag of this valve, all calibration values will be 
lost.  

 



PRESYS  Instruments ISOPLAN-5 

Page 131 

  .  
6.2.3. W.O. Manual Download   

  The manual download is normally used in calibrations where there is no 
participation of a Presys calibrator. This download consists of a report that must be filled 
in manually by the operator in charge of the calibration. 
 
  The manual download is initiated by clicking on Manual Download on the 
"Download" menu. Then, the reports are seen on the screen. 
 
  The report for each tag in the W.O. consists of a header filled with information 
about the instrument corresponding to the tag, calibration and adjustment tables with the 
calibration and reference values specified for the calibration sequence, and the 
remaining fields for reading values ("as found" and "as left") blank so that they can be 
filled later. 
 
  The update of the tag status and the restrictions about pending tags mentioned in 
the previous section also apply to manual download. 
 
  It is important to highlight that the manual download does not depend on the 
calibrator chosen during the creation of the W.O. It is not necessary to have ISOCAL or 
any other Presys calibrator to perform the manual download. 
 
6.2.4. Manual Download External Laboratory  

  This option has the same characteristics of a manual download and must be used 
when the instrument is sent to an external laboratory or when the calibration is carried 
out by a third party, who issues a previously prepared calibration certificate. In this case, 
a blank report is issued showing the calibration points, and this information must be part 
of the certificate issued by the external laboratory, which basically consists of the value 
measured by the instrument, the uncertainty and the K factor for each calibration point.  

 
6.2.5. Download Loop Calculated 19 

  The creation of the calculated loop certificate is done through the menu command 
Download>Download Manual Loop Calculated similarly it would be done to calibrate a 
loop through field measurements, but in this case Isoplan uses the certificate of each 
loop tag to creation of the loop certificate. After the download is completed, this screen 
can be closed and click the menu Results>Calibrations Result>Loops to issue the 
loop calculated certificate. 

 
6.2.6. Download to Excel Worksheets20 

 
  Isoplan allows users to do calibration using Excel spreadsheet to be sent to other 
PCs, Palms and other devices that work with spreadsheet Excel 2000 or higher. This 
feature is only available with Isoplan with Excel datasheet module.  
                                              
19 Optional Module Loops (ML) 
20 Optional Module Data Collector (CDE) 



PRESYS  Instruments ISOPLAN -5 

Page 132 

 
6.2.6.1. Excel Settings 
 
  Before starting the download of Excel datasheet verify if Excel 2000 or higher is 
installed on the machine and set the directories where the datasheet are saved through 
the menu "Register>Configurations>Excel DataSheets."  
 
  Isoplan allows users to create multiple directories where the Excel datasheet are 
temporarily saved, for example, one for each Palm to be connected with the computer.  
 
 To create a new directory must be completed two fields:  
 
Isoplan Name: a name to identify within the Isoplan to which device the sheets will be 
sent.  
Excel Spreadsheet directory: directory where the spreadsheets are saved. When using 
in conjunction with a mobile device it is recommended to use a directory synchronization 
software that came with the device. 
 
6.2.6.2. Create Excel Spreadsheet 
 
  An WO must be created in Isoplan the same way as was done in previous 
versions of the software.  
 
  After creating WO click on Download>Manual Download Excel menu to create 
spreadsheet with the data that should be collected during calibration.  
 
  Before the creation of spreadsheet, Isoplan asks for a confirmation with the 
directory where the spreadsheet will be sent. These directories are created in the 
configuration screen as explained in the previous section.  
 
  After sending datasheet, Isoplan opens the directory where the sheets were 
created.  
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6.2.6.3. Fill Spreadsheet 
 
  They must be completed in the spreadsheet fields where the cells are colored 
background. No checking of data is made in the spreadsheet, only during the transfer of 
the sheet to the Isoplan. The data entered are the same present in Isoplan screen. 
 

6.2.7. False Download  

  This kind of download aims to document any tag that should be calibrated on a 
certain date but, for some reason, such as the impossibility to stop the process, the 
instrument which occupies the position of the corresponding tag has not been authorized 
for calibration. 
 
  False download is initiated by clicking on False Download and it works the same 
way as the two other types of download. But, in this case, no report is issued and no 
instruction is sent to the Presys calibrator. In this operation, all the data about the tags of 
the work order are made available for the preparation of calibration reports (Results 
menu), and the tables concerning the calibration values are not filled in. 
 
 
6.2.8.  W.O. in Isoplan with Service Provider Module21 

 
  The name of the work Order (WO) will be shown in the calibration certificate. After 
downloading the WO it can not be erased or altered. 
 
 
6.2.9.  Work Order Search 

 
  The work order has a search option when clicking the button with binoculars icon. 
There is an option to filter by the name of the OS, tag name and status of the OS 
(pending or closed). It is possible to search knowing only a few characters that makes up 
the name tag or OS  
 
6.2.10. Report and Closing of a W.O.  

  ISOPLAN allows the printing of a report with the list of tags that are part of the 
W.O. on the Main > Print Preview menu. There is also the option of sending the report 
directly to the printer using the Main > Print menu  
 
  The execution of a W.O. using ISOPLAN starts when calibration data is sent to 
the Presys calibrator (download) or when a blank report, which must be filled in with 
data, is issued (manual download), as well as when calibration information is collected in 
the field or in a laboratory and when the calibration data is entered into ISOPLAN via 
serial communication (upload) or typing (manual upload).  

                                              
21 Optional Module Service Provider (PS) 
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Figure 84 –Work Order Report 

 
  After the download, a W.O. tag cannot be used in new work orders until the 
upload has been performed. If for any reason the tag upload cannot be performed and it 
is important to keep the W.O., a procedure called closing of the W.O. must be carried 
out. The closing of the W.O. is carried out through the Main > Close W.O. menu, 
showing ISOPLAN that this work order has been closed by the operator and no more tag 
calibration data uploads will be performed. 
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6.3. Upload from Field Calibrator  

  After the instrument calibrations have been performed by the Presys calibrator 
following the instructions on the work order, the results can be transferred to the 
computer. Connect the calibrator to the network and and click on the Upload > Upload 
menu.  
 
The Upload presents two options:  
 
  All Tags Calibrator: uploads all present tags in Presys calibrator.  
 
  Only Tag Selected: upload only the selected tag from the calibrator, with 2017 
this option can be used when you want to end an incomplete calibration, for example, it 
was only done the preliminary calibration and you like to end the final calibration, in this 
case the operation screen calibration of 2017 appears again. Isoplan does not allow the 
transfer of calibration data for the Isoplan database partially, if is transferred only the 
data of the preliminary calibration will not be possible later transfer the data of the final 
calibration having to run a new work order. 
 
  Tasks created in the Calibrator: Isoplan allows you to upload data from a task 
that was created manually using an advanced Presys calibrator. This functionality 
basically aims to transfer the calibration values. The tag or instrument must be registered 
in Isoplan before uploading from calibrator. The calibrator must be connected and 
networked with Isoplan so that the tasks created in the calibrator appear on the Upload 
screen. The upload should be done as follows:  
 

• Select the the option Tasks Created in Calibrator. 
 

• Click Search to locate the tasks created in the calibrator. 
 

• Select a tag and click the Upload>Upload menu. The tag list displays the 
tag name and instrument number.  

 

Isoplan allows users to order the uploads list by name or by date through the menu 
Settings>Order by name or Order by date OS. 

 

  During the upload, in case the registration number of the instrument on the 
calibrator has not been entered (serial number), a screen called Confirm Changes 
Upload will appear. In this moment, the registration number on the list Registration 
Number must be selected, and then it is necessary to click on OK to resume the upload.  
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Figure 85 – Dialog box Upload from Field Calibrator 

 
 
  After the upload is finished, the tags that were in the calibrator are removed from 
the Pending Tags list. In order to view the calibration data, it is necessary to go to the 
Calibration Results screen on the main screen menu of ISOPLAN   
Results > Calibration Results. If a tag cannot be found, use the option Tags General 
Search on the Results screen. 
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6.4. Manual Upload  

  The filling in of calibration data is initiated through a dialog box called Manual 
Upload (it is opened by using the W.O. menu on ISOPLAN main window), where all the 
tags with available manual download are shown. Choose one of the tags and select the 
option Upload, so that the window Manual Upload Data Entry appears. 

 

Figure 86 – Dialog box Manual Upload 

 

Isoplan allows users to order the uploads list by name or by date through the menu 
Settings>Order by name or Order by date OS. 

You can delete the tags of Pending Tags list through the Delete Upload button. 

 

 
6.4.1. Manual Upload Input    

  The data collected during calibration must be entered on this screen. Choose the 
option As Found to enter the initial calibration data and As Left to enter the final 
calibration. Then, fill in the table fields and click on Save to save the calibration data. 
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Figure 87 – Dialog box Data Entry Manual Upload 

 
  After saving, the tag is removed from the Pending Tags list. In order to view the 
calibration data, it is necessary to go to the Calibration Results screen on the main 
screen menu of ISOPLAN Results > Calibration Results. If a tag can not be found, use 
the option Tags General Search on the Results screen.  

 

The fields on this screen are as follows: 

Tag 
 
  Instrument tag identification.  
 
Registration Number 
 
  Instrument registration number.  
 
Calibration Date 
 
  Date when the calibration was completed. 
 
Calibration Values  
 
  On this table, the values concerning Corrected Calibration and Reading are 
entered, where: 
 

• Point: calibration point number. 
• Calibration: calibration point (instrument input). 
• Reference: reference point (instrument output). 
• Corrected Calibration: corrected calibration value; value applied to the 

instrument input. This value is normally the same as the calibration value, but in 
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some cases, such as pressure measurement, it is not possible to adjust the 
instrument input (calibration) to the desired value, so it is necessary to enter the 
calibration value effectively used in the instrument input, which is referred to as 
Corrected Calibration in ISOPLAN.  

• Reading: instrument output value; it can be an indication read by the operator or 
a signal measured by a standard, in the case of transmitters or sources.  

• Error: value calculated by ISOPLAN with the error in engineering unit.  
• Acceptance Criteria: acceptance criteria in engineering unit.  

 
6.4.2. Manual Upload External Laboratory  

  The tags that have been sent for calibration in an external laboratory and are 
waiting for the certificate input appear on this screen. Choose one of the tags and select 
the option Upload, so that the window Manual Upload External Lab. appears. 
External. 
 
6.4.3. Manual Upload Input External Calibration  

   The calibration data provided by the external laboratory certificate must be 
completed on this screen. Choose the option As Found to enter the initial calibration 
data and As Leftt to enter the final calibration. Then, fill in the table fields and click on 
Save to save the calibration data.  
 
  After saving, the tag is removed from the Pending Tags list. In order to view the 
calibration data, it is necessary to go to the Calibration Results screen on the main 
screen menu of ISOPLAN Results > Calibration Results. If a tag can not be found, use 
the option Tags General Search on the Results screen.  
 
  The fields on the screen are the following:  
Tag 
  Instrument tag identification.  
 
Registration Number 
   
  Instrument registration number.  
 
Calibration Date 
   
  Date when the calibration was completed. 
 
Calibration Values  
 
  On this table, the values concerning Calibration and Reading are entered, 
where: 
 

• Point: calibration point number.  
 

• Calibration: calibration point (instrument input). ISOPLAN brings the desired 
calibration points that have been defined in the tags registration in the strategy 
part. This value can be altered in case the laboratory has defined a different 
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calibration point. 
 

• Reference: reference point (instrument output). 
 

• Reading: instrument output value; it can be an indication read by the operator or 
a signal measured by a standard, in the case of transmitters or sources. This 
value is generally an average value provided on the calibration certificate. 
 

• Uncertainty: uncertainty value declared on the certificate. 
 

• K Factor: K factor associated with uncertainty. 
 

• Acceptance Criteria: acceptance criteria in engineering unit.  
 
 
 

 

Figure 88 - Manual Input External Laboratory dialog box 
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6.5. Isoplan Connector 

  Isoplan presents an application called Isoplan Connector that facilitates the 
communication of Isoplan with Presys calibrators through ethernet connection in 
corporate environments where Isoplan is virtualized, does not have access to USB port 
or direct access to the network where the calibrator is installed. In this mode both Isoplan 
and calibrators must have access to a common server defined by the company's IT 
department. 
 
 

 

Figure 89 –  Isoplan connector 

 
  The communication between the Isoplan and the calibrators is no longer direct 
and works as follows:  
 

1) During Download Isoplan sends all calibration information to the connector 
that stores this data as a Presys Calibrator task on the server where the 
connector is installed. The Calibrator does not need to be turned on at this 
time.  
 

2) Turn on the calibrator and follow the next steps inside the calibrator.  
 

3) + Choose the Tasks> Explore Tasks> Remote Server option 
 

4) Tap Search to list the tasks sent by Isoplan and stored in the connector. 
Note that Isoplan does not have to be open at this time.  

 
5) Tap Load to transfer the tasks to the Calibrator to run.  

 
6) Perform tasks normally on the calibrator 

 
7) After the task has been executed, go back to the Remote Server option.  

 
8) Tap the Performed tab and tap SEARCH.  

 
9) Tap Send to send the tasks that are performed to the connector. The task 

is not sent directly to the Isoplan database 
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10) Return to Isoplan and upload the pending calibrations in the same way as 

other calibrations sent to the calibrators are uploaded. Note that the 
calibrator does not need to be turned on at this time.  

 
6.5.1. Connector Installation 

  Installing the connector requires that the software be installed on a company 
server and adjust some settings on Isoplan and the calibrator.  
 
6.5.1.1. Server Installation 

 
The installation of the connector on the server should be done as follows:  
 
1) Install Isoplan on a company server. This server can be any machine that is 

connected continuously.  
 

2) Search in the Windows Start menu for the connector shortcut in Presys 
Instruments> Isoplan 5.0> Presys Calibrators Connector 
 

3) Run the connector by clicking on the shortcut.  
 

4) On the Windows Service tab click Install to install the connector as a Windows 
service.  

 
5) Adjust the connector network information:  
 

Address: machine name or connector ip address 
 
Port: TCP / IP port that will be used by the connector 
 
NOTE: The address and port cannot be used by another program and 
both the calibrator and Isoplan should not have restriction to connect to 
this address. The Isoplan and the calibrator may be in different locations 
and networks, but both need to have access to this server where the 
connector was installed. 
 
 

6) Click Save to save the settings.  
 

7) Click Start to start the connector service. The connector is a Windows service 
that works regardless of whether a user is logged on to the machine. You 
should normally set the service to start automatically. 
 

8) Click Test to verify that the service is working.  
 

6.5.1.2. Calibrator Configuration 
 

  The following settings must be performed on the Calibrator:  
 

1) + Choose the Tasks> Explore Tasks> Remote Server option 
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2) Touch the CONFIGURATION tab. 

 
3) Enter the following as the remote address:  

 
http://<address>/ITasksCalibrator 

 
  Where: <address> is the address where the connector is running.  
 

4) Tap the tab WAITING and press SEARCH to verify that the calibrator is 
able to access the connector.  
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7. Results   

 
7.1. Calibration Results  

  This screen is used to view the calibration data performed through upload and the 
issuing of calibration certificates. Before printing the certificate, it is necessary to enter 
some complementary information about calibration on the several tabs of this screen, as 
described in the topics below:  
 
7.2. Tags  

  The Tags tab shows a list of calibrated tags. Initially, the list shows the tags that 
have been calibrated over the last working week. The Tags list can be modified through 
the Filter available on the screen. To filter choose one of the options, then click the 
Update button, the options are: 
 
Calibrations with latest upload: lists all calibrations carried out in the last 15 days; 
 
Pending operator: list all calibrations that are awaiting signature of the operator; 
 
Pending reviser: list all calibrations that are awaiting signature of the reviser; 
 
Pending responsible: list all calibrations that are awaiting signature of the responsible; 
 
All: list all calibrations. 
 
Isoplan allows you to perform an instant search of tags that are on the list, simply enter 
the tag name or part, in the Filter text box. 
 
 For a more detailed search see the menu Main>General Tags Research. 
 
This list is also used to delete calibrations, see the Erasing Calibrations topic.  
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Figure 90 – Tags tab on the Calibrations Results dialog box 

 
7.3. Strategy 

 
  Isoplan allows a single certificate with more than one range or calibration strategy. 
If it have been configured more than one strategy in the tag register, it can select the 
desired strategy in the strategy list.  
 
7.3.1. Calibration Values  

This table shows the calibration values and it can display different columns. It depends if 
the calibration is carried out by ISOPLAN or if the instrument is sent to an external 
laboratory.  
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7.3.1.1. Table for calibrations carried out by ISOPLAN  
 

 

Figure 91 – Values tab on the  Calibrations Results dialog box 

 
• Point: calibration point number. 

 
• Calibration: calibration point (instrument input). 

 
• Reference: reference point (instrument output). 

 
• Corrected Calibration: corrected calibration value; value applied to the 

instrument input. This value is normally the same as the calibration value, but in 
some cases, such as pressure measurement, it is not possible to adjust the 
instrument input (calibration) to the desired value, so it is necessary to enter the 
calibration value effectively used in the instrument input, which is referred to as 
Corrected Calibration in ISOPLAN.  

 
• Ref. * Corr. : reference point (instrument output) when the corrected calibration 

value in the instrument input is applied. 
 

• Reading: instrument output value; it can be an indication read by the operator or 
a signal measured by a standard, in the case of transmitters or sources.  
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• Error: value calculated by ISOPLAN with the error in engineering unit. 
 

• Acceptance Criteria: acceptance criteria in engineering unit. 
 
 
7.3.1.2. Table for Calibrations carried out in External Laboratory  

 

 

Figure 92 – External lab. Values tab on the Calibrations Results dialog box  
Calibration Results 

 
• Point: calibration point number. 

 
• Calibration: calibration point (instrument input). ISOPLAN brings the desired 

calibration points that have been defined in the tags registration in the strategy 
part. This value can be altered in case the laboratory has defined a different 
calibration point. 

 
• Reference: reference point (instrument output). 

 
• Reading: instrument output value; it can be an indication read by the operator or 

a signal measured by a standard, in the case of transmitters or sources. This 
value is generally an average value provided on the calibration certificate. 

 
• Uncertainty: uncertainty value declared on the certificate. 
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• K Factor: K factor associated with uncertainty. 
 

• Acceptance Criteria: acceptance criteria in engineering unit. 
 
 
 
7.3.2. Error Chart  

  This tab shows an error chart in relation to the calibration point. The error of the 
measured values is expressed in engineering unit. The results achieved during readings 
with up, down or up/down sequences for as found and as left calibrations can be drawn 
on the same chart by the selection of the items of the "Sequence Type" field.  
 
Click on Chart to open a separate screen for the charts, allowing them to be printed. 
 

 

Figure 93 – Chart tab on the Calibrations Results dialog box Operation Conditions 
and Standards 

 
7.3.3. Standards  

  This tab presents data on calibration conditions, external laboratory data, sources 
of error, uncertainties due to the standards used and the instrument being calibrated. 
Below the description of the items on this screen.  

 
7.3.3.1. Error Sources 
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  Error Sources Uncertainties due to the used standards and to the instrument 
being calibrated. This option must not be used when the instrument is sent to an external 
laboratory.  
Used Standards 
 
  List with the standards used during calibration. Click on the button to edit the 
list of used standards. See section Used Standards to obtain more details about 
choosing standards. 
 
Instrument Uncertainty Sources 
 
  ISOPLAN allows uncertainties related to the instrument to be taken into account, 
such as uncertainty due to the instrument resolution, effect of the room temperature 
variations etc. Click on the button  to edit the list of used error sources. See section 
Instrument Uncertainty Sources. 
 
Number of Uncertainty Decimals 
 
  ISOPLAN usually brings the same number of decimals used in the reference 
(instrument output) to show uncertainty. There is an option to show the uncertainty with a 
larger or smaller number of decimal places by choosing one of the values from this list 
for the number of places the option "2 Significant" to show the uncertainty with two 
significant figures.  
 
7.3.3.2. Used Standards 

 
  This screen is used to register the standards applied during the calibration of an 
instrument according to the procedure stated below. It is only possible to use a standard 
that has a certificate registered in ISOPLAN, as explained in standards registration.  

1. First, click on the "Instrument Input Uncertainties" field if you would like to add 
standards that have been used to generate the instrument input signal, or click on 
"Instrument Output Uncertainties" if you would like to add standards that have 
been used to measure an instrument output signal (normally used with 
transmitters).  

2. Click on the Add button of the Uncertainty Standards tab to access the screen 
showing the available standards. Isoplan has the option of trying to automatically 
find the standard used, click the Yes button to accept this option or No to 
manually select the standard.  

3. Choose one of the available standards from the Error Source field, which must 
correspond to the standard used during calibration. 

4. In the Scale field, choose which standard scale has been used. 
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Figure 94 - Tab Uncertainty Standards of the   dialog box  
Uncertainty of Standards and Error Sources  

 

 

Figure 95 - Adding an Error Source dialog box 

5.  Optionally, choose an extra type of uncertainty, besides the standard, that is 
likely to be taken into account for the preparation of the calibration certificate. 
These extra uncertainties only appear if they are created in the Standard Scales 
Registration.  

6. Click on OK to confirm the standard addition.  
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7. The table on the Standard Uncertainties tab must show a new column with the 
uncertainties due to the standard. The column is called UpIn1, which means this 
is the first standard uncertainty associated with the instrument input. The Syst. 
Error tab represents the standard systematic error, as described in the manual 
appendix, and it is only used if the option Correct Standards on the Diagnosis 
tab is chosen.  

8. Repeat steps 2 to 7 for any other standard scale that has been used in the 
instrument input.  

9. If there is the need to add standards associated with the instrument output, it is 
necessary to start from step 1 again, choosing the corresponding option. 

 

Figure 96 - Tab System Error of dialog box  
Uncertainty of Standards and Error Sources  

 

  The tab Syst. Error displays the systematic error of the standard as supplied in 
the standard register for the measured point. A systematic error of the standard was 
considered to be the value indicated by the standard minus the reference value of the 
laboratory that provided the certificate of the standard.  

  

mk:@MSITStore:C:/isoplans/Isoplan50QuimicaAmparo/bin/pt-BR/isocs.chm::/calibrations_diagnosis.html
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Figure 97 - Tab Standards Extra Uncert  of the  dialog box  
Uncertainty of Standards and Error Sources  

 

 

  The tab standards Extra Uncert.  shows values for other uncertainties that were 
chosen in step 5 explained above.  

 

Comments: 

• The values shown on the screen correspond to the interpolated data concerning 
used errors and uncertainties, obtained from the standard calibration certificate.   

• ISOPLAN can display a warning saying it was not possible to calculate the 
uncertainty data. This usually occurs in cases where ISOPLAN is not capable of 
converting the unit from the standard certificate to the unit used in the instrument 
calibration. ISOPLAN only allows the conversion of pressure unit. It is 
recommended to register scales that do not have the same pressure as the unit 
that will be used by the instruments. 
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7.3.3.3. Instrument Uncertainty Sources 
 

  ISOPLAN allows extra uncertainties regarding the instrument to be taken into 
account, such as uncertainty due to the instrument resolution, effect of the environmental 
temperature variation etc. In order to add uncertainties related to the instrument, follow 
the procedure described below.  

 

 

Figure 98 - Tab Error Sources of the  dialog box  
Uncertainty of Standards and Error Sources  

 

Figure 99 - Error Source dialog box 
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1. Choose the Error Source (Input) tab if you want to register an error source 
associated with the instrument input, or choose the Error Source (Output) tab if 
you want to register an error source associated with the instrument output. 

2. Click on the Add button to access the screen with the registered instrument error 
sources.  

3. Choose one available Error Source. This list will only appear if an error source 
registration was made on the Instrument Scales screen, and if this scale was 
associated in a correct way on the Calibration tab of the Tags Registration.  

4. Click on OK to confirm the addition of the error source.  

5. The table on the Error Source (Input) tab must display a new column with the 
uncertainties due to the instrument. The column is called UxIn1, which means this 
is an extra uncertainty from the first error source associated with the calibration.  

6. Repeat steps 2 to 5 for any other instrument error source that you may want to 
add. 

7. If it is necessary to add error sources to the instrument output, one must start 
from step 1 again, choosing the corresponding option. 

Comments: 

• The values shown on the screen correspond to the interpolated data concerning 
uncertainties that have been registered on the Instrument Scales screen.  

• ISOPLAN can display a warning saying it was not possible to calculate the 
uncertainty data. This usually occurs in cases where Isoplan-5 is not capable of 
converting the unit from the instrument scale registration to the unit used in the 
instrument calibration.   
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7.3.4. Scale Diagnosis  

  This tab provides information about the calibration diagnosis, maximum error 
found and some calibration settings. This diagnosis is specific to a single calibration 
strategy or range. There is also a general diagnosis for cases where there is more than 
one strategy for the tag.  
 
Initial Diagnosis and Final Diagnosis 
 
  In ISOPLAN, the diagnosis is defined by the user, who can specify if the 
instrument was approved or reproved by clicking on one of the options on the screen. 
The equipment is usually reproved if the error, or the absolute value of the error plus the 
uncertainty, is smaller than the acceptance criteria. If desired, the user can approve an 
instrument that presents an error larger than the acceptance criteria. In this case, it is 
recommended to justify the approval in the comments part of the Failures tab. 
 

 

Figure 100 – Diagnosis tab on the Calibrations Results dialog box  
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Calibration Errors 
 
  This field brings information about the initial and final calibration, where: 
 
  Max (E): biggest error found during calibration. 
 
  Max (|E|+ U): biggest sum value of the error module and uncertainty. 
 
  Acceptance Criteria: acceptance criteria defined by the user. The acceptance 
criteria are shown for the biggest error found. 
 
 
Configurations 
 
  Defines some settings for calibration:  
 

• Reverse calibration: the calibration at ISOPLAN is usually performed by 
adjusting a desired value to the standard, which is applied to the instrument input, 
and by reading a value indicated on the instrument. In case of multiple readings, 
the standard value is fixed and the instrument value can vary. For the reverse 
calibration, which is used for the analogical manometers, for example, the value 
applied to the instrument input is adjusted until the instrument indication shows a 
desired value, and then the standard value is read. In case of multiple readings, 
the instrument value is fixed and the standard value can vary. When it comes to 
reverse calibration, the report transforms the field Reading into Reference, 
indicating that the standard reference value is what varies. 

 
• Group by the Calibration Values: Isoplan normally separates both ascending  

and descending reading points to check for some type of hysteresis, if you are not 
interested in this separation click on this option where Isoplan groups all points of 
the same calibration value, for example, if you have made a calibration ranging 
from 0 to 100 and  100 to  0 once, if you click this option, the certificate will 
consider that there were 2 readings for each calibration point. 

 
• Corrects Standards: option used to correct values indicated by the calibration 

standards by the certificate, for example, if a standard shows on the display 
10.00, but on the certificate indicates that for this value the laboratory reference is 
9.95 so if this option is enabled, the value of 9.95 will be displayed and not the 
value indicated in the standard display.  

 
• Acceptance Criteria Type: concerning the option Only Error, ISOPLAN 

suggests the approval of the certificate if |E| <= acceptance criteria, where |E| 
refers to the absolute value of the error. Choosing Error plus uncertainly ‒ 
ISOPLAN suggests the certificate should be approved if |E| +U <= acceptance 
criteria, where |E| is the error module and U is the uncertainty of the calibration 
point. 

 
• Display As Found: if disabled the as found calibration is no longer displayed 

even if it was done.  
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• Inserts page break before strategy: inserts a page break before the strategy to 
improve the formatting of the certificate.  
 

• Uses Error of Standard as Uncertainty Source: allows you to use the maximum 
error of the standard as a source of uncertainty. This feature can be used when 
the pattern correction option has not been chosen.  
 

 
7.3.5. Observations 

 

 

Figure 101 – Diagnosis tab on the Calibrations Results dialog box  

 
  The Notes tab allows the user to enter all the remarks pertaining to the certificate. 
This field is populated with a default text that can be set in the Configuration option of 
the menu Register of Isoplan. Only supervisor level user can change this text. 
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7.3.6.  Accreditation 22 

The fields in this tab may vary according to the service chosen.  
 
  Uncertainty due to zero point hysteresis: Check the option "Enable zero point 
hysteresis" to add an uncertainty component due to zero point hysteresis. You must 
enter the zero point read at the beginning and end of the calibration.  
 
  The temperature services have the following fields:  
 
  Shows Electrical Signal on the Certificate: this option, when marked, is used to 
show the corresponding value of the electrical signal (ohm or mV) generated by the 
sensor together with the temperature points. These values must be entered in the 
Values tab.  
 
  Electrical Signal Unit: sensor's electrical signal unit (mV for thermocouples and 
ohm for thermoresistors).  
 
  Number of Wires: number of thermoresistance wires. 
 
  Shaft Length: This option, when checked, is used to show the depth value at 
which the sensor was calibrated along with the temperature points. These data must be 
entered on the Values tab.  
 
  Immersion Unit: Immersion unit used as mm. 
 
 Shaft Length: Text with length of sensor shaft. 
 
 Shaft diameter: text with sensor rod diameter. 
 
 
 In the part of adding standards used there is a option called "Calibration Points 
Used" where you can specify in which calibration points the standard was used. 
Normally all points are marked, uncheck if the standard has not been used at all 
calibration points.  
  

                                              
22 Accredited Services Module 
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7.4. Environment/Settings  

 

 

Figure 102 - Tab Standards/Operation of the  dialog box Calibration Results 

Local 
 
  Text to define where the instrument was calibrated. Isoplan shows a list with the 
last registered locals. 
 
Humidity, Pressure and Temperature 
 
  Fields that define the conditions of the environment during calibration. 
 
time Cal. (h) 
 
  Calibration time in hours. This value is used to generate calibration time statistics, 
see topic Area Statistic. 
 
  The calibration conditions can be filled with a default value of temperature, 
pressure and humidity if it has been filled in the Configurations option of Isoplan. 

 

7.4.1. External Laboratory 



PRESYS  Instruments ISOPLAN -5 

Page 160 

  Data used for instruments calibrated in an external laboratory. 
 
Laboratory 
  Select one of the registered laboratories or use the button  to register a new 
laboratory. 
 
Certificate number 
 
Number of the certificate provided by the laboratory. 
 
Attached File 
 

In this group it can be added and viewed a file in PDF format, usually the standard 
calibration certificate, click the Add button to add a file, the Remove button is used to 
remove the file, and to view the file click the Visualize button. 

 

 

7.4.2.  Service Provider23 

  Client 
  In the case of the Isoplan service provider there is possibility to choose the client 
that appears in the certificate of the Instrument. 
 
  Show Accreditation Logo  

  Option to display a laboratory accreditation logo on the certificate.  

 

7.5. General Diagnosis  

 
Initial Diagnosis and Final Diagnosis 
 
  These configurations are similar to the strategy diagnosis shown previously, but 
would be for the certificate as a whole, the strategy diagnosis is individual by range, this 
would be a final diagnosis of the instrument, where the user, for example, could approve 
a presented instrument some scale that presents a nonconforming diagnosis.  
 
Maintenance 
 
  Indicates whether the maintenance type was preventative or corrective. 
 

                                              
23 Optional Module Service Provider 
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Defects and situations detected during calibration can be added through the tab Defects. 
The addition of a defect is done as follows: 

1. Click the button Add.  

2. Choose one of the defects from the list or click on the Edit button to create a new 
defect and click the Ok button to add the defect. The Cancel button is used to 
cancel the addition of the defect.  

3. If necessary remove a defect choose the defect to be removed and click on the 
Remove button.   

 

 

Figure 103 – Tab Diagnosis on the Calibrations Results dialog box  

 

  The list of defects can be changed through the  Registration>Defects menu of 
the Isoplan main screen.  
 
  This guide also allows you to add a short text with general comments on 
calibration through the Comments field. 
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7.6. Verifications 

  When the tag is selected for verification only, see Tag  register, is presented a 
table with verifications that were performed  
 
 
Verifications Executed  
 
  In this table it is defined whether the verifications  was Approved , Reproved or if 
the  verification does not apply  (N.A.) to this tag. The choice is made through a list in 
the Result column. 
 
 
 
 

 

Figure 104 - Tab Verifications  of the dialog box Calibration Results 

 
 
 
 
 
 
 
 
 
 
 
 

file:///C:/Users/admin/AppData/Roaming/Microsoft/isocsHtmlHelp/portbr/tags.htm
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7.7. Signature  

7.7.1. Manual Signature 

 
  In Isoplan without electronic signature, the user only chooses which user is the 
operator and the responsible, and it is necessary to manually sign the printed certificates.  
 
  To finalize  the calibration and issue the certificate it is necessary to terminate the 
calibration by clicking the button  "Ends Calibration". Isoplan now generates a unique 
number for the certificate. After terminating the calibration it is only for reading, if you 
want to change the certificate you need to click the "Corrects" button and justify the 
correction. 
 
 The certificate number can also be set manually by the user, to enable check 
Enable manual certificate number option in the tab General of the configuration 
register. 
 
7.7.2. Isoplan Manual Signature Service Provider24 

  The client field allows the name and address of the client to be defined in the 
report header. Click the button  to edit or add a new client.  
 
  Termination of the calibration on the Isoplan with the service provider module is 
performed by clicking on the "Ends Calibration" button where the user must confirm 
that he really wants to terminate the calibration data entry. Once the end of the 
calibration is confirmed, no further changes to the certificate will be allowed, it will be 
necessary to create a revision of the certificate if changes are necessary. The certificate 
number will be unique even if one or more companies have been registered in Isoplan.  
 
  In addition to asking the user if he or she wants to finish the calibration, there is an 
option called "Overlap a Certificate done" if you want the certificate to replace an 
existing certificate that is likely has an error.  

 
 
7.7.3. Correction of the Certificate in Isoplan with Service Provider 

module25 

   After the calibration is finished, the certificate can not be changed, if a correction 
is necessary, there are two options:  
 

1. You must create a new work  order, do the download and upload 
procedures and when you finish the certificate leave the option Overlap a 
Certificate done checked   selecting the certificate number of the 
calibration to be corrected. This mode should be used if there are major 

                                              
24 Service Provider Module 
25 Service Provider Module 
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changes to the certificate, eg adding new calibration points, changing the 
output type from mA  to ° C, etc.  

 
2. Click the button "Correct" of the Tab Signatures  in the Calibrations 

Results screen.  
 

 
  In the case of correction by the Results form a justification is requested and a 
copy of the certificate will be created where the number is changed, for example from 
2/2009, to 2/2009-01 indicating that it is the the first revision of the certificate. The tag 
name on the screen also changes where it is added (# 01) in the tag name, in the 
certificate this text does not appear. The revision tag must be located in the tab Tags of 
the Results.  
 
  The corrected certificate displays a text referring to the original certificate being 
corrected.  
 
 
7.7.4. Signature Electronic26  

The name of the operator, reviewer, and responsible user only appears on the certificate 
after the electronic signatures have been made, which in Isoplan consists in validating 
the user by his/her password.  

 

Figure 105 - Tab  Signatures of  dialog Calibration Results 

 

                                              
26 Available only on Isoplan with Electronic Signature module (ASE) 
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The certificate is signed as follows: 

1. Enter the Signatures tab and choose whether you want to sign the certificate as 
a operator, reviewer, or responsible.  

2. Click the button Sign  next to the Operator field, type the password and if it is 
correct the user login appears on the screen. After the signature, the user's full 
name appears on the certificate.  

3. Depending on the settings and the company's procedures, two different users 
must access ISOPLAN and repeat steps 1 and 2, one signing as Reviser and the 
other one as Responsible. After the Responsible signature, a certificate number 
is created automatically, and it is not allowed to change the certificate anymore. In 
case it is necessary to modify a previously signed certificate, see the instructions 
in the Correcting a Signed Certificate section. 

 

Note:  

• There are some options on the Registration > Settings menu that allow the 
adjustment of some signature settings, such as enabling the same user to enter 
more than one signature.  

• Isoplan allows the user to use a scanned signature that will appear in the 
certificate, so the Enabled Scanned signature option of the general 
configuration register tab must be enabled and the user must add a signature in 
the Users register. 

 
7.7.4.1. Correcting a Signed Certificate 
   
  After the Operator signature is entered, ISOPLAN prevents any change on the 
Calibration Results screen from being made. If the reviser or responsible has found any 
error, it is possible to start a certificate correction. The correction is made by clicking on 
the Correct button on the Diagnosis tab, where a reason for the correction must be 
stated. The justification appears on the Corrections field. 
 
7.8. Calibration Reports 

ISOPLAN brings the following types of reports:  

• Standard: report commonly used, which contains three calibration points, the 
uncertainty and the error.   

• General: report that shows the read values and It is recommended for equipment 
where a single repetition is performed.   

• Brief: reports that presents only a reading average, the error and the uncertainty.   
• Accreditation : specific reports for accredited services performed on Isoplan.  
• Uncertainty sheet : report showing in more detail the uncertainty components 

used in the Isoplan calculations.  
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After all the tabs on the Calibration Results screen are complete, you can generate the 
calibration certificate or directly export in PDF format. 

To generate certificate: 

1. Click on the Report menu on the Calibration Results screen and choose one of 
the certificate models.  

2. Click on the Show Error Chart option in case you want the error chart to appear 
on the certificate.  

3. Click on the Main > Print Preview menu on the Calibration Results screen to 
view how the printed certificate will look like.  

4. On the preview screen, click on the printer icon. It is possible to export the report 
into a PDF, Excel or Word file by using the icon .   
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Figure106 – Calibration Certificate sample 

To export directly to PDF click the menu Main>Export to PDF of the screen 
Calibration Results. 

Isoplan allows you to print several certificates directly at once, so select the 
calibrations you want to print in the calibration list and then click the menu  Main> Print 
Selected Calibrations. 
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7.9. Erasing Calibrations 

In order to erase calibrations performed through ISOPLAN, follow the steps below: 

1. Access the Calibration Results screen and click on the Tags tab.  

2. Check if the calibration you would like to erase is on the list. In case it is not, try a 
search, as described in the General Tags Search section.  
 

 

3. Select the desired tag by clicking on the square next to the tag column, as shown 
in the figure above. Multiple tags can be selected by pressing the Ctrl key while 
clicking on the tag.  

4. Click on the button Erase and confirm.   

 

 

7.10. Label Printing 
 
 
  Isoplan displays the label printing option through the menu Main>Print Label 
Preview.  Clicking on this option Isoplan shows a screen where the following fields are 
shown:  
 
  Label: fields specifying the characteristics of the label used by Isoplan. If 
necessary, contact Presys to use another label type. 
 
  Line and Column: A form of labels for inkjet or laser printers usually have several 
labels on one page. This field indicates in which position (row and column) that the label 
is on the page.  
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7.11. General Tags Search  

  Use the Main > General Tags Search menu to find the calibrations performed 
through ISOPLAN. The search procedure is as follows: 

1. Use the Form tab to fill in the data that is known about the tag. On the fields that 
allow typing, it is possible to use wildcards (%) in case you know the information 
to fill in only part of the fields. For example, when entering TT% into the tag field, 
all the calibration tags starting with "TT" will be shown. The fields that are 
irrelevant to the search can be left blank. See below further details about how to 
fill in the fields.  

2.  Select a sorting criterion in the Sort By field at the bottom of the screen. 

3. Click on the Search tab in the upper part of the screen. Then, click on the Start 
Search button to search through ISOPLAN, following the criterion set on the 
Form tab. The search result is shown in the table in the upper part of the screen. 
The search result can be printed by clicking on the Print Preview button, to check 
the result of the printing, and then on the printer icon, to send the report to the 
printer. 

4. To work only with calibrations found use the Use Search button to transfer the list 
of calibrations found to the list of tags in the Calibration Results screen. Use the 
Cancell button if the list of tags that were found will not be necessary for further 
procedures. 

 

Figure 107 - Tab   Form of  dialog Search Results 
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Figure 108 - Tab Search of dialog Search Results 

 
 
The following are comments on some form fields:  

• Area: field shows the Search all sub-areas option. When this option is selected, 
the search is made in the selected area and in all sub-areas of the initial area.   

• Diagnosis: returns calibrations where any of the marked options are true, for 
example, by checking the No Diagnosis option and Reproved,  returns all the 
calibrations that are without diagnosis or reproved.   

• Maintenance: it works the same way as the Diagnosis field, where calibrations 
are displayed when any of the options marked are true.   

• Interval: shows two dates that limit the search to the desired time interval. Both 
fields allow three options: a) fill in the date on the left only ‒ in this case, 
calibrations from the specified date on will be searched for b) fill in the date on 
the right only ‒ calibrations performed until that date will be searched for c) fill in 
both dates ‒ calibrations performed during the time interval between the specified 
dates will be searched for.   

• Signatures:  choose one of the users as a operator or responsible for filtering 
calibrations of a particular user. Choose the (pending) option if you want to 
choose the calibrations where the signature of a certain level of user is pending.  

• Certificate number: search for certificate number.  
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7.12. Instruments History  

  The information registered in the ISOPLAN database can be used to issue reports 
that indicate the situation verified during the several performed calibrations for each 
instrument registration number. 
 

 

Figure 109 –Instruments History dialog box 

 
 
  The organization of the Calibrations History ‒ Instrument report is selected on 
the Report menu, according to the "General" and "Brief" options. The general report 
displays technical information about the instrument and lists, in chronological order, the 
type of maintenance carried out (preventive, corrective or not authorized), the verified 
failures (through their codes and descriptions exactly as specified on the Failures dialog 
box) and the tag corresponding to the instrument in each of the calibrations. In the 
summarized report, the failure codes are presented (without descriptions) in the format of 
a table where only the verified errors are marked with an "x" for each calibration. 
 
  The instrument choice for the report depends on the registration number selected 
on the box of the Registration Number list. For the box to show only some of the 
registered instruments, open the Instrument General Search dialog box by clicking on 
the "..." button. After the search, the "Registration Number" box is filled in with the 
instruments registration numbers filtered during the search. Use the "Print Preview" and 
"Print" buttons to check the report and print it. 
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Figure 110 – Instrument History report 
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7.13. History Tag  

  The information registered on ISOPLAN database can be used to generate 
reports that indicate the situations verified during the several calibrations performed for 
each tag, besides charts that indicate the evolution of the errors found in the instrument 
calibrations that belonged to the same tag. 
 
  The organization of the Calibrations History ‒ Tag report is selected on the 
Report menu, according to the "General" and "Brief" options. The general report 
displays technical information about the last instrument associated with the tag and lists, 
in chronological order, the type of maintenance carried out (preventive, corrective or not 
authorized), the verified failures (through their codes and descriptions exactly as 
specified on the Failures dialog box) and the registration number corresponding to the 
instrument in each of the calibrations. In the summarized report, the failure codes are 
presented (without descriptions) in the format of a table where only the verified errors are 
marked with an "x" for each calibration. 
 

 

Figure 111 – History - Tag dialog box 

 
  The tag choice for the report depends on the name selected of the "Tag" list. 
Open the Tags General Search dialog box by clicking on the "Search ..." button to show 
only some of the registered tags. After the search, the "Tag" list box is filled in with the 
chosen tags, according to the possible tag names, areas, calibration dates, serial 
number, kind and model of instrument. Use the "Print Preview" and "Print" buttons to 
check the report and print it. 
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Figure 112 – Tags History report 

 

Figure 113 - Max error history graph 
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  The error chart has its specifications provided on the "Maximum Error History" 
field. Select the type of error to be examined on the box of the "Acceptance Criteria 
Type" list (Error or Error plus Uncertainty) and indicate the period in which the 
calibrations must be included. To specify an unlimited period, leave the initial or final date 
fields unfilled, or both fields. Press the "Show Chart" button to open the chart screen. In 
order to print, use the Print command on the File menu. 
 
7.14. Area Statistics  

  This dialog box allows the creation of a report displaying calibration statistics and 
a chart with the calibration distribution along the year, as described in the following 
section.  

7.14.1. Creating an Area Statistics Report  

 

 

Figure 114 - Tab Report of dialog Statistics by Area 
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Figure 115 -Report of the calibration statistics 

 

1. Choose one of the areas or leave the Area field unfilled to obtain a report about 
all the areas.  

2. Define an interval between the dates on the Interval field.  

3. Click on the Print Preview button to see the report on the screen or use the Print 
button to send the report directly to the printer.  
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7.14.2. Creating a Calibration Distribution Chart 

 

 

Figure 116  - Chart tab on the Area Statistics dialog box 

 
 

1. Click on the Chart tab on the screen.  

2. Choose one of the areas or leave the Area field unfilled to obtain a report about 
all the areas.  

3. Enter the year corresponding to the chart on the Year field.  

4. Choose the type of chart: N. Cal. to show the number of calibrations per month; or 
N. Hours to show the number of hours spent with the calibration service per 
month.  

5. Click on the Refresh button to view the chart and use the Chart button to highlight 
a chart. If necessary, the chart can be printed by clicking on the File > Print menu 
of the open window.  
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7.15. Calibration Plan  

 
 

Figure 117 - Dialog Box Calibration Plan 

7.15.1. Standard Pan 

 
  The Calibration Plan dialog box allows the issuing of a report informing all the tags 
(grouped by month) of a certain area, whose next calibrations will be carried out in a 
certain period. In order to view the calibrations of all the company areas, leave the 
"Area" list box unfilled. Select the Standard Plan option. The report can be viewed and 
printed by pressing the "Print Preview" and "Print" buttons. 
 

 

Figure 118 –Calibration Plan Report 

7.15.2. Realized and not Realized Calibration Plan 
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  This report is used when selected the "Realized and not Realized Calibration 
Plan". In this mode Isoplan submit a report with the following information relating to a 
certain specified period:  
 
 Performed: list of calibrations performed in the period and planned to be 
executed in the chosen period.  
 
  PAD - Performed after the deadline: list of calibrations planned to be made in 
the period, but were executed late. 
 
 UDE- Unrealized(deadline expired): calibrations planned for the period but until 
the report print time were not made.  
 
  UTE: Unrealized (to expire): calibrations to be performed in the future, appears 
only if period covers future dates.  
 
 
  In the final report is presented a bar graph with the number of calibrations for each 
list and sum of all calibrations scheduled for the interval.  

 

Figure 119 –Calibration Plan Report - Realized and not Realized 

 
 
7.15.3. Generate calibration plan for all areas in separate file 

Isoplan allows users you to print or to print preview calibrations plan from all areas 
at once. You can also select the areas that will be printed following the steps below: 
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• Check the Generate calibrations plan for all areas in separate files option; 
 

• In the Report menu select the Select Areas option; 
 

• In the list of Areas choose the area you want to print or print preview, then click 
the button and add the area to the list of Selected Areas; 

 
• Repeat the above step for the number of sectors that you want; 

 
• Click the Print or Print Preview button. 

  
 
7.15.4. Show calibrations planned in standard plan 

This option must be checked to generate a calibration plan with all calibrations 
planned in the selected interval. 
 

Example: If an instrument is calibrated annually and the selected interval is five 
years, the report showed all calibrations to be made during these five years.  
 

If Show calibrations planned in the standard plan is not checked the calibration 
plan report only shows the next calibration. 
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7.16. Critical Analysis List 27 

  Isoplan allows you to generate a list of tags to get an overview of the tags critical 
levels of the entire factory or any specific area.  
 
  The list can be generated through the menu Results> Critical Analysis List. 
 
  Click the Generate List button to generate an Excel spreadsheet with the critical 
level of the tags and some additional information of the register.  
 
  The list can be filtered by part of the tag name, area and instrument type.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

                                              
27 Critical Analysis Module 
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8. Isoplan Explorer 

 

 
 

Figure 120 - Dialog Box Isoplan Explorer 

 
The Isoplan Explorer dialog box allows user to consult, quickly, all the company 

information, for example: areas, tags, loops, calibration, certificate, etc. 
 
8.1. Menus and Status Bar 

With the click of the right mouse button you can access the menu, each item has its 
own menu, status bar and in some cases their own nomenclature, as follows: 

 
 
 
 
 
 
 
 
 
 
 
 

8.1.1.   Company 
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Figure 121 Companies Menu 

Menu 
 
View Model: opens the Register of Companies dialog box, in the example, the 
company name is Model; 
Exit: Close Isoplan Explorer dialog box 
 
Status Bar 
 

 
 

Figure 122 –Company status bar 
    
Displays the Company name, in the example, the company name is Model 

 
 
8.1.2.  Areas 

 
Menu 
 

 
Areas: opens the Register of areas dialog box. 

  
 
8.1.3.  Tags 

 
Nomenclature 
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1. Name Tag register; 
2. Inactive: Tag is inactive 
3. Due: Tag is due 

 
Menu 
 

 
View Tags: Loads the tag registration dialog box; 
Technical Specification: Loads a report with the technical specifications of the Tag; 
 
Status Bar 

 

 
 

Figure 123 –Tags status bar 
 

1. Name of Tag Register 
2. Tag active; 
3. Tag inactive; 
4. Tag not due with the next calibration date; 
5. Tag Overdue, with the date it would be the next calibration. 

 

8.1.4.  Loops 

Menu 
 

 
View Loop: Loads the loop register dialog box; 
View Loop Register: Loads a report with the report of the selected loop; 
View Accuracy Loop: Loads a report with the accuracy of the selected loop. 
 

8.1.5.  Calibrations 

 
Nomenclature 

 
1. Calibration date; 
2. Number of calibration certificate; 
3. Due: Tag is due 
4. No calibration date: No calibration date 
5. No Certificate number: There is no calibration code; 
6. Miss upload: Calibration with pending upload. 

Menu 
 

View Calibration: Loads calibrations results dialog box; 
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View Certificate: Loads calibration certificate report 
Export to PDF: Export Report to PDF 
Upload: Loads upload dialog box 
 
Status Bar 

 

 
 

Figure 124 –Calibrations status bar 
 

1. Date  and Certificate number of the calibration (Nomenclature 
received only in the window); 

2. Certificate with signature pending; 
3. Tag waiting for upload. 
 
 

 
Report Menu 
  

As the Calibration Result, you can determine the type of report 
This menu is only available when selecting a calibration 

 

 
 

Figure 125 - Reports Menu 
 
 

Standard: Loads a report of the standard type; 
General:  Loads a report of the general type; 
Brief:  Loads a  report of the brief type. 

 
NOTE: When no option is selected the report is created according to the standard 
options of the calibration results screen. 
 

 
8.1.6.  Instruments 

Nomenclature format separated by "-" (dash) 
 
Register Number; 
Model; 
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Manufacturer; 

 
Menu 

 
View Instrument: Loads Register o Instruments dialog box 
Print Preview: View Instruments data 

 
Status Bar 

 

 
 

Figure 126 – Instruments status bar 
 

1. Instrument active; 
2. Instrument inactive; 
3. Instrument in maintenance; 
4. Instrument is spare 

 
8.1.7.  Standards 

Nomenclature format separated by "-" (dash) 
 

Register Number; 
Model; 
Manufacturer; 

 
Menu 

 
View Standards: Loads standards dialog box 
View List of Standards: View report with standards data 
View Standards: Loads standards dialog box 
View Standard History:  Displays the calibration history of the selected standard; 

 
 
Status Bar 

 

 
 

Figure 127 – Instruments status bar 
 

1. Standard Active; 
2. Standard not due with the next calibration date; 
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3. Standard Inactive; 
4. Standard due  with due date 

 
8.1.8.  Manufacturers 

Menu 
 

View Manufacturers: Loads the dialog box Manufacturers; 
View Manufacturer:  Loads the dialog box of manufacturer register ; 
Exit: Close Isoplan Explorer dialog box 

 

8.1.9.  Models 

Menu 
 

View Models: Loads Models dialog box 
View Model:  Loads the dialog box of  models register , already with the selected 
model; 

 

8.1.10. Clients 

Menu 
 

View Clients: Loads clients dialog box; 
View Clients: Loads clients dialog box; 
 
 

8.1.11. Criticality Levels 

 
Menu 

 
 

View Criticality Levels: Loads criticality levels dialog box 

 
8.2. Controls 

The Isoplan Explorer dialog box has several controls for easy handling.  
 
8.2.1. Main Menu bar 

Menu bar with buttons for back, forward, up, down, block tree view, update, list, 
search field, the search button, search settings, views settings and help screen 
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Figure 128 – Standard status bar 

 
1. Return: Back to the last selected item; 
2. Advance: Advances an item 
3. Up: Go up an item 
4. Down: Go down an item. 
5. Block View Tree: Blocks the exchange of the tree view item 

(only available in the tree view + list); 
6. Update List: Updates all items; 
7. Search Field: Search items text (Only available in the Preview 

List and tree view + list); 
8. Search Button: Execute a search 
9. Search Settings: Sets the search options (Only available in 

the Preview List and tree + list view); 
 

 
 

Figure 129 - Setting Search menu 
 

Search criteria: Search only the specific type of item; 

                                                                                
  

Figure 130 – Search Types 
 

Advanced Search: Enabled only when the type of search is (Tags, Loops, 
calibrations Tags, calibrations loops and instruments). 

 
Note. When the Advanced Search is used, the tree view is automatically locked and can 
only be used again when clicked the lock icon (icon 5 from the main menu bar) 

 
10. Display Mode: Sets the display of items; 
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Figure 131 - Display Types 
 
 
 
 
 
 
 
 
 

 
Tree View:  View in root; 

 

 
 

Figure 132 –Tree View 
 

List View: View Icons; 
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Figure 133 - List View 
 

View Tree and  List: View in Tree along with the view in list. 
 

 
 

Figure 134 - Tree + List View 
 

11. Help button: Loads the dialog help. 
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8.2.2.  Report Menu 

Sets which items are displayed. 
 

 

 
 

Figure 135 - View Menu 
 

8.2.3.  Toolbar 

Item Local 

 
 

Figure 136 –Toolbar 
 

By double-clicking on the item name, it is selected and displayed.  
This bar only appears in List view and Tree view plus List 

 
 

8.2.4.  Main Menu bar 

Bar with list count and progress bar. 
 

 
Figure 137 - Main Status Bar 

 
Progress bar; 
Internal Items count or items selected. 
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8.3. Move Tags/Loops 

To change the area of tag / loop, just select the tag / loop and move to a new area 
(If the area is the same, the tag / loop will not be modified). 
 

Select the Tag (s) / loop (s) you want to change the area.  

 

 
 

Figure 138 – Tags Selected for moving 
 

Click and hold with the left mouse button, and then move to a new area and 
release the left mouse button. 

 
Click Yes in the change confirmation message. 

 
Wait for the screen load, the screen will be reloaded and will open the area to the 

moved tags. 
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Figure 139 - Tags in the New Area 
 

The move action can also be performed with loops and tags simultaneously, and 
can be used to tag folder and loop to move all the tags / loop of theirs areas. 

 
Another option is to click the "Edit" menu and then the menu "Batch 

Processes". 
 

 
 

Figure 140 - Move of Tags/Loops 
 
 

Hold and move the area you want to move the tags / loops to the field of "New 
Location" or select the area and click the button next to the field of "New Location" 
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Figure 141 - Area that received the Tags/Loop 
 

Hold and drag the Tags that will be moved to the new area in the field "Items that 
will be modified" or select the Tags/Loops and click the button next to the field "Items that 
will be modified". 
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Figure 142 - Tags that will be moved from the area 
 

Click on Run Process. 
 

Click Yes and wait for the tags/loops to be moved. 
 

 At the end of the process a message will be displayed, questioning the display of 
the changes. 
  

 

 
 

Figure 143 - Move Confirmation View 
 

Click Yes to view the changes 
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Figure 144 - Moving Report 
 

 
Note: The tags / loops that have not been modified for any problems will be shown 

in "Red." 
 
Buttons: 
 

 
 

Figure 145 -Move Buttons Tags/Loops 
 

1. Remove the selected item; 
2. Add the selected item; 
3. Clean all items from the Items list that will be modified; 
4. Execute the moving process of Tags / selected loops; 
5. Previews the list of "Items that will be modified." 

8.4. Hot Keys 

 
The Isoplan Explorer dialog box also features a set of hot keys that facilitate its 

use, below there is a complete list of valid shortcuts. 
 

Ctrl + e Use the search tool 
Ctrl + f Use advanced search tool 
Ctrl + w Close the Isoplan Explorer dialog box 
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Ctrl + p Load Batch processes menu 
Ctrl + z Back to last selected item 
Ctrl + y Next to last selected item 

Ctrl + Page Up View an item above 
Ctrl + Page 

Down View an item below 

Ctrl + Home Select company 
Ctrl + t Tree View 
Ctrl + l List View 
Ctrl + v Tree View and List View 
Ctrl + a Help 

F5 Updates all items 
Alt + l Disables the Moving in the tree 

 
 
 
9. Unit Conversion  

 

Figure 146 – Unit Conversion dialog box 

  The Unit Conversion dialog box allows the user to convert temperature or 
pressure value given in a certain unit to values in many other units (psi, atm, kgf/cm2, in 
H20, m H2O, cm H2O, mm H2O, in Hg, cm Hg, mm Hg, bar, mbar, kPa and torr for 
pressure; degrees Celsius and Fahrenheit for temperature) 
 
Choose one of the available units from the "Unit" list box and enter a value into the 
"Value" box. Then press the "Convert" button in order to see the corresponding values 
in other units. 
 
 



PRESYS  Instruments ISOPLAN -5 

Page 198 

10. Using Presys Calibrators 
 
 This section provides an overview of the use of Presys calibrators. However, 
calibrations of the instrument types described in this text must be performed with the 
appropriate calibrators. 
 Communication between a Presys calibrator and the computer is accomplished by 
means of the RS-232 Interface of the Presys calibrators or RS-485 Interface (except for 
ISOCAL MCS-10) connected to the computer COM 1, 2, 3 or 4 serial port and to the 
corresponding input on the side panel of the calibrator. Connect the communication 
cable to the Presys calibrator so that polarity identification of the cable (white mark) 
coincides with that on the calibrator. The message exchange is enabled only by selecting 
the COM function on the main menu of the calibrator. In this situation, the Presys 
calibrator is able to receive a work order. This initial procedure corresponds to the next 
two figures: 
 
 1. Choose the COM option on the main menu and press ENTER: 
 

IN OUT  EXEC 
CONF CAL > COM 

 
 Note: For calibrations using pressure input in ISOCAL with PMY Pressure Module 
or in PC-507, make sure to set the pressure indication (manometric or vacuum) to zero 
before entering COM function, according to the procedure described in the technical 
manuals of the calibrators. 
 
 2. 2. Then, the functions on the COM menu are shown: 
 

> TAG EXEC VERIF 
 
 Choose one of the work orders from the "W.O." list of ISOPLAN (make sure the 
calibrator model associated to the W.O. is the one connected to the computer) and start 
its transfer with the Download command. Remember that the False Download 
command on the Download menu does not transfer any calibration instructions to the 
calibrator. See section6.2.1on W.O. Registration/Download. 
 The TAG option displays the work order tags in the calibrator. Select the tag 
related to the calibration to be performed and press ENTER. In order to enter in EXEC or 
VERIF options, the "None" tag must not be selected. Otherwise, the message "Choose 
a tag first" will be shown. 
 Connect the calibrator input and/or output terminals to the instrument 
corresponding to the tag above and choose the EXEC option to calibrate it. Inform the 
calibration type ("as found" or "as left"), the operator's name and the device serial 
number, as shown below: 
 

> AS_FOUND 
 AS_LEFT 

 
Operator's Name 
--------------- 
Serial Number 
------------- 
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 Choose each character (number or letter) as the operator's name and serial 
number with the and arrow keys, and move to the adjacent places with the ➔and 
arrow keys. Numbers can be entered directly by pressing the keys corresponding to the 
numbers you want. Confirm each written word by pressing ENTER. Be sure to inform the 
correct instrument serial number ‒ ISOPLAN checks the serial number associated with 
the tag during the upload operation. 
 Wait a few seconds while the calibrator configures its input and output 
automatically. Before starting the calibration, the display shows, if it exists, the message 
written on the Strategy tab on the Tags dialog box in ISOPLAN (section5.14). 
 
 In general, instruments can be grouped in 3 basic types, namely: 
 
 1. Indicator Type 
 2. Source Type 
 3. Converter Type 
 
 Each one of these types defines a distinct way of calibration, which can be 
implemented by the ISOPLAN/Presys calibrator. See their descriptions below: 
 
 
Indicator Type 
 
 For this instrument type, the calibrator only generates the signal and reading is 
carried out externally ("Presys Calib." for "Output" and external "Reading" in 
Calibration (1) or (2) on Tags). That is, the calibrator generates signals automatically in 
the sequence determined by the calibration strategy and the reading is accomplished by 
the operator, and its value is entered into the calibrator when it is asked. 
 
 

 
 

Figure 147 - Calibration of an indicator type instrument  

 See the example below: 
 
 1. One of the calibration points is displayed: 
 

Set = 50.000mV 
 2. And its output is automatically generated: 
 

OUT = 50.000mV 
 
 3. After a certain time (specified as Settle Time in Strategy (1) or (2) on Tags), 
the value read in the display of the instrument being calibrated is asked: 
 

Input Value: 
+00.000# 
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 Note: If is a zero value is attributed to Settle Time, you must press ENTER after 
the signal is stable so that the calibrator asks for the reading value. 
 
 4. The reading value carried out externally must be entered by the operator: 
 

Input Value: 
+50.008# 

 
 5. When pressing ENTER, the value is stored in the calibrator memory and its 
error is calculated: 

Writing to RAM 
Error: 0.02% 

 
 6. The calibrator goes, after that, to the next calibration point: 
 

Set = 37.500 mV 
 
 At the end of the calibration, the "Calibration End" message appears. 
 
 
Source Type 
 
 For calibrations of source type instruments, the Presys calibrator only performs 
the reading, i.e., the instrument to be calibrated generates the signals (external "Output" 
and "Presys Calib." for "Reading" in Calibration (1) or (2) on Tags). The calibrator 
previously informs the signal to be generated by the instrument according to the 
sequence determined by the calibration strategy (Strategy (1) or (2) on Tags) and, for 
each calibration point, the reading is accomplished automatically by the Presys 
calibrator. 
 

 
 

Figure 148 - Calibration of a source type instrument 

 See the example below: 
 
 1. The calibrator asks for the first output signal to be generated: 
 

Next setpoint: 
Out = 0.0000# 

 
 2. Make the external source (instrument) to generate the set-point you want and, 
by pressing ENTER, the signal is automatically read: 
 

IN = 0.0060mA 
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 3. After a certain time (specified as Settle Time in Strategy (1) or (2)) the value of 
the reading is stored in the calibrator memory and its error is calculated: 
 

Writing to RAM 
Error: 0.03% 

 
 Note: If a zero value is attributed to Settle Time, you must press ENTER after the 
signal is stable so that the calibrator stores the reading. 
 
 4. The message above is shown during a short period of time and the calibrator 
asks again for the next output signal to be generated corresponding to the next 
calibration point: 
 

Next setpoint: 
Out = 4.0000# 

 
 At the end of the calibration process, the "Calibration End" message appears. 
 
Converter Type 
 
 In the case of a converter type instrument, the Presys calibrator can carry out a 
completely automatic calibration since the work order configures the calibrator to 
generate the output signal corresponding to the calibration point and to read its input 
simultaneously ("Presys Calib." for "Output" and "Reading" in Calibration (1) or (2)). 
 

 
 

Figure 149 - Calibration of a converter type instrument 

 
 
 After informing the calibration type ("as found" or "as left"), the operator's name 
and the device serial number, the calibrator configures its input and output automatically 
and displays the message written on the Strategy tab on the Tags dialog box of 
ISOPLAN. You must then press ENTER to start calibration. 
 Below, an example of calibration sequence: 
 
 1. The output for one of its calibration points is displayed and it is followed by its 
reading: 

IN = 50.010mV 
OUT = 50.000mV 
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 2. After a certain time (specified as Settle Time in Strategy (1) or (2)) the value of 
the last reading is stored in the calibrator memory and its error is calculated: 
 

Writing to RAM 
Error: 0.02% 

 
 Note: If a zero value is attributed to Settle Time, you must press ENTER after the 
signal is stable so that the calibrator stores the reading. 
 
 3. The message above is displayed for a short period of time and the next 
calibration point is shown. 
 
 The "Calibration End" message indicates the end of the calibration process. 
 
 Besides the three types of calibration described above, there is also the possibility 
of using the Presys calibrator only for storing data of calibrations in which signals are 
generated externally and the reading is carried out by the operator; or of performing 
calibrations of temperature sensors or instruments with pressure input, in which 
temperature or pressure, although being generated by means of an external source, can 
be directly read by the Presys calibrator. These calibrations are classified as: 
 
 1. Calibration with External Signal Generation and External Reading 
 2. Calibration of Temperature Sensors 
 3. Calibration of Instruments with Pressure Input 
 
 See their descriptions below: 
 
Calibration with External Signal Generation and External Reading 
 
 In this case, the Presys calibrator is not used directly in the calibration. The 
calibrator indicates the signal to be generated according to the sequence determined in 
Strategy (1) or (2) on Tags, and the operator must select this signal on the external 
source and then read the value indicated on the instrument being calibrated, which must 
be entered into the calibrator when asked. Specify, on the Tag dialog box of ISOPLAN, 
External for "Output" ("Calibration" field) and "Reading" ("Reference" field). 
 

 
 

Figure 150 - Calibration of Instrument with External Signal Generation and External 
Reading 

 
 See the example below: 
 
 1. The calibrator asks for the first signal to be generated: 
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Next setpoint: 
Out = 10.0000# 

 
 2. Make the external source generate the set-point and press ENTER. 
 
 3. After a certain time (specified as Settle Time in Strategy (1) or (2) on Tags), 
the value read on the display of the instrument being calibrated is asked: 
 

Input Value: 
+00.0000# 

 
 Note: If a zero value is attributed to Settle Time, you must press ENTER after the 
signal is stable so that the calibrator asks for the reading value. 
 
 4. The reading value carried out externally must be entered by the operator: 
 

Input Value: 
+10.0020# 

 
 5. When ENTER is pressed, the value is stored in the calibrator memory and its 
error is calculated: 

Writing to RAM 
Error: 0.02% 

 
 6. The message above is shown during a short period of time and the calibrator 
asks again for the next output signal to be generated corresponding to the next 
calibration point: 
 

Next setpoint: 
Out = 20.0000# 

 
 At the end of the calibration, the "Calibration End" message appears. 
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Calibration of a Temperature Sensor with ISOCAL 
 
 In this calibration type, it is necessary to use a calibration bath which generates 
temperature to the sensor. The operator must set the temperature asked by the 
calibrator (according to the sequence determined by the calibration strategy), and its 
value is read by ISOCAL with the temperature probe. On the Calibration tab on the Tag 
dialog box, specify "Presys Calib." for "Output" and "Temp. Probe" for "Signal" 
("Calibration" field), and External or "Presys Calib." for "Reading" ("Reference" field), if 
the verification of the sensor is carried out externally or by ISOCAL, respectively. 
 
 

 
 

Figure 151 – Temperature sensor calibration 

 
 See the example below: 
 
 1. The calibrator asks for the first signal to be generated: 
 

Next setpoint: 
Out = 100.00# 

 
 2. Set the external source to generate the set-point asked. By pressing ENTER, 
the signal is automatically read: 

IN = 100.20°C 
PROB = 100.01°C 

 
 3. After a certain time (specified as Settle Time in Strategy (1) or (2) on Tags) 
the value of reading is stored in the calibrator memory and its error is calculated: 
 

Writing to RAM 
Error: 0.19% 

 
 Note: If a zero value is attributed to Settle Time, you must press ENTER after the 
signal is stable so that the calibrator stores the value. 
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 4. The message above is shown during a short period of time and the calibrator 
asks again for the next output signal to be generated corresponding to the next 
calibration point: 
 

Next setpoint: 
Out = 200.00# 

 
 At the end of the calibration process, the "Calibration End" message appears. 
 
 
Temperature Sensor Calibration with Presys Dry Block Calibrator 
 
 A calibration with Presys dry block calibrator is simpler to carry out than the one in 
the previous case, and it may also be performed automatically, without any intervention 
from the operator during the calibration, except when using temperature indicators, such 
as glass thermometers. In this case, the operator must enter the reading values. This is 
possible because the dry block temperature control, the probe for block temperature 
measurement and the Presys calibrator are all integrated in a single instrument. 
 
 

 
 

Figure 152 - Temperature sensor calibration with Presys dry block calibrator 

 
 The configuration of the Calibration tab on the Tag dialog box is made the same 
way as explained for the previous case, that is, "Presys Calib." for "Output" and "Temp. 
Probe" for "Signal" ("Calibration" field), and External or "Presys Calib." for "Reading" 
("Reference" field), in case the verification of the sensor is carried out externally or by 
the Presys dry block calibrator, respectively. 
 
 The example below presents a RTD calibration performed automatically: 
 
 1. The display shows the first calibration point used as the set-point of the dry 
block temperature control. Then, it shows the temperature values of the sensor being 
calibrated and of the dry block probe: 
 

IN = 50.01 °C 
PROB = 50.00 °C 

 
 2. After the dry block temperature stabilizes, the calibrator waits a certain time 
(specified as Settle Time in Strategy (1) or (2)) before the value of reading is stored in 
the calibrator memory and its error is calculated: 
 

Writing to RAM 
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Error: 0.02% 
 
 Note: If a zero value is attributed to Settle Time, you must press ENTER after the 
signal is stable so that the calibrator stores the reading. 
 
 3. The message above is displayed for a short period of time and the next 
calibration point is shown. 
 
 The "Calibration End" message indicates the end of the calibration process. 
 
Calibration of Instruments with Pressure Input 
 
 For this calibration, an external pressure source is necessary. The operator must 
apply the pressure indicated by the calibrator (according to the sequence determined by 
the calibration strategy), and its value is read by ISOCAL with UC504 PMY pressure 
module or by a PC-507. On the Calibration tab of the Tag dialog box, specify "Presys 
Calib." for "Output" and Pressure P1, Pressure P2 or Pressure P1-P2 for "Signal" 
("Calibration" field), and External or "Presys Calib." for "Reading" ("Reference" field), in 
case the verification of the instrument output signal is carried out externally or by the 
Presys calibrator, respectively. For connections among pressure source, calibrated 
instrument and ISOCAL, see sections 3.2 to 3.5 from UC504 PMY Pressure Module 
technical manual. A PC-507 does not require a pressure module, so it is only necessary 
to make the connections with the pressure source and the instrument to be calibrated. 
 

 
 

Figure 153 - -Calibration of Instrument with Pressure Input 

 
 See the example below: 
 
 1. The Presys calibrator asks for the first signal to be generated: 
 

Next setpoint: 
Out = 0.0000# 
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 2. Make the pressure source generate the set-point you want and, by pressing 
ENTER, the signal is automatically read: 
 

IN = 0.0100mA 
Out = -0.0001atm 

 
 3. After a certain time (specified as Settle Time in Strategy (1) or (2) on Tags) 
the value of reading is stored in the calibrator memory and its error is calculated: 
 

Writing to RAM 
Error: 0.05% 

 
 Note: If a zero value is attributed to Settle Time, you must press ENTER after the 
signal is stable so that the calibrator stores the value. 
 
 4. The message above is shown during a short period of time and the calibrator 
asks again for the next output signal to be generated corresponding to the next 
calibration point: 
 

Next setpoint: 
Out = 0.3000# 

 
 At the end of the calibration process, the "Calibration End" message appears. 
 
 If there are points with errors higher than the error tolerance in any one of the 
calibration types above, the number of failures is displayed along with the "Calibration 
End" message and, when ENTER is pressed, the "Failure Code" (only for as found 
calibration) is asked. Then, the Presys calibrator indicates the input and/or output 
normally. The C/CE key brings the display back to the main menu. 
 
 The calibration points and their readings, the errors and number of failures can be 
verified in the VERIF option for each calibration type ("as found" or "as left"). If a not 
calibrated tag is chosen, the "No calibration performed" message will be shown. See 
what to do in this case: 
 
 1. Choose the VERIF option and press ENTER: 
 

TAG EXEC > VERIF 
 
 2. Choose the calibration type and press ENTER: 
 

> AS_FOUND 
 AS_LEFT 
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 3. The number of failures in the calibration is informed: 
 

Calib. perform. 
0 points fail 

 
 4. Pressing ENTER causes the error of the first point and the OK or FAIL remark 
to be displayed: 
 

Point 001 (OK) 
Error: 0.00% 

 
 5. Pressing the ➔or arrow keys causes the read and generated signals for the 
calibration of the first point to be displayed (in this example the number of decimals of the 
output signal is that used by the Presys calibrator, and that of the input is the one 
specified for the mV scale on Scales): 
 

IN = 50.004 
Out = 50.000 

 
 It is necessary to press the or ➔arrow keys in order to see the calibration point 
again, as well as its error. The and arrow keys display information about the other 
calibration points. To quit the VERIF option, use the C/CE key. 
 In order to accomplish the transfer of calibration data to the computer, make sure 
the COM function is selected on the main menu of the calibrator, and activate upload in 
ISOPLAN according to the description in section 6.3 for Upload from Field Calibrator. 
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11. ISOPLAN Maintenance  

  This program was created to perform some access configurations, back up of the 
database used by ISOPLAN, as well as carry out some tests to check how ISOPLAN 
was installed. 
 
  The program starts when you click on the ISOPLAN Maintenance icon, which is 
located in the ISOPLAN group of programs. 
 
 
11.1. Using Access Database  

  Access is a very simple database, which does not require much knowledge for 
maintenance, and it is generally adequate to be used along with ISOPLAN in places 
where there are few users working with the instruments maintenance. Initially, ISOPLAN 
is installed to work with an Access database, located in the set up directory of the 
program. 
 
11.1.1. Access Database Network Installation   

  A copy of Access database is included in ISOPLAN, but it will only work on the 
computer where the program was installed. In order to set up Access database in a 
network server, do the following:  

1. Open the ISOPLAN Maintenance program and click on the Database tab. 

2. Choose Access from the Database Type list. 

3. The Database Main File field shows where the model database, that comes 
along with the program, is installed, e.g. "c:\isocs\data\db50.mdb".  

4. Click on the "Open Directory" button to have access to the directory where the 
Access database is installed.  

5. Copy all the files and directories from this folder to a network location where the 
Access database must be, for example \\SERVER\ISOPLAN [HYPERLINK: 
file:///\\SERVER\ISOPLAN], where "SERVER" is the server's name and ISOPLAN 
is the name of the directory where the database will be. ISOPLAN users must be 
allowed to read and write on this folder. 

6. Change the path of the Database Main File field, usually called db50.mdb, to the 
new location, e.g. "\\SERVER\ISOPLAN\db50.mdb".  

7. Click on the Save button to save the new configurations. 
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8. See the Auto-Check topic in case you want to do an initial test before using 
ISOPLAN. Close the ISOPLAN Maintenance program and try to log on 
ISOPLAN.  

9. If ISOPLAN is installed on several computers, open the ISOPLAN Maintenance 
program on every computer and configure the Database Main File field, in order 
to direct all the computers to the same file.   

 

11.1.2. Access Database Backup 

 
  In order to make a database backup, follow these steps:  

1. Open the ISOPLAN Maintenance program, click on the Database tab and check if 
Access is selected as the Database Type. 

2. Click on the Backup button.  

3. Choose a directory and a name to save the backup file, compacted file (zip 
format) and click on the Save button.  

 
Comments:  

• Isoplans that bring the Audit-Trail module create monthly files of Access database 
that can take up considerable space. There is an option called Include Audit-
Trail Files to Backup that does not include these files in the backup when 
disabled. This option must only be chosen in case of support for the sending of 
the database to Presys, in order to reduce the size of the backup file.  

• There is an option called Send Backup by E-mail that, when marked, opens the 
standard e-mail program automatically and attaches the backup file, so you just 
have to enter the e-mail address, write a message and click on Send. 

 
11.1.3. Restoring Access Database Backup  

 
In order to restore an Access Database backup, follow these steps:  

1. Open the ISOPLAN Maintenance program, click on the Database tab and check if 
Access is selected as the Database Type. 

2. Click on the Restore Backup button.  

3. Find where the zip backup file is located and click on the Open button.  

4. A confirmation of the database location will be required, and if the information is 
correct, click on Yes. If there is an ISOPLAN database in the directory, it will 
be lost. 
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11.1.4. Repairing an Access Database  

  The repair of the database file must be done in case the user does not manage to 
run ISOPLAN, many error messages are shown or the program stops running during its 
normal operation.  
 
  It is important to perform a backup of the DB50.MDB file (or any other database 
used) before beginning the database repair operation. 
 
  To repair the database, do the following: 
 

1. Open the ISOPLAN Maintenance program, click on the Database tab and check if 
Access is selected as the Database Type. 

2. Close ISOPLAN if it is open. 

3. Click on the Repair button and confirm the operation execution. A dialog box 
indicating the directory where ISOPLAN was installed will be shown. 

4. Select the database file and click on OK. 

5. Wait until the end of the database repair process.    

 

  In case the repair was not successful, the database must be restored from a 
previous backup of the database file. 
 
11.2. Using an SQL Server Database 28  

 
  SQL Server is a more robust database, allowing a larger number of users, and it 
is less subjected to failures. However, it demands more knowledge for maintenance and 
set up, so it is recommended for companies that already use SQL Server for other 
corporate systems.  Microsoft offers a free version of SQL Server with a limit to the 
database maximum size, but it is adequate to ISOPLAN. Initially, ISOPLAN comes with 
an Access database, therefore a configuration must be made to allow its use with SQL 
Server database. 

                                              
28 SQL Server Optional Module 
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11.2.1.  Installing the Database on the SQL Server 

  This set up demands certain knowledge of the use and management of the tools 
that come along with SQL Server Database; thus the following items are just a general 
guidance on how to set up the server using the Enterprise Manager, which is included in 
the SQL 2000. 
 

1. Locate the MSSQL folder on the Set up CD, where backup (bak) files of the 
ISOPLAN database for SQL Server can be found. The file used must be 
compatible with SQL version that is installed in the company, for example, for 
SQL 2000, use the file db50SQL2000.bak.  

 
2. Open the Enterprise Manager program, select the Server where the ISOPLAN 

database will be located and click on the Action > All Tasks > Restore 
Database menu. 

 
3. Fill in the Restore as database field with the ISOPLAN database name, such as 

"isoplan", click on the From device option and click on the Select Devices button 
to locate the ISOPLAN backup file. The ISOPLAN file usually stays in the same 
server where SQL server is.  It is possible to use the standard options on the 
screen.  Click on OK and check if the ISOPLAN database was installed. 

 
4. Register a new user on the SQL (check the Enterprise Manager manual), for 

example, "isoplan", choose a password and grant the user a permission from the 
ISOPLAN database owner "db_owner". It is only necessary to create a single user 
for the ISOPLAN, regardless of the amount of people who will use it. There is a 
separate users' registration inside ISOPLAN. 

 
5. Open the ISOPLAN Maintenance program and click on the Database tab. 

 
6. Choose SQL Server as the Database Type. 

 
7. Fill in the Server fields (server address as well as the instance used, if this is the 

case, e.g. "192.168.33.18\SQLEXPRESS"), Database (database name defined 
on step 3), User (ISOPLAN user name on the SQL Server) and Password 
(ISOPLAN user password on the SQL Server)  

 
8. Use Standard Security if authentication through SQL Server is being used and 

Integrated Security if the access to SQL Server is limited by the Windows user 
login. In this case, the User and Password fields are not used. See further 
explanation on the SQL Server manual.  

 
9. Click on the Test Connection button to check if the connection was successfully 

made. 
 

10. Click on the Save button to save the configurations.  
 

11. Close the ISOPLAN Maintenance program and try to access ISOPLAN by using 
the standard account (user name "admin" and password "admin"). 

 
12. Repeat steps 5 to 11 on all the computers where ISOPLAN has been installed. 

 



PRESYS  Instruments ISOPLAN-5 

Page 213 

11.2.2. SQL Server Database Backup  

 
  ISOPLAN offers a basic backup routine of an SQL Server Database. This 
resource is often unnecessary, since more advanced backup tools from the SQL Server 
can be used, or any other procedure followed by the company. To perform a backup 
through ISOPLAN, do the following:  
 
 

1. Open the ISOPLAN Maintenance program, click on the Database tab and check if 
SQL Server is selected as the Database Type. 

 
2. Fill in the Backup File field with the file name and directory where the backup file 

will be saved. This directory is located on the SQL server, not on the 
computer running the ISOPLAN Maintenance Program. If you use a name 
without directory, for example, "isoplan.bak", the SQL Server will store the file on 
the standard backup directory, which is also located on the server.  

 
3. Click on the Make Backup button to start the backup.  

 
 
11.2.3. Restoring SQL Server Database Backup 

  A database backup on ISOPLAN is normally restored using the program that 
comes along with the SQL Server, therefore the use of ISOPLAN is not necessary. The 
log in used by ISOPLAN on the SQL server must show the permission for a database 
creation (Database Creators) in order to to carry out this procedure. 
 
 

1. Open the ISOPLAN Maintenance program, click on the Database tab and check if 
SQL Server is selected as the Database Type. 

 
2. Fill in the Backup File field with the backup file name (.bak). If you use a directory 

name, e.g. C:|\isoplan\isoplan.bak, this file will be searched for on drive C: of the 
server where SQL Server is installed, not on the computer running the ISOPLAN 
Maintenance Program.  

 
 

3. Click on the Restore Backup button to finish the process. 
 
 
Note: 
 

• When a backup copy is restored, all the information from the ISOPLAN database 
on the SQL Server is erased. 
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•  
11.3. Using an Oracle Database 29  

  Oracle, as well as SQL Server, is a more robust database, allowing a larger 
number of users, and it is less subjected to failures. However, it demands more 
knowledge for maintenance and set up, so it is recommended for companies that already 
use Oracle for other corporate systems.  There is a free version of Oracle with a limit to 
the database maximum size, but it is adequate to ISOPLAN. Initially, ISOPLAN comes 
with an Access database, therefore a configuration must be made to allow its use with 
Oracle 10g database or higher. 
 
11.3.1. Installing an Oracle Database  

 
  This set up demands certain knowledge of the use and management of tools that 
come along with Oracle Database. The following items are just a general guidance on 
how to set up the server using the "Data Pump" tool. It is necessary to have one of the 
following softwares installed on the same computer where ISOPLAN is: "Oracle Database 
10g Client" or "Oracle Instant Client 10.2.0.4", provided by Oracle. These softwares are not 
included on the ISOPLAN setup CD, but can be downloaded from Oracle website.  
 

1. Locate the Oracle folder on the Set up CD, where the backup (.dmp) file of the 
ISOPLAN database for Oracle can be found in the "Data Pump" format.  

 
2. Run a impdp command line utility, which is used to import the isoplan.dmp file to 

the Oracle server. The scheme on the file is called "isoplan". Below, an example 
of a command line to be used. 

 
impdp SYSTEM/admin SCHEMAS=isoplan DIRECTORY=isoplandir DUMPFILE = ISOPLAN.DMP 
REMAP_SCHEMA = isoplan:isoplan_data TABLE_EXISTS_ACTION = replace LOGFILE=isoplanimport.log 
 
 

These are the descriptions of some parameters. See Oracle documentation:  
 
SYSTEM/admin: login and password of the System account in Oracle.  
 
isoplandir: directory in Oracle where the file isoplan.dmp is located. It can be created by 
using the SQL command from Oracle "CREATE OR REPLACE DIRECTORY", or an 
existing file can be used.  
 
REMAP_SCHEMA=isoplan: isoplan_data: used when necessary to change the 
ISOPLAN user name. In the example, it was altered from "isoplan" to "isoplan_data". 
 

3. After importing the database scheme, the user must have be left with "connect" 
and "resource", according to Oracle documentation.  Choose a password for the 
ISOPLAN user (scheme) on Oracle.  

 
4. Open the ISOPLAN Maintenance program and click on the Database tab. 

 
5. Choose from the Database Type as Oracle. 

                                              
29 Oracle Optional Module 
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6. Fill in the Server field (server address, e.g. "192.168.33.18"), Port (TCP/IP port 

used, generally 1521), Instance (Instance name on Oracle server, for example, 
XE), User (ISOPLAN user name on Oracle) and Password (ISOPLAN user 
password on Oracle).  

 
7. Click on the Test Connection button to check if the connection was successfully 

made. 
 

8. Click on the Save button to save the configurations.  
 

9. Close the ISOPLAN Maintenance program and try to access ISOPLAN by using 
the standard account (user name "admin" and password "admin"). 

 
10. Repeat steps 5 to 9 on all the computers where ISOPLAN has been installed. 

 
 
11.3.2. Oracle Database Backup  

  ISOPLAN does not have commands to make an Oracle database backup. There 
is only one backup option, intended for support, in case it is necessary to send a copy of 
the database to Presys without making contact with the Oracle administrator. When 
clicking on the "Support Backup" button, a zip file name is requested, where all the data 
concerning the database internal tables will be stored. This zip file can be sent to Presys 
by e-mail, in case it is necessary to perform some tests with the same data from Oracle 
at Presys.  
 

 
11.4. ISOPLAN Auto-Check  

  The ISOPLAN Maintenance program brings a routine to check the environment 
where the program is installed, such as database connection and serial communication. 
This auto-check procedure has the main purpose to help the product set up support. The 
auto-check routine is carried out as follows:  

1. Open the ISOPLAN Maintenance program and click on the Auto-Check tab. 

2. In case you want to test the serial communication with the Presys calibrators, 
connect the calibrator to the computer serial port, leaving the calibrator display on 
the COM menu. Then, select the model according to the calibrator being used, 
choose the COM port and mark the Test Communication option.  

3. Click on the Start button to generate an Auto-Check report.   
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Figure 154 –  Auto-Check tab on the ISOPLAN Maintenance dialog box 

Comments: 

• If the communication is working, the calibrator serial number and model must 
appear on the first line of the report.  

• The other information displayed is about the operational system, database 
connection and directories permissions intended to help the program support.  

• The buttons at the bottom of the tab represent the shortcuts to the operational 
system options. ISOPLAN Directory: opens the directory where ISOPLAN is 
installed. Device Manager: opens the device manager and checks if the 
computer has a COM port installed. Printers: shows the installed printers. 
Regional Settings: opens the Regional Settings screen from Windows.  

 

 

 

11.5. Reset User 
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The Isoplan Maintenance software allows to return the default user settings as 
password, inactive status and locked status using the "Reset User" option. 
 
Open Isoplan Maintenance software and then click the "Reset User" button. 

 
 

 
 

Figure 155 - Reset Users of  dialog box Isoplan Maintenance 

Select the type of database where the company is registered. 
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Figure 156 - Selecting Database Type in the "Reset User" dialog box 

 
Select the users you want to reset the password and click the ">" to add user the list and 
reset the password. 

 
Note: When the user is selected, the data it will be shown in the "User Data" 

 
Enter the password provided by Presys in the "Password" field, then click "Reset 
Password" 

 
"To reset the user is required to enter the password that is provided by 
Presys. If you have no password, please contact the Presys. If the "Date" 
shown on the screen is incorrect provide this date to receive the password 
to reset the user. The password is only valid on the day of acquisition. 
Upon receiving the password fill in the "Password" field and click "Reset 
User" after already performed the choice of users who will be reset. 
Select the type of database being used, the company where users meet and 
finally users who will be reset to the default settings 
The configuration of the users will return to default settings when resetting 
users. The user will be unlocked, On, and the password will be reset to 
1234" 
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Figure 157 - Resetting User in the "Reset User" dialog box 
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Appendix 1 - Uncertainty Calculation 

 
  The uncertainty of measurement is based on the statistical analysis obtained 
during calibration (Type A Uncertainty) and by other means that are not based on the 
measurements (Type B Uncertainty). On the following pages, definitions and formulas 
used in the general uncertainty of measurement calculation are shown. The calculations 
refer to a single calibration point, therefore they must be repeated for each point defined 
in the tag calibration strategy.  
 

Type A Standard Uncertainty 
 

  
n

S
U i=1 (Eq. 1) 

 

 where:  Si = Standard Deviation 
  n = number of measurements (in general, three measurements)  
  U1 = type A standard uncertainty. 
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i (Eq. 2) 

 

where:  xi = value of each reading for a certain calibration point 
 x  = average reading value 

 

Type B Standard Uncertainty 

 
  Uncertainties evaluated by means other than statistical analysis of a series of 
measurements. Type B uncertainties used in ISOPLAN are described below: 
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Calibrator Standard and Instrument Error Source Uncertainty 
 

Fx

Ux
U =2  (instrument extra uncertainty) (Eq. 3) 

 

Fpextra

Upextra
U =2  (standard extra uncertainty) (Eq. 4)  

where:  
 
Ux = instrument extra uncertainty registered on the instrument scale section. 
Fx = factor associated with instrument extra uncertainty 
 
Upextra = extra standard uncertainty registered on the standard scales section. 
Fpextra = factor associated with standard extra uncertainty 
 
These uncertainties are optional and only used if the user has registered them in 

ISOPLAN, and if they have been added during calibration. These uncertainties can be 
used to add other error sources that must be taken into account during calibration, such 
as effect of environmental temperature, weather variation since the last certificate etc.  

 
 

Uncertainty No Correction of Standards 
  

Optional uncertainty that can be added during the uncertainty calculation when 

the standard correction option is not used.  

3

max
2

E
U =  (uncertainty of non-correction of the standard)  (Eq. 5) 

where:  

Emax = maximum error of the certificate of the standard for the selected scale.  

 
Calibrator Standard Inherited Uncertainty 
 

 
This factor is composed of the standard uncertainties used to calibrate the 

instrument. The standards used are defined during the Upload, where the standard and 
the used scales are chosen. 
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The calibrator uncertainty (U3) is composed of the calibrator uncertainties used for 
the reading of a signal (Ue) and of the calibrator uncertainties used to generate a signal 
(Us): 

 

 +=
i

is

i

ie UUU 2

)(

2

)(3 )()( ( Eq. 6) 

 
where:  

  Ue(i) = calibrator uncertainty of each reading standard used. 
  Us(i) = calibrator uncertainty of each generating standard used. 
  U3 = total calibrator uncertainty. 
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Reading Calibrator Uncertainty 

 

 
K

Ucert
Ue =  (Eq. 7) 

 
 where:  Ucert = uncertainty declared on the certificate. 
  K = constant K declared on the certificate. 
 

 On the certificate, the worst uncertainty between two existing points concerning 
the calibration point is used. This method can be easily understood with an example. 
Suppose we must calibrate an instrument that has current output, like a temperature 
transmitter, for example. Observe the figure: 

 

 

Figure 158 - Calibration of a converter type instrument 

 
 
In this example, the reading is the calibrator current input. Suppose you want to 

calibrate the instrument to a point where the output is 4mA, therefore we must know the 
standard uncertainty for a reading close to 4mA. From the standard calibration certificate, 
we have the following data: 

 
p1 = 3mA Ucert1 = 0.001mA K1 =2  
p2 = 6mA Ucert2 = 0.002mA K2 = 2 
 
where:  p1, p2 = calibrated points on the standard certificate.  
  Ucert1,Ucert2 = uncertainties declared on the certificate for points p1 and 

p2. 
  K1,K2 = "K" coverage factors declared on the certificate for points p1 and 

p2. 
 
Therefore, points 3 and 6mA are available for input, so calibrator uncertainty for 

4mA is estimated the following way:  
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In case there is more than one reading calibrator, it is necessary to find the 

uncertainty for each calibrator, and then apply the value found to the formula  (Eq. 5).  
 
 
Generation Calibrator Standard Uncertainty 
 

 (Eq. 8) 

 
 where:  Ucert = uncertainty declared on the certificate. 
  K = constant K declared on the certificate. 
 
 In this case, it is also necessary to find the standard uncertainty value, as 

described in the previous example. 
 
The calculations made by ISOPLAN (uncertainties, errors etc.) and the tag 

acceptance criteria are related to the instrument output, therefore the generation 
calibrator standard uncertainty must be propagated from the instrument input to output. 
This is possible with the use of propagation of uncertainty formulas. For linear 
instruments, the propagation of uncertainty from the instrument input to output happens 
as follows: 

 
 

'
min)max(

min)max(
Us

EE

SS
Us 

−
−

=  (Eq. 9) 

 
where: Smax = instrument output maximum value (value configured on tags registration on the reference field).  

 Smin - = instrument output minimum value (value configured on tags registration on the reference field).  
 Emax - = instrument input maximum value (value configured on tags registration on the calibration field).  
 Emin - = instrument input minimum value (value configured on tags registration on the calibration field). 
 Us' = standard uncertainty value of the input standard obtained from the formula (7). 
 
 The value given in (8) must be used to calculate the total standard uncertainty  

 

 Still about the previous example, suppose the temperature transmitter has a Pt-
100 as input, ranging from 0 to 100°C, and the output between 4 and 20mA, and we are 
calibrating the point corresponding to 0°C. As standard calibrator, we use an instrument 
that simulates a Pt-100, where the standard uncertainty obtained from the certificate for 
0°C, already interpolated, is 0.025°C.  
  

K

Ucert
Us ='
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Applying (8)  
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Calculating Us and Ue, it is possible to calculate the total calibrator inherited uncertainty 
using the equation (5), that is:   
 

)(00406,0004,00006667,0 22

3 mAU =+=  

In simpler cases, for example, an indicator instrument type such as thermometers or 
manometers, we only have the generation standard uncertainty, therefore, Ue = 0, only 
Us are left, where most of the cases Us = Us', because the range of calibration and 
reference values are equal. 
 
 
 
Combined Uncertainty 

 Combined uncertainty of a measurement, when this measurement is obtained 
through values from several other quantities, is equal to the positive square root of a sum 
of terms. 
 

2

3

2

2

2

1 UUUUC ++= ( Eq. 10) 

 
where: Uc = combined standard uncertainty 

U1 = Type A uncertainty 
U2 = Type B uncertainty related to the instrument and calibrator extra uncertainties 
U3 = Type B uncertainty related to the calibrator standards used 
 

 
Effective Degrees of Freedom 
 
 When many uncertainties are combined, it is necessary to know the number of 
effective degrees of freedom that must be taken into account during calibration, for the 
calculation of the uncertainty of measurement. It is obtained through the use of the 
Welch-Satterthwaite formula: 
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 where:  eff = effective degrees of freedom 
  Uc = combined standard uncertainty 
  U i=standard uncertainty value of each component used to calculate the 
combined uncertainty. Normally we only have the uncertainty U1 that has degrees of 
freedom equal to n-1, the other uncertainties usually have infinite degrees of freedom. 
Isoplan finds the degrees of freedom of the standard using the k factor typed if it is 
greater than two through the t-student table with a probability of  of 95.45%. For 
example, if the certificate of the standard has a k factor equal to 2.11 the number of 
degrees of freedom will be 25. 
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 Uncertainty of Measurement 
 
 Quantity defining an interval around the result of a measurement, from which a 
large P fraction of the probability distribution is expected to be achieved, and P is the 
coverage probability or confidence level. This is the value shown on ISOPLAN reports 
and used to define if the diagnosis is approved or not. 
 
 U=K.Uc (Eq. 12) 
 
 where:  K= coverage factor 
  Uc = combined uncertainty defined in (9). 
 
 The K coverage factor is obtained on the Student's t distribution (t), for a certain 
confidence level and certain degrees of freedom defined in (10). If eff  is not a whole 
number, K is calculated by the means of a linear interpolation from the immediate 
numbers (anterior and posterior ones) existing on the table. 
 
 K= tp( eff ) (Eq. 13) 
 
 Example: A given trust level is equal to 95.45% (P = 95.45%) and a number of 
effective degrees of freedom , eff calculated in (10) is equal to 3.85. Find K. 

 
In this case, the value immediately before is 3 and the value immediately after is 

4, therefore we have the following values for K: 
 

eff =3   => K=3,31 
 

eff =4   => K=2,87 
 
In a linear interpolation of the two points above, we have: 
 

936,231,3)385,3(
43

87,231,3
=+−









−
−

=K  
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Appendix 2 - Instrument Calculation with Square Root Function 

 Instruments like flow meters (square root function) use the following formula to 
calculate the reference value. 
 
  In Root Function  
 
 

  
minminmax

minmax
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−
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= ( Eq. 14) 

 
 
 where: 
 
  R = reference value 
  C = calibration point 
  Cmin = minimum calibration value configured on tags screen. 
  Cmax = maximum calibration value configured on tags screen. 
 Rmin = minimum reference value configured on tags screen. 
  Rmax = maximum reference value configured on tags screen. 
 
 
 
Appendix 2.1 - Propagation of Uncertainties 

  The propagation of standard uncertainty used in the instrument input to the 
output, as in the case of flow meters, is calculated using the following formula:  
 

2

)()(
)( cc

s

UCRUCR
CU

−−+
=  

  where: 
 
  C = calibration point specified in the strategy. 
 
  Us(C) = generation calibrator standard uncertainty referring to the tags screen 
calibration. 
 
  R(C) = flow meter formula mentioned in the previous topic. 
 
  Uc(C) = calibrator standard uncertainty obtained from the calibration certificate.   

  
  In the previous formula, it is possible to see that Us(C) is numerically evaluated 
when we calculate if the Us variation is due to a calibration point variation of +Uc(C) and - 
Uc(C). 
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Appendix 2.2 - Propagation of Errors 

  The propagation of the systematic standard error used in the instrument input to 
the output, in the case of flow meters, is found using the following formula:  
 

)'()()( ss ECRCRCE −−=  
  where: 
 
  C = calibration point specified in the strategy. 
 
  Es'(C) = generation standard systematic error in the referring calibration unit of the 
tags screen. 
 
  R(C) = flow meter formula mentioned in the previous topic. 
 
  Es(C) = systematic error propagated from instrument input to output, i.e., in the 
reference unit of the tags screen.   

 
 

Appendix 3 - Automatic Calibration Frequency Setting  

 
  ISOPLAN uses previous calibration diagnosis to define if the calibration period 
must be increased or reduced. This increase or reduction is based on Schumacher Table 
as well as on the factors defined on the configuration screen.  
 
 

Previous Calibrations Current Calibration 
 

F C 
CCC D E 
FCC D P 
CF M P 
FC M P 
FF M P 

Schumacher Table 
 

The information on the screen is the following: 
 
Previous Calibrations: diagnosis of the two or three previous calibrations  
 
Current Calibration: diagnosis of the last calibration. 
 
C: calibration diagnosis was approved or is compliant.  
 
F: calibration diagnosis was reproved or is not compliant (out of tolerance).  
 
D: calibration interval must be reduced according to the Reduction Factor shown on the 
Configurations screen.  
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M: calibration interval must be reduced according to the Maximum Reduction Factor 
shown on the Configurations screen.  
 
E: calibration interval must be increased or extended according to the Increase Factor 
shown on the Configurations screen. 
 
 
  On the tags screen, the maximum and minimum limits for a calibration interval are 
shown, preventing calibrations from happening between very short or very long intervals.  
 
  ISOPLAN uses the following algorithm:  
 

1) After the calibration data is entered, ISOPLAN checks if the diagnosis 
concerning the previous calibrations fit one of the cases on Schumacher 
table, for example, CCC (three calibrations with approved diagnosis), FF 
(two calibrations with reproved diagnosis etc.). If none of the cases occurs, 
the calibration interval is kept the same.  

 
2) If one of the cases on the table occurs, according to the diagnosis of the 

current calibration, ISOPLAN will calculate the calibration interval following 
the suggestion from Schumacher Table and the factors on the 
configuration screen.  

 
E (extend): faTTnovo =   
D (reduce): fdTTnovo =  
M (maximum reduction): fmTTnovo =  
P (remain): TTnovo =  
 
where:  
 

=novoT New calibration interval suggested by ISOPLAN in months or days.   
=T  Current calibration interval in months or days.  

fa = Calibration interval increase factor, which must be a number higher 
than 1.  

fd = Calibration interval reduction factor, which must be a number lower 
than 1.  

fm = Calibration interval maximum reduction factor, which must be a 
number lower than fd. 
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3) ISOPLAN checks if the new suggested interval is between the minimum 
and maximum limits specified by the user. If the interval goes beyond the 
maximum limit, ISOPLAN adopts the maximum value suggested by the 
user as the new interval. In case of reduction, ISOPLAN also suggests the 
minimum limit, if the calculations present a value lower than the minimum 
limit suggested by the user.  

 
4) The user is requested to confirm if s/he really wants to change the 

calibration interval. In case the user confirms the change, the calibration 
interval is altered.  

 
 

Appendix 4 - Characteristics of Analog Manometers 

 
 The loop is a combination of two or more instruments connected so that the signal 
passes from one to the other in order to perform a measurement. The metrological 
evaluation of the loop can be done in two ways. The first consists of the loop calibration 
performed in Isoplan through the normal loop download and upload procedure, where 
the loop as a whole is treated as an instrument by injecting a standard signal at the 
beginning of the loop and reading the output or indication of the last instrument of the 
loop. In this mode all the instruments must be interconnected and functioning in order to 
carry out the calibration. The second way is to use the calibration parameters of each tag  
of the loop (uncertainties and errors) and to use the uncertainty propagation method to 
estimate the error and uncertainty of the loop.  
 
 The following figure shows the loop diagram 
 

 

Figure 159 - Loop composed of several tags 

 
 In the previous figure T1 through Tn are the various tags that make up a loop. A 
signal is present at the input of the loop, passes through several instruments until it 
reaches the output of the last equipment, which in many cases is an indicator showing 
the signal of the loop (temperature, flow, pressure and etc.). 
 
  In order to perform the loop uncertainty calculations manually, the following data 
must be obtained: 
 
 SP(M): point of calibration of the loop that is desired to do the calculations.  
 
  AmplitudeInput (M): input amplitude in the loop or operating range of the loop.  
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  AmplitudeOutput(M): amplitude of output  in the loop or range of operation of the 
loop. 
 
  AmplitudeInput (TN): input amplitude of each tag of the loop.  
 
  AmplitudeOutput(TN): output amplitude of each tag of the loop.  
  
  SPOUT (TN): value in the output of each of each tag of the loop.  
 
  u (TN):standard uncertainty consisting of the expanded uncertainty divided by k 
factor. Value obtained in the tag certificate.  
 
  e(TN): systematic error, difference between the value indicated or read on the 
instrument and the reference value shown on the certificate. Obtained by tag certificate.  
 
vEff(TN): effective degrees of freedom of tag N. Obtained by tag certificate.  
 
Loop Sensitivity  
 
  The sensitivity of the tag is a constant, which when multiplied by the value of 
variation of the input produces the value of variation of the output of the tag. The 
sensitivity for linear instruments can be calculated by dividing the amplitude of the 
instrument output by the input amplitude, for example, in a transmitter with input from 0 
to 100°C and output 4 to 20 mA we have as sensitivity the value of (20-4)/(100-0)=0.16 
mA /°C. 
 
 
  The sensitivity of the loop can be calculated by the following equation:  
 
 S(M) = S(T1).S(T2). ... S(TN)   (Eq. 15) 
 
 where: 
 
 S(M): loop sensitivity  
 S(TN): sensitivity of each tag of the loop. For linear instruments it is given by  
 
 S (TN) = AmplitudeOutput(TN) /AmplitudeInput (TN) 
 
 where: 
 

AmplitudeInput(TN): amplitude of variation of the instrument input.  
 

AmplitudeOutput(TN): amplitude of variation of the instrument output 
corresponding to the variation of input amplitude mentioned above.  
 
Relative Tag Error 
 
  To facilitate the combination of errors and uncertainties the calculations will be 
made in relative terms, in the case of Isoplan in relation to the operating range of the 
loop. In this way the calculations become simpler since it is not necessary to deal with 
different units or quantities of each tag of the loop.  
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  Er(TN) = E(TN)/ Amplitude(TN) 
 
 where: 
 
 Er(TN): relative error of tag N   
 S(TN): sensitivity of each tag of the loop.  
 
  For example, in a tag that has an uncertainty of 1°C in the certificate and the 
operating range in the loop is from 0 to 100° C (amplitude), then the relative error will be 
1/100 = 0.1. 
 
Relative Loop Error 
 
  It can be shown that the relative equivalent error of the loop is calculated by the 
following equation:  
 
  Er(M) = Er(T1) + Er(T2). ... Er(TN)   (Eq. 16) 
 
  where: 
 
  Er(M): relative error of the loop corresponding to the error of the loop in 
engineering unit divided by the output span of the loop.  
 
  Er(TN): relative tag error that corresponds to the tag error in engineering unit 
divided by the output span of the tag. 
 
  The relative error of the loop corresponds to the simple sum of the relative errors 
of each tag of the loop.  
 
 
Loop Error in Engineering Unit 
 
 The previous equation shows the error of the loop in relation to the output 
amplitude of the loop, to calculate the error in engineering unit, simply multiply the 
relative error by the output amplitude of the loop.  
 
 E (M) = Er (M) * AmplitudeOuput(M) (Eq.17) 
 
  where: 
 
 E(M): loop error in engineering unit.  
 
 AmplitudeOutput(M): amplitude of output  in the loop or range of operation of the 
loop. 
 
  This value is shown in the Isoplan certificate.  
 
Loop Relative standard Uncertainty 
 
  It can be shown that the relative equivalent standard uncertainty of n uncorrelated 
interconnected tags can be estimated by: 
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  2222 )(...)2()1()( TNurTurTurMur +++=  (Eq. 18) 
 
  where: 
 
  ur(M): relative standard loop uncertainty that corresponds to the standard loop 
uncertainty in engineering unit divided by the output span of the loop.  
 
  ur(TN): relative standard uncertainty of the tag that corresponds to the standard 
uncertainty of the tag in engineering unit divided by the output span of the tag. 
 
  The standard uncertainty of each tag corresponds to the uncertainty shown in the 
Isoplan certificate divided by the k factor.  
 
 
  ur(TN) = (U(TN) / K(TN))/Span(TN) 
 
 
Effective Degrees of Freedom of the Loop 
 
  Using the Welch-Sartewaite equation, the effective degree of freedom of the loop 
can be determined  
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  where: 
 
  ur(M): relative standard uncertainty of the loop obtained in (Eq. 18) 
 
  ur (TN): relative standard uncertainty of the  tag N obtained through the tag 
certificate.  
  v (TN): effective degrees of freedom that can be obtained from the calibration 
certificate of the tag.  
 
  In this equation the only unknown is v(M) which gives the  effective degrees of 
freedom of the loop.  
 
 
Expanded Relative Uncertainty of the loop 
 
 
  After  the number of degrees of freedom of the loop is found  is used the t-Student 
table to find the coverage factor (K) in the same way that is explained in the appendix of 
calculation of uncertainty of the tag.  
 
  Ur(M) = K*ur(M) 
 
 
ur(M): relative standardized uncertainty of loop calculated in the previous topic. .  
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K: coverage factor that must be obtained by interpolating the t-Student table to a 
confidence level of 95.45% as explained in the appendix to calculate the uncertainty of 
the tag.  
 
Expanded Loop Uncertainty 
 
 
 The previous equation shows the uncertainty of the loop in relation to the output 
amplitude of the loop, in order to calculate the uncertainty in engineering unit, it is 
sufficient to multiply the relative uncertainty by the output amplitude of the loop.  
 
 U(M) = Ur(M)* AmplitudeOutput(M) (Eq. 20) 
 
  where: 
 
 U(M): expanded uncertainty of the loop in engineering unit.  
 
 AmplitudeOutput(M): amplitude of output  in the loop or range of operation of the 
loop. 
 
  This value is shown in the Isoplan certificate.  
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Appendix 5 - ASME Calibration Tolerance 

 
 Below is the tolerance table that Isoplan uses to automatically calculate the 
acceptance criteria for safety valves.  
 

ASME I Aperture  
Pressure Tolerance 
Up to 70 psi  2 psi 
From 70 to 300 psi  3 % 
From 300 to 1000 psi 10 psi 
Above 1000 psi 1% 

ASME VIII Opening 
Up to 70 psi  2 psi 
Above 70 psi 3% 
 
 

ASME I Differential Relief  
Pressure Tolerance 
Any Pressure  4% or 4psi (whichever is greater) 

ASME VIII Differential Relief 
Any Pressure (Gases) 10% 
Any Pressure (Liquids) 25% 
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Appendix 6 - Characteristics of Analog Manometers 

In the certificate of analog manometers some characteristics of the instrument are 
calculated.  
 
Maximum Repeatability 
 
R = 100*MAX(E)/Range 
 
E = ABS(MaxMes - MinMes) (for the same up or down calibration point)   
 
Where:  
 
R = Maximum Repeatability 
MaxMes = maximum value measured for a calibration point.  
MinMes = measured minimum value for a calibration point.  
 
E = difference between the highest value and the lowest measured value of the 
same up or down calibration point.  
Range = Instrument range 
 
NOTE: Calibration points are separated between ascending and descending 
calibration points. 
 
Maximum Fiducial Error 
 
EF = 100 * MAX(E)/Range 
 
E = ABS (Vi-Vp)   
 
Where:  
 
EF = Maximum Fiducial Error 
E = difference between the value indicated by the instrument (Vi) and the value 
indicated by the standard (Vp) for each calibration point.  
Range = Instrument range 
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Maximum Hysteresis 
 
H = 100 * MAX (Eh) / Range 
 
Eh = ABS (VMc -VMd)   
 
Where:  
 
H = Hysteresis 
Eh = difference between the measured value of a calibration point for each 
increasing and decreasing cycle  
VMc - measured value of an increasing calibration point 
VMd - measured value of a decreasing calibration point 
Range = Instrument range 
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